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Chapter 1. Accessibility Features for IBM Application
Discovery for IBM Z

Accessibility features assist users who have a disability, such as restricted mobility or limited vision, to
use information technology content successfully.

Overview

IBM® Application Discovery for IBM Z® includes the following major accessibility features:

• Keyboard-only operation
• Operations that use a screen reader

IBM Application Discovery for IBM Z uses the latest W3C Standard, WAI-ARIA 1.0 (www.w3.org/TR/wai-
aria/), to ensure compliance with US Section 508 (www.access-board.gov/guidelines-and-standards/
communications-and-it/about-the-section-508-standards/section-508-standards) and Web Content
Accessibility Guidelines (WCAG) 2.0 (www.w3.org/TR/WCAG20/). To take advantage of accessibility
features, use the latest release of your screen reader and the latest web browser that is supported by IBM
Application Discovery for IBM Z.

The IBM Application Discovery for IBM Z online product documentation in IBM Knowledge Center is
enabled for accessibility. The accessibility features of IBM Knowledge Center are described in the
Accessibility section of the IBM Knowledge Center help (https://www.ibm.com/support/
knowledgecenter/en/about/releasenotes.html).

Keyboard navigation

This product uses standard navigation keys.

Interface information

For alternative installation using Command Line Installation (CLI), refer to section Alternative Installation
for ADDI Using CLI in IBM AD Installation and Configuration Guide.

The IBM Application Discovery for IBM Z user interfaces do not have content that flashes 2 - 55 times per
second.

The IBM Application Discovery for IBM Z web user interface relies on cascading style sheets to render
content properly and to provide a usable experience. The application provides an equivalent way for low-
vision users to use system display settings, including high-contrast mode. You can control font size by
using the device or web browser settings.

The IBM Application Discovery for IBM Z web user interface includes WAI-ARIA navigational landmarks
that you can use to quickly navigate to functional areas in the application.

Related accessibility information

In addition to standard IBM help desk and support websites, IBM has a TTY telephone service for use by
deaf or hard of hearing customers to access sales and support services:

TTY service
800-IBM-3383 (800-426-3383)
(within North America)

For more information about the commitment that IBM has to accessibility, see IBM Accessibility
(www.ibm.com/able).
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Chapter 2. IBM AD High-Level Architecture Overview

The following diagram illustrates IBM Application Discovery for IBM Z (AD) high-level architecture and the
relationships among the different components of the suite.

Figure 1. IBM AD high-level architecture

Following is a brief description of the relationships among the different components of IBM AD.

IBM AD Configuration Server ensures the consistency of the installation parameters throughout an
installation and allows the system administrator to manage user access to workspaces.

IBM AD Build - uses data from mainframe systems to build projects. It uses project sources that are
brought from z/OS®®, performs a compilation/build process and stores the analysis data to the repository.

IBM AD Validation Service - works with ChangeMan SCM only. Provides coding rule enforcement via
synchronization with ChangeMan and upon member staging.

IBM AD Batch Server - imports data from the relational database repository into the GraphDB (OrientDB)
repository, automates processes such as report generation and indexing, and manages the creation of the
annotations database.

IBM AD Analyze Client - runs over Eclipse or IDz and provides project analysis via graphs reports and
usage views. When the analyzed application sources are coming from Endevor, it allows viewing source
code per user based on Endevor permissions that are checked via z/OS Explorer/CARMA interface.

IBM AD Mainframe Projects - authorizes the access to the AD projects, by using SSO authentication
within AD. This service is mandatory to be configured to use AD, whether the authentication feature is in
place or not.
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IBM AD File Service - in the context of the authorization/authentication, the access rights of users or
users' groups are mapped to a certain folder that contains the source files. Once authenticated and
authorized, the user can start the analysis on the source files as long as the user has read access rights.

IBM AD Search Service - is responsible with the access to the indexed data. Whether the authentication
feature is in place or not, the folder path in which the indexes are generated needs to be accessible for
both IBM AD Batch Server and IBM AD Search Service.

IBM AD Manual Resolutions Service - manages the manually added resolutions and allows clients that
use SSO authentication within AD to ask for user authentication to access these resolutions. This service
is mandatory to be configured if you want to use callgraph-based analyzes (graphs or reports), whether
authentication feature is in place or not.

Authentication Server (DEX) - is an identity service that uses OpenID Connect and supports OAuth2
protocol in order to allow clients to use SSO authentication within AD. With the credentials provided by
the user, it interrogates a Secure Storage, through the LDAP protocol. The Secure Storage can be an
Active Directory or any other entity that stores users and groups and can communicate through LDAP.
This service is mandatory to be installed and configured only when authentication feature is in place.

IBM AD Cross Applications Service - is mandatory to be configured if you want to generate a Cross
Applications Callgraph, whether the authentication feature is in place or not.

Batch Web Service - serves the data that is provided by a component of the Batch Server and prepares it
for delivery.

IBM AD Web Services - contains the following features: AD Audit, AD Catalog and AD BRD REST API.
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Chapter 3. Installation Prerequisites

Note: Starting with IBM AD V5.0.4.1, the IBM AD Licensing Server, IBM AD Java™ Bridge and IBM AD
Monitor Service components are no longer used, therefore must be uninstalled from your environment.

Before installing IBM AD components, make sure you install 64bit Java Runtime Environment (JRE) v1.8.
Please uninstall any previous version of Java before installing v1.8; failing to do this might result in
unexpected IBM AD behavior. JRE can be downloaded from http://www.oracle.com/technetwork/java/
javase/downloads/index.html. Make sure to use the latest service release of Java v1.8.

Deploying IBM AD in your environment can be logically divided into two phases: installing IBM AD and
then configuring IBM AD. For existing IBM AD installations, please see Chapter 4, “Upgrading
Components from Earlier Versions,” on page 17 before deciding on an installation method.

CPU, RAM, and Storage Requirements
Note:

• On Linux for System z a minimum of at least 4 cores from a single IFL are recommended in order to run
the IBM AD components.

• For detailed system requirements, you can find a software product compatibility report at https://
www.ibm.com/software/reports/compatibility/clarity/softwareReqsForProduct.html.

For Production Level implementations

The minimum recommended hardware requirements for Production-level implementations with multiple
users and projects:

Note: The dedicated database server is a server with a running instance of Microsoft SQL Server,
dedicated to IBM AD components. It is recommended that all IBM AD components to be installed on one
or more machines that are separate from the machine where Microsoft SQL Server is running.

• For IBM AD Dedicated Database Server:

– CPU: Intel XEON Dual processor with minimum of 4 cores each, 3 GHz or higher, with Turbo support.
– 64 GB of RAM.
– Dedicated hard disk drive for the operating system, minimum 500 GB. Secondary dedicated hard disk

drive for data, minimum 2 TB.
• For all the IBM AD components:

– CPU: Intel XEON Dual processor with minimum of 4 cores each, 3 GHz or higher, with Turbo support.
– Minimum 32 GB of RAM.
– Dedicated hard disk drive for the operating system, minimum 500 GB. Secondary dedicated hard disk

drive for data, minimum 2 TB.
– 4 GB allocated Virtual Memory.

• For IBM AD Analyze Client:

– CPU: Intel i5 or equivalent.
– Minimum 8 GB of RAM.
– 20 GB allocated disk space.

• For IBM AD Build Client:

– CPU: Intel i5 or equivalent.
– 64GB of RAM.
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– 20 GB allocated disk space.

For Evaluation / POC implementations

The minimum recommended hardware requirements for evaluating the IBM AD in a Windows
environment:

Note: SQL Server and all the IBM AD components can be installed on this machine for evaluation / POC
purposes only.

• For IBM AD Workstation:

– CPU: Intel Core i5 or equivalent.
– 32 GB of RAM.
– 35 GB allocated disk space.

Supported Platforms and Versions

Supported Operating Systems

IBM AD Analyze Server/Batch Server/Configuration Server can be installed on:

• Windows 10 (64-bit)
• Windows Server 2008/2012/2018
• Linux Red Hat/SUSE/Ubuntu

Important: Make sure that a Linux Samba client is set up before installing IBM AD products on Linux.

IBM AD Build/Analyze Client can be installed on:

• Windows 7/8.1/10
• Windows Server 2008/2012/2016

IBM® AD Connect for Mainframe can be installed on z/OS 2.2/2.3.

Note: For more information about the minimum operating system service level, hardware and bitness,
see Supported Operating Systems for IBM Application Discovery.

Supported Databases

The following databases are supported:

• Db2® for z/OS version 11.1 and later
• Microsoft SQL Server 2012 and later

Note:

• Only one relational database repository type, either Microsoft SQL Server or Db2 for z/OS, is taken into
account when creating a project.

• Microsoft SQL Server Standard or Enterprise Edition is required for IBM Application Discovery Microsoft
SQL Server repository support.

• Microsoft SQL Server Express® Edition can be used for IBM AD Suite evaluation purposes only.
• For more information about the minimum prerequisite level that is required for a specific database and

version, see Supported Databases for IBM Application Discovery.

Prerequisite Software and Configurations

• Eclipse Classic / RCP and RAP Developers
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32/64 bit Eclipse Classic (RCP and RAP Developers), minimum supported version v4.4. Eclipse Classic
can be downloaded from www.eclipse.org.

• IBM Rational® Development for z Systems® (RDz)

Supported versions are v9.1.x to v9.5.x.

• IBM Developer for z Systems (IDz)

Minimum supported version is v14.0.0.0.

• The supported Internet browsers (used for accessing the IBM AD Configuration Server) are: Google
Chrome (recommended), Mozilla Firefox and Microsoft Edge.

Note: Make sure to enable JavaScript on your Internet browser of choice.

Java Runtime Environment
Any of the following Java Runtime Environments must be installed on your machine:

• 64-bit AdoptOpenJDK 8/11/13 HotSpot - https://adoptopenjdk.net/

Note: Make sure that Set JAVA_HOME variable and JavaSoft (Oracle) registry keys subfeatures are
selected when you install AdoptOpenJDK Development Kit with Hotspot.

• 64-bit Java 8 Oracle - http://www.oracle.com/technetwork/java/javase/downloads/index.html
• 64-bit Java 8 IBM - https://developer.ibm.com/javasdk/downloads/

Note: On Linux or Linux for System z, make sure to run the update-alternatives command to set the
specified IBM Java location to be used on the system.

Example:

update-alternatives --install /usr/bin/java java /opt/ibm/java-s390x-80/bin/java 1

Where /opt/ibm/java-s390x-80/bin/java represents the location of IBM Java. Based on the IBM
Java version that is used during the installation process, the location might change slightly.

Important:

• Make sure to uninstall any previous version of Java before you install the newest version and use the
latest service release of Java v1.8. Failing to do this an unexpected IBM AD behavior might result.

• 32-bit or 64-bit Java 8 Oracle/IBM must be installed before you install IBM AD Analyze Client.
• IBM AD Build Client runs only on the 64-bit JVM.

Important: Make sure that the path for Java is set in your system as follows: Start > System > Advanced
Settings > Environment Variables > System variables > Path. The path to the Java installation folder
must be set to include the bin folder as in C:\Program Files\Java\jre1.8.0_131\bin.

User Access

User access to workspaces

Workspaces that are created in IBM AD Configuration Server contain IBM AD projects. Configuring user
access to workspaces can restrict user access to projects from IBM AD Analyze Client and IBM AD Build
Client. When a workspace is created in IBM AD Configuration Server, by default, it is public. To configure
the user access to this workspace, add the credentials of the users who must have access to projects.
User names are case-sensitive in IBM AD Configuration Server.

For more information about user access to workspaces, see Managing workspaces' access rights in IBM
AD Configuration Server User Guide.
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Windows service access and user access to local or shared folders
The following table shows the required access to folders of different IBM AD components. By default, IBM
AD services are configured to use the Windows LocalSystem account ID, which can be changed. For IBM
AD Analyze Client and IBM AD Build Client, grant access to the logged on Windows user that is running
the component.

Components Folders Required
access types

Notes®

IBM AD Analyze Client Local Eclipse installation
folders

Read and write

Local workspace folders Read and write

Local folders where
sources are based

Read If you want to visualize the
sources in Endevor or
ChangeMan, the read access to
local sources is not required.

IBM AD Analyze Server
(Optional)

Local installation folders Read and write The write access is required for
the user under which the
Windows service or Linux
process runs.

The shared folder for
shared Java projects

Read and write A shared folder for shared Java
projects must be created and
be referenced in the IBM AD
Analyze Server manager.

IBM AD Build Client Local project folders Read and write

Local configuration
folders for z/OS
connections

Read and write

Local source code folders Read and write

IBM AD Batch Server The Indexes local folder Read and write

Local installation folders Read and write

Local project and source
folders

Read and write

The following image shows a best practice example of the IBM AD installation folder structure. However,
you can customize the structure based on your particular needs.
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Microsoft SQL Server Configurations
Most IBM AD components connect to an Microsoft SQL Server by using SQL Authentication. For Microsoft
SQL Server 2012/2014/2016/2017, perform the following configurations:

1. Make sure that Microsoft SQL Server instance is configured with a case-insensitive (CI) collation.

Important: IBM Application Discovery does not support the Microsoft SQL Server instance's collation
Latin1_General_CP1254_CI_AS.

2. Make sure Microsoft SQL Server Agent service is started.
3. Setting up an SQL user account:

a. Start SQL Server Management Studio.
b. Expand Security > Logins then right-click Logins and choose New Login. Add a login name, select

SQL Server Authentication, add a password, and make sure that the default database is set to
master. This user is referred to as IBM AD SQL Identity.

c. Expand Databases > System Databases > master > Security > Users then right-click Users and
choose New User. Choose the IBM AD SQL Identity user and click OK.

d. Expand Databases > System Databases > master then right-click master and choose Properties.
Go to Permissions tab and for the IBM AD SQL Identity and make sure that permissions are
granted for: Create database, Create function, Create procedure, Create table, and Create view.

e. The following permission must be granted only if the Rename project feature is used in IBM AD
Build, otherwise it is not needed. Right-click on the SQL server instance and then select
Properties. In the Server Properties window select Permissions: From the roles list, select the
IBM AD SQL Identity and then select Grant for Alter any database permission.

4. Configuring SQL Server to enable it to accept connection over TCP/IP:

a. Start SQL Server Configuration Manager.
b. Select SQL Native Client Configuration (32bit) > Client Protocols and then right-click TCP/IP and

set it to Enabled.
c. Select SQL Server Network Configuration > Protocols for <Instance ID> and make sure that

Shared Memory, TCP/IP, and Named Pipes are set to Enabled.
d. Select SQL Native Client Configuration > Client Protocols and make sure that Shared Memory,

TCP/IP, and Named Pipes are set to Enabled.
e. Close SQL Server Configuration Manager.

Important: SQL Server Configuration Manager writes startup parameters to the registry. They take
effect upon the next startup of the SQL Server.

IBM Db2 for z/OS Server Configurations
On workstations where IBM AD Build Client is installed, Data Server Client V11.1 that contains IBM Data
Server Provider for .NET must be installed and licensed. The mentioned package is part of Db2 Connect™

V11.1 product.

Note: .NET framework 4.5.1 or higher is prerequisite for IBM AD Build Client.

To license the .NET provider, click Start, select Run, type cmd to open the command window and run the
following command:

"<Installation Path for IBM Data Server Client>\BIN\db2licm.exe" -a <path to license file>
\db2consv_ee.lic

Example:

"C:\Program Files\IBM\SQLLIB\BIN\db2licm.exe" -a C:\Apps\DB2_CEE_QS_Activation_11.1\consv_ee
\db2\license\db2consv_ee.lic
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In case that IBM AD Build Client is intended to be used by a standard user, with no administration
privileges, make sure that during Db2 Connect V11.1 installation process the Enable operating system
security check box is selected.

Note: If you selected the Enable operating system security check box, you now have to add users to the
DB2ADMNS or the DB2USERS groups for users that need to run IBM AD Build Client. For more
information, see Adding your user ID to the DB2ADMNS and DB2USERS user groups.

Some packages must be bound on the server. The bound files are listed in the ddcsmvs.lst file for IBM
Z, for example, C:\Program Files\IBM\SQLLIB_01\bnd\ddcsmvs.lst.

User permissions

In IBM AD application, a z/OS user account (Authentication ID) is used to work with the Db2 for z/OS
repository. The user account must have permissions to perform the following actions:

• Use the storage group that is specified when configuring the Db2 z/OS connection in IBM AD
Configuration Server.

Note: Make sure that the storage group is initially created.
• Use the SYSDEFLT default storage group.
• Use the default buffer pools.
• Create and use databases, tables, table spaces, indexes, constraints, views, triggers, stored

procedures, and user-defined functions.
• Run the SELECT command over system tables (SYSIBM.SYS*).
• Have full control over the databases that are created by the user account.
• GRANT BINDADD, BINDAGENT, CREATEDBA, CREATESG, DISPLAY
• GRANT ALTERIN, CREATEIN, DROPIN ON SCHEMA *
• GRANT CREATE IN COLLECTION *
• GRANT SELECT ON TABLE SYSIBM.SYSROUTINES_SRC
• GRANT SELECT ON TABLE SYSIBM.SYSROUTINES_OPTS

Important: All permissions must be granted directly to the user account (Authentication ID).

IBM AD Connect for Mainframe Prerequisites
IBM AD Connect for Mainframe can be installed on:

• z/OS version 2.2 or later.
• The maximum storage space is 5 cylinders.

Before installing IBM AD Connect for Mainframe on the host machine (mainframe), you need to take the
following steps:

1. Authorize to add IBM AD Connect for Mainframe’s load library to APF.
2. Authorize IBM AD Connect for Mainframe’s listener to run.
3. Authorize to access all libraries specified in the STEPLIB card (see section "Configuring the listener

PROC" in IBM AD Connect for Mainframe Configuration Guide).
4. Make sure to provide authorization according to the analyzed area:

Analyzed Area Required Authorization

Adabas Authorization to issue an ADAREP command

Control-M Access to the libraries containing the Control-M data

DB2® Rights to read from the Db2 system tables (SYSIBM)

SMF Access to the SMF dump files
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Analyzed Area Required Authorization

Libraries and
Members

Access to the libraries

Natural Authorization to issue a Natural batch command and read Access to all Natural
libraries (LOGON)

Operator
commands

Normal RACF® security to allow the user to issue those commands.

WebSphere® MQ Authorization to perform PUT and GET from command and reply queues

TCP Port Requirements and Firewall Exceptions

The following table summarizes the TCP ports that need to be allowed by the firewall in order for the
Application Discovery Suite to function as intended.

In all cases, communication is bidirectional. The firewall must allow both the incoming traffic, which
represents requests, for the mentioned ports, and the outgoing traffic, which represents the answers to
these requests.

From (Sender) To (Listener
Component)

Default
Listener
Port

Note

• AD Analyze
Clients

• AD Audit Service
• AD Batch Server
• AD Build Client
• AD Build
Configuration

• AD Catalog

SQL Server TCP 1433 The port of the SQL Server Database Engine
instance that hosts the AD databases. Majority of
the AD components use this port to read/write
data from/into the SQL databases.

The default instance of the SQL Server Database
Engine listens on TCP port 1433, but it can be
changed via SQL Server admin tools. Ask your
database server administrator what port is used
by the SQL server instance that is used by AD.
Make sure not to use TCP port 1434, which is
used by Dedicated Administration Console (DAC).

The computer
where the browser
session is opened

AD
Configuration
Server

TCP 8080 The port that is used to access the web interface
of AD Configuration Server.

The default port is 8080, but it can be changed in
the admin-ws.properties file, which is located
in the conf folder where AD Configuration Server
is installed.

If the web interface is accessed only locally on AD
Configuration Server, this port does not have to be
opened in the firewall.

• AD Analyze
Clients

• AD Batch Server
• AD Build Client
• AD Build
Configuration

AD
Configuration
Server

TCP 2181 The port that AD Configuration Server listens on
for requests from various AD components that
need to obtain the configuration settings from AD
Configuration Server.

The default port is 2181, but it can be changed in
the server.properties file, which is located in
the conf folder where AD Configuration Server is
installed.
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From (Sender) To (Listener
Component)

Default
Listener
Port

Note

• AD Validation
Server

AD Analyze Clients AD Batch
Server

• TCP 2424
- TCP
2430

• TCP 2434
- TCP
2440 (*)

The port of the OrientDB database instance that is
hosted by AD Batch Server.

AD Analyze Client makes requests to this port for
retrieving the data that is related to callgraph
analyses.

OrientDB uses the first free TCP port in the range
2424 - 2430. This can be changed in the
config/orientdb-server-config.xml file.

(*) If the ssl implementation is used, the default
port for OrientDB SSL is 2434. You need to
change your port range to 2434-2440 in the
config/orientdb-server-config.xml file.
For more information, see Configuring OrientDB
for SSL/TLS.

AD Analyze Clients AD Analyze
Server

TCP 1099 The port where the Remote Method Invocation
(RMI) registry can be found on AD Analyze Server.
AD Analyze Clients make RMI-specific requests to
this port.

The default port is 1099, but it can be changed
from AD Analyze Server Manager. To change the
setting, click Server Settings > RMI Registry
Port.

AD Analyze Server is required only when AD
Analyze Clients use and run Java-specific
analyses, so if AD Analyze Server is not installed,
the port does not have to be opened in the
firewall.

AD Analyze Clients AD Analyze
Server

TCP 1900 The port that is used by AD Analyze Server for the
Remote Method Invocation (RMI) communication.
AD Analyze Clients make requests to this port for
obtaining various information that is needed for
Java analyses.

The default port is 1900, but it can be changed
from AD Analyze Server Manager. To change the
setting, click Server Settings > Export Port.

AD Analyze Server is required only when AD
Analyze Clients use and run Java-specific
analyses, so if AD Analyze Server is not installed,
the port does not have to be opened in the
firewall.

AD Analyze Server AD Analyze
Client

A random
free TCP
port, which
is allocated

The port that AD Analyze Client listens on for
notifications from AD Analyze Server. This port is
temporarily used, which is released after the
application is closed.
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From (Sender) To (Listener
Component)

Default
Listener
Port

Note

at run time,
in the
ephemeral
port range
49152 -
65535.

The default port is a random free TCP port, which
is allocated at run time, in the ephemeral port
range 49152 - 65535, but AD Analyze Client can
be configured to use a specific port. To configure
the setting, click Window > Preferences >
Application Discovery > Local Settings >
General Settings > Client Settings in Eclipse,
and then set a value in the range 1 - 65535 in the
Port field. Value 0 means that a free port on AD
Analyze Client is selected at run time in the
ephemeral port range 49152 - 65535.

AD Analyze Server is required only when AD
Analyze Clients use and run Java-specific
analyses, so if AD Analyze Server is not installed,
the port does not have to be opened in the
firewall.

• AD Build Client
• AD Build
Configuration

AD Connect for
Mainframe

Any
available
TCP port (no
default
value)

The port that AD Connect for Mainframe listens
on. It is used by AD Build Configuration to retrieve
source code information and operational
information from the mainframe, and used by AD
Build Client to retrieve source code files from the
mainframe.

For how to set or change the port that is used by
AD Connect for Mainframe, see section
Configuring the Listener PROC in IBM AD Connect
for Mainframe Configuration Guide. There is no
default port that is specified. Any available port
can be selected. For example, port 6000 or port
46000.

After you change this port in AD Connect for
Mainframe, the z/OS connection setup needs to
be reconfigured to use the new port. To configure
the setting, click the zOS tab in the AD Build
Configuration tool.

AD Connect for
Mainframe

AD Validation
Service

Any
available
TCP port (no
default
value)

The port that AD Validation Service listens on for
validation requests from AD Connect for
Mainframe.

It can be configured in the ServicePort.txt
configuration file that is located in the AD
Validation Server installation folder. No default
port is set by default. Any available TCP port can
be used. For example, port 48000.

AD Validation Service is an optional component. If
it is not used, this port does not have to be
opened in the firewall.

• AD Analyze
Clients

AD Audit
Service

TCP 9080 The port that AD Audit Service listens on to
receive requests from various AD components for
logging audit events.
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From (Sender) To (Listener
Component)

Default
Listener
Port

Note

• AD Batch Server
• AD Build Client

The port number can be changed by altering the
httpPort value in the server.xml file. The file is
located in the folder of the IBM Liberty instance
that hosts AD Audit Service. After you change this
port, make sure to reconfigure the AD
components that audit events to use the new
port. For more information, see IBM AD Web
Services User Guide.

The AD Audit and AD Catalog services are optional
AD components. They are both hosted by the
same WebSphere Liberty instance. If neither of
them is used, the port does not have to be opened
in the firewall.

• AD Analyze
Clients

• AD Data Collector

AD Catalog
Service

TCP 9080 The port that AD Catalog Service listens on. This
port is used by AD Data Collector to push data
into AD Catalog, and it is used by AD Analyze
Clients to retrieve the data that is needed for
displaying API analyses.

The port number can be changed by altering the
httpPort value in the server.xml file. The file is
located in the folder of the IBM Liberty instance
that hosts AD Catalog Service. After you change
this port, make sure to reconfigure AD Data
Collector and AD Analyze Client to use the new
port. For more information, see IBM AD Web
Services User Guide.

The AD Audit and AD Catalog services are optional
AD components. They are both hosted by the
same WebSphere Liberty instance. If neither of
them is used, the port does not have to be opened
in the firewall.

• AD File Service
• AD Analyze Client
• AD Search Service
• AD Manual

Resolutions
Service

• AD Mainframe
Projects Service

• AD Cross
Applications
Service

• Secure Storage

Authentication
Server (DEX)

TCP 7600 The default port on which Authentication Server
(DEX) listens to different requests is 7600. It can
be modified in the conf.yaml file.

• (Optional)
Authentication
Server (DEX)

AD File Service TCP 7700 The default port on which AD File Service listens
to different requests is 7700. It can be modified
in the conf.yaml file.
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From (Sender) To (Listener
Component)

Default
Listener
Port

Note

• AD Analyze Client

• (Optional)
Authentication
Server (DEX)

• AD Analyze Client

AD Search
Service

TCP 7800 The default port on which AD Search Service
listens to different requests is 7800. It can be
modified in the conf.yaml file.

• (Optional)
Authentication
Server (DEX)

• AD Analyze Client
• AD Batch Server

AD Manual
Resolutions
Service

TCP 7900 The default port on which AD Manual
Resolutions Service listens to different requests
is 7900. It can be modified in the conf.yaml file.

• (Optional)
Authentication
Server (DEX)

• AD Analyze Client
• AD Batch Server

AD Mainframe
Projects Service

TCP 7650 The default port on which AD Mainframe Projects
Service listens to different requests is 7650. It
can be modified in the conf.yaml file.

• (Optional)
Authentication
Server (DEX)

• AD Analyze Client
• AD Batch Server

AD Cross
Applications
Service

TCP 7850 The default port on which AD Cross Applications
Service listens to different requests is 7850. It
can be modified in the conf.yaml file.

Authentication
Server (DEX)

AD Analyze
Client

TCP 9999 The port that is used by Authentication Server
(DEX), opened on all Analyze Client machines (in
environments using DEX), and used for callback.

Note: Make sure that the firewall does not prevent AD Analyze Client from communicating with AD Batch
Server, AD Configuration Server, AD Analyze Server, and the relational database server. Program rules in
the firewall might need to be created to allow both the inbound and outbound traffic for the
eclipse.exe instance on each AD Analyze Client that is located under the installation folder of your
Eclipse or IDz instance.
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Chapter 4. Upgrading Components from Earlier
Versions

Upgrading to IBM AD V5.1.0.5

Upgrading from IBM AD V5.1.0.4

Steps to be performed when you upgrade IBM AD V5.1.0.4 to IBM AD V5.1.0.5.

1. Run the IBM ADDI V5.1.0.5 installer without uninstalling AD components and make sure that the same
IBM AD installation path is used, but do not use the same IBM ADI installation path if ADI has been
previously installed.

Important: When using the IBM ADDI V5.1.0.5 installer, do not use the same installation path to
install a newer version of ADI over an existing version of ADI. Installing a higher level of ADI directly
over an existing instance of ADI can cause problems when trying to migrate ADI configuration
information and data to a newer level. For more information, see the Migrating from a previous release
section, in the ADI documentation.

2. Once the upgrade to IBM AD V5.1.0.5 is finalized, make sure to manually delete the cross databases
that were used by IBM AD Cross Applications Service in IBM AD V5.1.0.4 from Microsoft SQL Server.

3. Make sure that IBM AD File Service, IBM AD Search Service, IBM AD Manual Resolutions Service,
IBM AD Mainframe Projects Service, and IBM AD Cross Applications Service are configured and the
services are up and running. For more information, see Chapter 6, “Configuring IBM AD ,” on page 39.

4. Starting with IBM AD V5.1.0.5, IBM AD Web Services are using a new version of IBM® WAS Liberty
Web Service and you need to perform the following steps:

a. Go to <IBM ADDI Installation Folder>\IBM AD Web Services\wlp\usr\servers
\ad_server folder and back up the following data:

• server.xml configuration file.
• conf.brd-ws folder.

b. Delete the existing wlp folder and the wlp-webProfile7-18.x.x.x.zip file.
c. Extract the wlp folder from the wlp-webProfile7-19.x.x.x.zip file, and place the wlp folder

to the IBM AD Web Services installation folder. The default installation folder is <IBM ADDI
Installation Folder>\IBM AD Web Services.

d. Go to \wlp\bin and execute the following command: server.bat create ad_server.

Note: You can verify the successful web service creation by checking whether the \ad_server
folder is present in \wlp\usr\servers or not.

e. Restore the backed up server.xml configuration file, overwriting the existing one, and the
conf.brd-ws folder to the \wlp\usr\servers\ad_server folder.

f. From the IBM AD Web Services installation folder, copy the com.ez.jtds-x.x.x.jar file to
\wlp\usr\shared\config.

g. From the IBM AD Web Services installation folder, copy the following files to the \wlp\usr
\servers\ad_server\apps folder:
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• com.ibm.etools.ad.catalog.war
• com.ibm.ad.audit.service.war
• com.ibm.ad.brd.restapi.war

h. Go to \wlp\bin folder and execute the server.bat start ad_server command.

Note: It takes roughly 30 seconds to 1 minute for the Ad Server to start.
i. Check the execution log file, accessible at \wlp\usr\servers\ad_server\logs
\console.log.

Note: Once the latest version of IBM Application Discovery and Delivery Intelligence is installed and fully
configured, you need to:

1. Mandatory, upgrade the repository for each project by using either IBM AD Build Client or IBM AD
Build Configuration and it is highly recommended to perform a full Build.

2. Highly recommended to perform a full Build of each IBM AD project.

Instructions for upgrading the repository can be found at Upgrade a repository.

Instructions for performing a full Build of the project can be found at Building projects.

Upgrading from IBM AD V5.1.0.3

Steps to be performed when you upgrade IBM AD V5.1.0.3 to IBM AD V5.1.0.5.

1. Run the IBM ADDI V5.1.0.5 installer without uninstalling AD components and make sure that the same
IBM AD installation path is used, but do not use the same IBM ADI installation path if ADI has been
previously installed.

Important: When using the IBM ADDI V5.1.0.5 installer, do not use the same installation path to
install a newer version of ADI over an existing version of ADI. Installing a higher level of ADI directly
over an existing instance of ADI can cause problems when trying to migrate ADI configuration
information and data to a newer level. For more information, see the Migrating from a previous release
section, in the ADI documentation.

2. Make sure that IBM AD File Service, IBM AD Search Service, and IBM AD Manual Resolutions
Service are configured and the services are up and running.

3. Once the upgrade to IBM AD V5.1.0.5 is finalized, IBM AD Mainframe Projects Service and IBM AD
Cross Applications Service need to be configured as follows:

a. IBM AD Mainframe Projects Service - is a mandatory service that needs to be configured to
authorize the access to the AD projects. The list of projects is not cached at the restart of the IBM
AD Analyze Client and it is necessary to use the Get project list contextual-menu option each time
when IBM AD Analyze Client starts. For more information on how to configure IBM AD Mainframe
Projects Service, see “STEP 6. Configuring IBM AD Mainframe Projects Service” on page 54
(without authentication) or “STEP 7. Configuring IBM AD Mainframe Projects Service” on page 96
(with authentication).

b. IBM AD Cross Applications Service - is an additional service that needs to be configured to show
calls between different mainframe projects that have their databases on the same DB instance in
IBM AD Analyze Client. For more information on how to configure IBM AD Cross Applications
Service, see “STEP 9. Configuring IBM AD Cross Applications Service” on page 63 (without
authentication) or “STEP 10. Configuring IBM AD Cross Applications Service” on page 106 (with
authentication).

4. Starting with IBM AD V5.1.0.5, IBM AD Web Services are using a new version of IBM® WAS Liberty
Web Service and you need to perform the following steps:

a. Go to <IBM ADDI Installation Folder>\IBM AD Web Services\wlp\usr\servers
\ad_server folder and back up the following data:

• server.xml configuration file.
• conf.brd-ws folder.
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b. Delete the existing wlp folder and the wlp-webProfile7-18.x.x.x.zip file.
c. Extract the wlp folder from the wlp-webProfile7-19.x.x.x.zip file, and place the wlp folder

to the IBM AD Web Services installation folder. The default installation folder is <IBM ADDI
Installation Folder>\IBM AD Web Services.

d. Go to \wlp\bin and execute the following command: server.bat create ad_server.

Note: You can verify the successful web service creation by checking whether the \ad_server
folder is present in \wlp\usr\servers or not.

e. Restore the backed up server.xml configuration file, overwriting the existing one, and the
conf.brd-ws folder to the \wlp\usr\servers\ad_server folder.

f. From the IBM AD Web Services installation folder, copy the com.ez.jtds-x.x.x.jar file to
\wlp\usr\shared\config.

g. From the IBM AD Web Services installation folder, copy the following files to the \wlp\usr
\servers\ad_server\apps folder:

• com.ibm.etools.ad.catalog.war
• com.ibm.ad.audit.service.war
• com.ibm.ad.brd.restapi.war

h. Go to \wlp\bin folder and execute the server.bat start ad_server command.

Note: It takes roughly 30 seconds to 1 minute for the Ad Server to start.
i. Check the execution log file, accessible at \wlp\usr\servers\ad_server\logs
\console.log.

Note: Once the latest version of IBM Application Discovery and Delivery Intelligence is installed and fully
configured, you need to:

1. Mandatory, upgrade the repository for each project by using either IBM AD Build Client or IBM AD
Build Configuration and it is highly recommended to perform a full Build.

2. Highly recommended to perform a full Build of each IBM AD project.

Instructions for upgrading the repository can be found at Upgrade a repository.

Instructions for performing a full Build of the project can be found at Building projects.

Upgrading from IBM AD V5.1.0.2

Steps to be performed when you upgrade IBM AD V5.1.0.2 to IBM AD V5.1.0.5.

1. Run the IBM ADDI V5.1.0.5 installer without uninstalling AD components and make sure that the same
IBM AD installation path is used, but do not use the same IBM ADI installation path if ADI has been
previously installed.

Important: When using the IBM ADDI V5.1.0.4 installer, do not use the same installation path to
install a newer version of ADI over an existing version of ADI. Installing a higher level of ADI directly
over an existing instance of ADI can cause problems when trying to migrate ADI configuration
information and data to a newer level. For more information, see the Migrating from a previous release
section, in the ADI documentation.

2. Once the upgrade to IBM AD V5.1.0.5 is finalized, the following services need to be configured as
follows:

a. IBM AD File Service

Prior to IBM AD V5.1.0.3, the sources and the project folders need to be shared.
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Starting with IBM AD V5.1.0.3, IBM AD File Service was introduced and in the context of the
authorization/authentication, the access rights of users or users' groups are mapped to a certain
folder with the source files that are on the same machine with IBM AD File Service or not. Once
authenticated and authorized, the user can start the analysis on the source files as long as the user
has read access rights.

If you still want to use the existing projects, you need to add the path to the shared sources
folders that were used during the project creation, when configuring IBM AD File Service. In this
way, you are still able to access the sources from another machine. This path needs to be added in
the conf.yaml file, in the mapping section, where the remote parameter is present.

Note:

• If the authorization/authentication feature is not used, for the new projects you need to have a
shared folder to access those files from another machine. For more information on how to
configure IBM AD File Service without authentication, see “STEP 4. Configuring IBM AD File
Service” on page 47.

• If the authorization/authentication feature is used, for the new projects it is not necessary to
have a shared folder. For more information on how to configure IBM AD File Service with
authentication, see “STEP 5. Configuring IBM AD File Service” on page 88.

b. IBM AD Search Service

Prior to IBM AD V5.1.0.3, IBM AD Batch Server was generating, through the index component, the
indexed data for the resources of a project into a path set in the project.properties file. In
IBM AD Analyze Client a search in resources was directly performed by using Search in Files
analysis.

Starting with IBM AD V5.1.0.3, IBM AD Search Service is responsible with the access to the
indexed data. Whether the authorization/authentication feature is used or not, the folder path in
which the indexes are generated needs to be accessible both for IBM AD Batch Server and IBM AD
Search Service. The path where the index data is generated needs to be added in the conf.yaml
file, where the indexPath parameter is present. This path can be found under <IBM ADDI
Installation Folder>\IBM Application Discovery Batch Server\conf
\project.properties, where the index.indexFolder parameter is present.

The path to the source folders that are added to the project or any additional folder that needs to
be indexed (apart from the project folders), needs to be added in the conf.yaml file of IBM AD
File Service, where the mapping section is present. The path to the additional folder can be found
under <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\conf\project.properties, where the index.extraSources parameter is present.

Note:

• Make sure that IBM AD Search Service and IBM AD File Service are started as Search in Files
analysis depends on them. For more information on how to configure IBM AD Search Service
without authentication, see “STEP 8. Configuring IBM AD Search Service” on page 60.

• If the authorization/authentication feature is used, the user that is logged in IBM AD Analyze
Client needs to have read access rights to see the content of the files where the search pattern
appears. For more information on how to configure IBM AD Search Service with authentication,
see “STEP 9. Configuring IBM AD Search Service” on page 102.

c. IBM AD Manual Resolutions Service

Prior IBM AD V5.1.0.3, the dynamic call resolutions were stored and managed by using files located
in the .resolutions folder under each project's path.

Starting with IBM AD V5.1.0.3, IBM AD Manual Resolutions Service manages these files, so the
path where these files are generated is separated from project's path and needs to be accessible
only for IBM AD Manual Resolutions Service. This path where the journal files are generated
needs to be added in the conf.yaml file, where the projectPath parameter is present. Once a
project is imported, a folder with the same name is generated in that path and hosts all the files
that are needed to manage dynamic call resolutions. For more information on how to configure IBM
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AD Manual Resolutions Service, see “STEP 5. Configuring IBM AD Manual Resolutions Service” on
page 50 (without authentication) or “STEP 6. Configuring IBM AD Manual Resolutions Service” on
page 92 (with authentication).

Note: Make sure that IBM AD Manual Resolutions Service is started as the import process
depends on it.

To preserve the journal files that were used in the previous versions, the moveResolutions.ps1
script allows you to automatically move the journal files from a previous location to a new
destination, where for each project, a folder that contains the journal files is created.

To run the moveResolutions.ps1 script, perform the following steps:

1) Go to the <IBM ADDI Installation Folder>\IBM Application Discovery Manual
Resolutions Service folder and locate the moveResolutions.ps1 script.

2) Run the moveResolutions.ps1 script by using Windows PowerShell.
3) Set the source parameter, which represents the path where the IBM AD Build Client projects

were created. The default path is found in IBM AD Configuration Server at the following
location: Home Page > "YourConfigurationServer:Port" > > Install Configurations > IBM
Application Discovery Build Client > Default projects path.

4) Set the destination parameter, which represents the path for the files that are moved on, as
described in step 5, in the Configuring IBM AD Manual Resolutions Service section.

5) As a result, all the journal files are moved in the newly set location.
d. IBM AD Mainframe Projects Service - is a mandatory service that needs to be configured to

authorize the access to the AD projects. The list of projects is not cached at the restart of the IBM
AD Analyze Client and it is necessary to use the Get project list contextual-menu option each time
when IBM AD Analyze Client starts. For more information on how to configure IBM AD Mainframe
Projects Service, see “STEP 6. Configuring IBM AD Mainframe Projects Service” on page 54
(without authentication) or “STEP 7. Configuring IBM AD Mainframe Projects Service” on page 96
(with authentication).

e. IBM AD Cross Applications Service - is an additional service that needs to be configured to show
calls between different mainframe projects that have their databases on the same DB instance. For
more information on how to configure IBM AD Cross Applications Service, see “STEP 9.
Configuring IBM AD Cross Applications Service” on page 63 (without authentication) or “STEP 10.
Configuring IBM AD Cross Applications Service” on page 106 (with authentication).

3. Starting with IBM AD V5.1.0.5, IBM AD Web Services are using a new version of IBM® WAS Liberty
Web Service and you need to perform the following steps:

a. Go to <IBM ADDI Installation Folder>\IBM AD Web Services\wlp\usr\servers
\ad_server folder and back up the following data:

• server.xml configuration file.
• conf.brd-ws folder.

b. Delete the existing wlp folder and the wlp-webProfile7-18.x.x.x.zip file.
c. Extract the wlp folder from the wlp-webProfile7-19.x.x.x.zip file, and place the wlp folder

to the IBM AD Web Services installation folder. The default installation folder is <IBM ADDI
Installation Folder>\IBM AD Web Services.

d. Go to \wlp\bin and execute the following command: server.bat create ad_server.

Note: You can verify the successful web service creation by checking whether the \ad_server
folder is present in \wlp\usr\servers or not.

Chapter 4. Upgrading Components from Earlier Versions  21



e. Restore the backed up server.xml configuration file, overwriting the existing one, and the
conf.brd-ws folder to the \wlp\usr\servers\ad_server folder.

f. From the IBM AD Web Services installation folder, copy the com.ez.jtds-x.x.x.jar file to
\wlp\usr\shared\config.

g. From the IBM AD Web Services installation folder, copy the following files to the \wlp\usr
\servers\ad_server\apps folder:

• com.ibm.etools.ad.catalog.war
• com.ibm.ad.audit.service.war
• com.ibm.ad.brd.restapi.war

h. Go to \wlp\bin folder and execute the server.bat start ad_server command.

Note: It takes roughly 30 seconds to 1 minute for the Ad Server to start.
i. Check the execution log file, accessible at \wlp\usr\servers\ad_server\logs
\console.log.

Note: Once the latest version of IBM Application Discovery and Delivery Intelligence is installed and fully
configured, you need to:

1. Mandatory, upgrade the repository for each project by using either IBM AD Build Client or IBM AD
Build Configuration and it is highly recommended to perform a full Build.

2. Highly recommended to perform a full Build of each IBM AD project.

Instructions for upgrading the repository can be found at Upgrade a repository.

Instructions for performing a full Build of the project can be found at Building projects.

Upgrading from IBM AD V5.0.5.0, V5.0.5.1, V5.0.5.2 or V5.1.0.0

Steps to be performed when you upgrade IBM AD V5.0.5.0, V5.0.5.1, V5.0.5.2 or V5.1.0.0 to IBM AD
V5.1.0.5.

1. Run the IBM ADDI V5.1.0.5 installer without uninstalling AD components and make sure that the same
IBM AD installation path is used, but do not use the same IBM ADI installation path if ADI has been
previously installed.

Important: When using the IBM ADDI V5.1.0.5 installer, do not use the same installation path to
install a newer version of ADI over an existing version of ADI. Installing a higher level of ADI directly
over an existing instance of ADI can cause problems when trying to migrate ADI configuration
information and data to a newer level. For more information, see the Migrating from a previous release
section, in the ADI documentation.

2. Once the upgrade to IBM AD V5.1.0.5 is finalized, make sure to configure the following services:

a. IBM AD File Service

Prior to IBM AD V5.1.0.3, the sources and the project folders need to be shared.

Starting with IBM AD V5.1.0.3, IBM AD File Service was introduced and in the context of the
authorization/authentication, the access rights of users or users' groups are mapped to a certain
folder with the source files that are on the same machine with IBM AD File Service or not. Once
authenticated and authorized, the user can start the analysis on the source files as long as the user
has read access rights.

If you still want to use the existing projects, you need to add the path to the shared sources
folders that were used during the project creation, when configuring IBM AD File Service. In this
way, you are still able to access the sources from another machine. This path needs to be added in
the conf.yaml file, in the mapping section, where the remote parameter is present.

Note:

• If the authorization/authentication feature is not used, for the new projects you need to have a
shared folder to access those files from another machine. For more information on how to
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configure IBM AD File Service without authentication, see “STEP 4. Configuring IBM AD File
Service” on page 47.

• If the authorization/authentication feature is used, for the new projects it is not necessary to
have a shared folder. For more information on how to configure IBM AD File Service with
authentication, see “STEP 5. Configuring IBM AD File Service” on page 88.

b. IBM AD Search Service

Prior to IBM AD V5.1.0.3, IBM AD Batch Server was generating, through the index component, the
indexed data for the resources of a project into a path set in the project.properties file. In
IBM AD Analyze Client a search in resources was directly performed by using Search in Files
analysis.

Starting with IBM AD V5.1.0.3, IBM AD Search Service is responsible with the access to the
indexed data. Whether the authorization/authentication feature is used or not, the folder path in
which the indexes are generated needs to be accessible both for IBM AD Batch Server and IBM AD
Search Service. The path where the index data is generated needs to be added in the conf.yaml
file, where the indexPath parameter is present. This path can be found under <IBM ADDI
Installation Folder>\IBM Application Discovery Batch Server\conf
\project.properties, where the index.indexFolder parameter is present.

The path to the source folders that are added to the project or any additional folder that needs to
be indexed (apart from the project folders), needs to be added in the conf.yaml file of IBM AD
File Service, where the mapping section is present. The path to the additional folder can be found
under <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\conf\project.properties, where the index.extraSources parameter is present.

Note:

• Make sure that IBM AD Search Service and IBM AD File Service are started as Search in Files
analysis depends on them. For more information on how to configure IBM AD Search Service
without authentication, see “STEP 8. Configuring IBM AD Search Service” on page 60.

• If the authorization/authentication feature is used, the user that is logged in IBM AD Analyze
Client needs to have read access rights to see the content of the files where the search pattern
appears. For more information on how to configure IBM AD Search Service with authentication,
see “STEP 9. Configuring IBM AD Search Service” on page 102.

c. IBM AD Manual Resolutions Service

Prior IBM AD V5.1.0.3, the dynamic call resolutions were stored and managed by using files located
in the .resolutions folder under each project's path.

Starting with IBM AD V5.1.0.3, IBM AD Manual Resolutions Service manages these files, so the
path where these files are generated is separated from project's path and needs to be accessible
only for IBM AD Manual Resolutions Service. This path where the journal files are generated
needs to be added in the conf.yaml file, where the projectPath parameter is present. Once a
project is imported, a folder with the same name is generated in that path and hosts all the files
that are needed to manage dynamic call resolutions. For more information on how to configure IBM
AD Manual Resolutions Service, see “STEP 5. Configuring IBM AD Manual Resolutions Service” on
page 50 (without authentication) or “STEP 6. Configuring IBM AD Manual Resolutions Service” on
page 92 (with authentication).

Note: Make sure that IBM AD Manual Resolutions Service is started as the import process
depends on it.

To preserve the journal files that were used in the previous versions, the moveResolutions.ps1
script allows you to automatically move the journal files from a previous location to a new
destination, where for each project, a folder that contains the journal files is created.

To run the moveResolutions.ps1 script, perform the following steps:

1) Go to the <IBM ADDI Installation Folder>\IBM Application Discovery Manual
Resolutions Service folder and locate the moveResolutions.ps1 script.

Chapter 4. Upgrading Components from Earlier Versions  23



2) Run the moveResolutions.ps1 script by using Windows PowerShell.
3) Set the source parameter, which represents the path where the IBM AD Build Client projects

were created. The default path is found in IBM AD Configuration Server at the following
location: Home Page > "YourConfigurationServer:Port" > > Install Configurations > IBM
Application Discovery Build Client > Default projects path.

4) Set the destination parameter, which represents the path for the files that are moved on, as
described in step 5, in the Configuring IBM AD Manual Resolutions Service section.

5) As a result, all the journal files are moved in the newly set location.
d. IBM AD Mainframe Projects Service - is a mandatory service that needs to be configured to

authorize the access to the AD projects. The list of projects is not cached at the restart of the IBM
AD Analyze Client and it is necessary to use the Get project list contextual-menu option each time
when IBM AD Analyze Client starts. For more information on how to configure IBM AD Mainframe
Projects Service, see “STEP 6. Configuring IBM AD Mainframe Projects Service” on page 54
(without authentication) or “STEP 7. Configuring IBM AD Mainframe Projects Service” on page 96
(with authentication).

e. IBM AD Cross Applications Service - is an additional service that needs to be configured to show
calls between different mainframe projects that have their databases on the same DB instance. For
more information on how to configure IBM AD Cross Applications Service, see “STEP 9.
Configuring IBM AD Cross Applications Service” on page 63 (without authentication) or “STEP 10.
Configuring IBM AD Cross Applications Service” on page 106 (with authentication).

3. Starting with IBM AD V5.1.0.5, IBM AD Web Services are using a new version of IBM® WAS Liberty
Web Service and you need to perform the following steps:

a. Go to <IBM ADDI Installation Folder>\IBM AD Web Services\wlp\usr\servers
\ad_server folder and back up the following data:

• server.xml configuration file.
• conf.brd-ws folder.

b. Delete the existing wlp folder and the wlp-webProfile7-18.x.x.x.zip file.
c. Extract the wlp folder from the wlp-webProfile7-19.x.x.x.zip file, and place the wlp folder

to the IBM AD Web Services installation folder. The default installation folder is <IBM ADDI
Installation Folder>\IBM AD Web Services.

d. Go to \wlp\bin and execute the following command: server.bat create ad_server.

Note: You can verify the successful web service creation by checking whether the \ad_server
folder is present in \wlp\usr\servers or not.

e. Restore the backed up server.xml configuration file, overwriting the existing one, and the
conf.brd-ws folder to the \wlp\usr\servers\ad_server folder.

f. From the IBM AD Web Services installation folder, copy the com.ez.jtds-x.x.x.jar file to
\wlp\usr\shared\config.

g. From the IBM AD Web Services installation folder, copy the following files to the \wlp\usr
\servers\ad_server\apps folder:

• com.ibm.etools.ad.catalog.war
• com.ibm.ad.audit.service.war
• com.ibm.ad.brd.restapi.war

h. Go to \wlp\bin folder and execute the server.bat start ad_server command.

Note: It takes roughly 30 seconds to 1 minute for the Ad Server to start.
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i. Check the execution log file, accessible at \wlp\usr\servers\ad_server\logs
\console.log.

Note: Once the latest version of IBM Application Discovery and Delivery Intelligence is installed and fully
configured, you need to:

1. Mandatory, upgrade the repository for each project by using either IBM AD Build Client or IBM AD
Build Configuration and it is highly recommended to perform a full Build.

2. Highly recommended to perform a full Build of each IBM AD project.

Instructions for upgrading the repository can be found at Upgrade a repository.

Instructions for performing a full Build of the project can be found at Building projects.

Upgrading to IBM AD V5.1.0.4

Upgrading from IBM AD V5.1.0.3

Steps to be performed when you upgrade IBM AD V5.1.0.3 to IBM AD V5.1.0.4.

1. Run the IBM ADDI V5.1.0.4 installer without uninstalling AD components and make sure that the same
IBM AD installation path is used, but do not use the same IBM ADI installation path if ADI has been
previously installed.

Important: When using the IBM ADDI V5.1.0.4 installer, do not use the same installation path to
install a newer version of ADI over an existing version of ADI. Installing a higher level of ADI directly
over an existing instance of ADI can cause problems when trying to migrate ADI configuration
information and data to a newer level. For more information, see the Migrating from a previous release
section, in the ADI documentation.

2. Make sure that IBM AD File Service, IBM AD Search Service, and IBM AD Manual Resolutions
Service are configured and the services are up and running.

3. Once the upgrade to IBM AD V5.1.0.4 is finalized, IBM AD Mainframe Projects Service and IBM AD
Cross Applications Service need to be configured as follows:

a. IBM AD Mainframe Projects Service - is a mandatory service that needs to be configured to
authorize the access to the AD projects. The list of projects is not cached at the restart of the IBM
AD Analyze Client and it is necessary to use the Get project list contextual-menu option each time
when IBM AD Analyze Client starts. For more information on how to configure IBM AD Mainframe
Projects Service, see “STEP 6. Configuring IBM AD Mainframe Projects Service” on page 54
(without authentication) or “STEP 7. Configuring IBM AD Mainframe Projects Service” on page 96
(with authentication).

b. IBM AD Cross Applications Service - is an additional service that needs to be configured to show
calls between different mainframe projects that have their databases on the same DB instance in
IBM AD Analyze Client. For more information on how to configure IBM AD Cross Applications
Service, see “STEP 9. Configuring IBM AD Cross Applications Service” on page 63 (without
authentication) or “STEP 10. Configuring IBM AD Cross Applications Service” on page 106 (with
authentication).

Note: Once the latest version of IBM Application Discovery and Delivery Intelligence is installed and
fully configured, you need to:

a. Mandatory, upgrade the repository for each project by using either IBM AD Build Client or IBM AD
Build Configuration and it is highly recommended to perform a full Build.

b. Highly recommended to perform a full Build of each IBM AD project.

Instructions for upgrading the repository can be found at Upgrade a repository.

Instructions for performing a full Build of the project can be found at Building projects.
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Upgrading from IBM AD V5.1.0.2

Steps to be performed when you upgrade IBM AD V5.1.0.2 to IBM AD V5.1.0.4.

1. Run the IBM ADDI V5.1.0.4 installer without uninstalling AD components and make sure that the same
IBM AD installation path is used, but do not use the same IBM ADI installation path if ADI has been
previously installed.

Important: When using the IBM ADDI V5.1.0.4 installer, do not use the same installation path to
install a newer version of ADI over an existing version of ADI. Installing a higher level of ADI directly
over an existing instance of ADI can cause problems when trying to migrate ADI configuration
information and data to a newer level. For more information, see the Migrating from a previous release
section, in the ADI documentation.

2. Once the upgrade to IBM AD V5.1.0.4 is finalized, the following services need to be configured as
follows:

a. IBM AD File Service

Prior to IBM AD V5.1.0.3, the sources and the project folders need to be shared.

Starting with IBM AD V5.1.0.3, IBM AD File Service was introduced and in the context of the
authorization/authentication, the access rights of users or users' groups are mapped to a certain
folder with the source files that are on the same machine with IBM AD File Service or not. Once
authenticated and authorized, the user can start the analysis on the source files as long as the user
has read access rights.

If you still want to use the existing projects, you need to add the path to the shared sources
folders that were used during the project creation, when configuring IBM AD File Service. In this
way, you are still able to access the sources from another machine. This path needs to be added in
the conf.yaml file, in the mapping section, where the remote parameter is present.

Note:

• If the authorization/authentication feature is not used, for the new projects you need to have a
shared folder to access those files from another machine. For more information on how to
configure IBM AD File Service without authentication, see “STEP 4. Configuring IBM AD File
Service” on page 47.

• If the authorization/authentication feature is used, for the new projects it is not necessary to
have a shared folder. For more information on how to configure IBM AD File Service with
authentication, see “STEP 5. Configuring IBM AD File Service” on page 88.

b. IBM AD Search Service

Prior to IBM AD V5.1.0.3, IBM AD Batch Server was generating, through the index component, the
indexed data for the resources of a project into a path set in the project.properties file. In
IBM AD Analyze Client a search in resources was directly performed by using Search in Files
analysis.

Starting with IBM AD V5.1.0.3, IBM AD Search Service is responsible with the access to the
indexed data. Whether the authorization/authentication feature is used or not, the folder path in
which the indexes are generated needs to be accessible both for IBM AD Batch Server and IBM AD
Search Service. The path where the index data is generated needs to be added in the conf.yaml
file, where the indexPath parameter is present. This path can be found under <IBM ADDI
Installation Folder>\IBM Application Discovery Batch Server\conf
\project.properties, where the index.indexFolder parameter is present.

The path to the source folders that are added to the project or any additional folder that needs to
be indexed (apart from the project folders), needs to be added in the conf.yaml file of IBM AD
File Service, where the mapping section is present. The path to the additional folder can be found
under <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\conf\project.properties, where the index.extraSources parameter is present.

Note:
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• Make sure that IBM AD Search Service and IBM AD File Service are started as Search in Files
analysis depends on them. For more information on how to configure IBM AD Search Service
without authentication, see “STEP 8. Configuring IBM AD Search Service” on page 60.

• If the authorization/authentication feature is used, the user that is logged in IBM AD Analyze
Client needs to have read access rights to see the content of the files where the search pattern
appears. For more information on how to configure IBM AD Search Service with authentication,
see “STEP 9. Configuring IBM AD Search Service” on page 102.

c. IBM AD Manual Resolutions Service

Prior IBM AD V5.1.0.3, the dynamic call resolutions were stored and managed by using files located
in the .resolutions folder under each project's path.

Starting with IBM AD V5.1.0.3, IBM AD Manual Resolutions Service manages these files, so the
path where these files are generated is separated from project's path and needs to be accessible
only for IBM AD Manual Resolutions Service. This path where the journal files are generated
needs to be added in the conf.yaml file, where the projectPath parameter is present. Once a
project is imported, a folder with the same name is generated in that path and hosts all the files
that are needed to manage dynamic call resolutions. For more information on how to configure IBM
AD Manual Resolutions Service, see “STEP 5. Configuring IBM AD Manual Resolutions Service” on
page 50 (without authentication) or “STEP 6. Configuring IBM AD Manual Resolutions Service” on
page 92 (with authentication).

Note: Make sure that IBM AD Manual Resolutions Service is started as the import process
depends on it.

To preserve the journal files that were used in the previous versions, the moveResolutions.ps1
script allows you to automatically move the journal files from a previous location to a new
destination, where for each project, a folder that contains the journal files is created.

To run the moveResolutions.ps1 script, perform the following steps:

1) Go to the <IBM ADDI Installation Folder>\IBM Application Discovery Manual
Resolutions Service folder and locate the moveResolutions.ps1 script.

2) Run the moveResolutions.ps1 script by using Windows PowerShell.
3) Set the source parameter, which represents the path where the IBM AD Build Client projects

were created. The default path is found in IBM AD Configuration Server at the following
location: Home Page > "YourConfigurationServer:Port" > > Install Configurations > IBM
Application Discovery Build Client > Default projects path.

4) Set the destination parameter, which represents the path for the files that are moved on, as
described in step 5, in the Configuring IBM AD Manual Resolutions Service section.

5) As a result, all the journal files are moved in the newly set location.
d. IBM AD Mainframe Projects Service - is a mandatory service that needs to be configured to

authorize the access to the AD projects. The list of projects is not cached at the restart of the IBM
AD Analyze Client and it is necessary to use the Get project list contextual-menu option each time
when IBM AD Analyze Client starts. For more information on how to configure IBM AD Mainframe
Projects Service, see “STEP 6. Configuring IBM AD Mainframe Projects Service” on page 54
(without authentication) or “STEP 7. Configuring IBM AD Mainframe Projects Service” on page 96
(with authentication).

e. IBM AD Cross Applications Service - is an additional service that needs to be configured to show
calls between different mainframe projects that have their databases on the same DB instance. For
more information on how to configure IBM AD Cross Applications Service, see “STEP 9.
Configuring IBM AD Cross Applications Service” on page 63 (without authentication) or “STEP 10.
Configuring IBM AD Cross Applications Service” on page 106 (with authentication).

Note: Once the latest version of IBM Application Discovery and Delivery Intelligence is installed and
fully configured, you need to:

a. Mandatory, upgrade the repository for each project by using either IBM AD Build Client or IBM AD
Build Configuration and it is highly recommended to perform a full Build.
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b. Highly recommended to perform a full Build of each IBM AD project.

Instructions for upgrading the repository can be found at Upgrade a repository.

Instructions for performing a full Build of the project can be found at Building projects.

Upgrading from IBM AD V5.0.5.0, V5.0.5.1, V5.0.5.2 or V5.1.0.0

Steps to be performed when you upgrade IBM AD V5.0.5.0, V5.0.5.1, V5.0.5.2 or V5.1.0.0 to IBM AD
V5.1.0.4.

1. Before you run the IBM ADDI V5.1.0.4 installer, you must uninstall the IBM AD components, but do
not uninstall IBM ADI. For more information, see Chapter 10, “Uninstalling IBM AD Components,” on
page 123.

Important: When using the IBM ADDI V5.1.0.4 installer, make sure to install the IBM AD components
in the same folder as in the previous version, but do not use the same installation path to install a
newer version of ADI over an existing version of ADI. Installing a higher level of ADI directly over an
existing instance of ADI can cause problems when trying to migrate ADI configuration information and
data to a newer level. For more information, see the Migrating from a previous release section, in the
ADI documentation.

2. Delete the orientdb-community-2.1.5_ezpatch1 folder from the following location <IBM ADDI
Installation Folder>\IBM Application Discovery Batch Server\orientdb.

3. Once IBM AD V5.1.0.4 is installed, you need to perform the following steps since the version and the
location of OrientDB have changed.

a. Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\orientdb\orientdb-community-2.1.25-ibm1\bin\ and run server.bat on Windows or
server.sh on Linux. A command prompt window opens, asking for the root user account
password. Fill in a password of your choosing and press ENTER. The password is case-sensitive. A
message, which indicates that the service is now active is displayed.

b. Go to IBM AD Configuration Server and fill in the password for OrientDB at the following location:
Home Page > Configuration server name > Environments > "MyEnvironment" > Configurations
> "MyDefaultConfiguration" > Graph Database.

Note: At this point, OrientDB is configured to run with the root user name and the password that is
configured above.

Important:

• It is necessary to upgrade the repository for each project by using either AD Build Client or AD
Build Configuration and it is highly recommended to perform a full Build.

• In case that full Build is triggered, then step 3 can be skipped as the links will automatically be
created (it is recommended as a Best Practice).

c. Go to <IBM AD Batch Server Installation folder> and run
recoverGDBSymbolicLinks.bat on Windows and recoverGDBSymbolicLinks.sh on Linux
to re-create the symbolic links.

Note: Both of the files must be executed with the following two parameter values:
Location of the graph databases

"<IBM AD Batch Server Installation path>\data\tmp\gdb"
Location where the symbolic links must be created

"<IBM AD Batch Server Installation path>\orientdb\orientdb-community-2.1.25-
ibm1\databases"

Example: recoverGDBSymbolicLinks.bat "<IBM AD Batch Server Installation
path>\data\tmp\gdb" "<IBM AD Batch Server Installation path>\orientdb
\orientdb-community-2.1.25-ibm1\databases"

4. Make sure to configure the following services:

a. IBM AD File Service
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Prior to IBM AD V5.1.0.3, the sources and the project folders need to be shared.

Starting with IBM AD V5.1.0.3, IBM AD File Service was introduced and in the context of the
authorization/authentication, the access rights of users or users' groups are mapped to a certain
folder with the source files that are on the same machine with IBM AD File Service or not. Once
authenticated and authorized, the user can start the analysis on the source files as long as the user
has read access rights.

If you still want to use the existing projects, you need to add the path to the shared sources
folders that were used during the project creation, when configuring IBM AD File Service. In this
way, you are still able to access the sources from another machine. This path needs to be added in
the conf.yaml file, in the mapping section, where the remote parameter is present.

Note:

• If the authorization/authentication feature is not used, for the new projects you need to have a
shared folder to access those files from another machine. For more information on how to
configure IBM AD File Service without authentication, see “STEP 4. Configuring IBM AD File
Service” on page 47.

• If the authorization/authentication feature is used, for the new projects it is not necessary to
have a shared folder. For more information on how to configure IBM AD File Service with
authentication, see “STEP 5. Configuring IBM AD File Service” on page 88.

b. IBM AD Search Service

Prior to IBM AD V5.1.0.3, IBM AD Batch Server was generating, through the index component, the
indexed data for the resources of a project into a path set in the project.properties file. In
IBM AD Analyze Client a search in resources was directly performed by using Search in Files
analysis.

Starting with IBM AD V5.1.0.3, IBM AD Search Service is responsible with the access to the
indexed data. Whether the authorization/authentication feature is used or not, the folder path in
which the indexes are generated needs to be accessible both for IBM AD Batch Server and IBM AD
Search Service. The path where the index data is generated needs to be added in the conf.yaml
file, where the indexPath parameter is present. This path can be found under <IBM ADDI
Installation Folder>\IBM Application Discovery Batch Server\conf
\project.properties, where the index.indexFolder parameter is present.

The path to the source folders that are added to the project or any additional folder that needs to
be indexed (apart from the project folders), needs to be added in the conf.yaml file of IBM AD
File Service, where the mapping section is present. The path to the additional folder can be found
under <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\conf\project.properties, where the index.extraSources parameter is present.

Note:

• Make sure that IBM AD Search Service and IBM AD File Service are started as Search in Files
analysis depends on them. For more information on how to configure IBM AD Search Service
without authentication, see “STEP 8. Configuring IBM AD Search Service” on page 60.

• If the authorization/authentication feature is used, the user that is logged in IBM AD Analyze
Client needs to have read access rights to see the content of the files where the search pattern
appears. For more information on how to configure IBM AD Search Service with authentication,
see “STEP 9. Configuring IBM AD Search Service” on page 102.

c. IBM AD Manual Resolutions Service

Prior IBM AD V5.1.0.3, the dynamic call resolutions were stored and managed by using files located
in the .resolutions folder under each project's path.

Starting with IBM AD V5.1.0.3, IBM AD Manual Resolutions Service manages these files, so the
path where these files are generated is separated from project's path and needs to be accessible
only for IBM AD Manual Resolutions Service. This path where the journal files are generated
needs to be added in the conf.yaml file, where the projectPath parameter is present. Once a
project is imported, a folder with the same name is generated in that path and hosts all the files
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that are needed to manage dynamic call resolutions. For more information on how to configure IBM
AD Manual Resolutions Service, see “STEP 5. Configuring IBM AD Manual Resolutions Service” on
page 50 (without authentication) or “STEP 6. Configuring IBM AD Manual Resolutions Service” on
page 92 (with authentication).

Note: Make sure that IBM AD Manual Resolutions Service is started as the import process
depends on it.

To preserve the journal files that were used in the previous versions, the moveResolutions.ps1
script allows you to automatically move the journal files from a previous location to a new
destination, where for each project, a folder that contains the journal files is created.

To run the moveResolutions.ps1 script, perform the following steps:

1) Go to the <IBM ADDI Installation Folder>\IBM Application Discovery Manual
Resolutions Service folder and locate the moveResolutions.ps1 script.

2) Run the moveResolutions.ps1 script by using Windows PowerShell.
3) Set the source parameter, which represents the path where the IBM AD Build Client projects

were created. The default path is found in IBM AD Configuration Server at the following
location: Home Page > "YourConfigurationServer:Port" > > Install Configurations > IBM
Application Discovery Build Client > Default projects path.

4) Set the destination parameter, which represents the path for the files that are moved on, as
described in step 5, in the Configuring IBM AD Manual Resolutions Service section.

5) As a result, all the journal files are moved in the newly set location.
d. IBM AD Mainframe Projects Service - is a mandatory service that needs to be configured to

authorize the access to the AD projects. The list of projects is not cached at the restart of the IBM
AD Analyze Client and it is necessary to use the Get project list contextual-menu option each time
when IBM AD Analyze Client starts. For more information on how to configure IBM AD Mainframe
Projects Service, see “STEP 6. Configuring IBM AD Mainframe Projects Service” on page 54
(without authentication) or “STEP 7. Configuring IBM AD Mainframe Projects Service” on page 96
(with authentication).

e. IBM AD Cross Applications Service - is an additional service that needs to be configured to show
calls between different mainframe projects that have their databases on the same DB instance. For
more information on how to configure IBM AD Cross Applications Service, see “STEP 9.
Configuring IBM AD Cross Applications Service” on page 63 (without authentication) or “STEP 10.
Configuring IBM AD Cross Applications Service” on page 106 (with authentication).

Note: Once the latest version of IBM Application Discovery and Delivery Intelligence is installed and
fully configured, you need to:

a. Mandatory, upgrade the repository for each project by using either IBM AD Build Client or IBM AD
Build Configuration and it is highly recommended to perform a full Build.

b. Highly recommended to perform a full Build of each IBM AD project.

Instructions for upgrading the repository can be found at Upgrade a repository.

Instructions for performing a full Build of the project can be found at Building projects.

Upgrading to IBM AD V5.1.0.3
Note: Once the latest version of IBM Application Discovery and Delivery Intelligence is installed and fully
configured, you need to:

1. Mandatory, upgrade the repository for each project by using either IBM AD Build Client or IBM AD
Build Configuration and it is highly recommended to perform a full Build.

2. Highly recommended to perform a full Build of each IBM AD project.

Instructions for upgrading the repository can be found at Upgrade a repository.
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Instructions for performing a full Build of the project can be found at Building projects.

There are several steps and situations that you must take into account when upgrading to IBM AD
V5.1.0.3:

• IBM AD File Service, IBM AD Search Service, and IBM AD Manual Resolutions Service are mandatory
to be installed during the upgrade/install process.

• The procedure for upgrading is slightly different, depending on which existing version you have installed
before you begin the upgrade:

– From IBM AD V5.1.0.2
– From IBM AD V5.0.5.0, V5.0.5.1, V5.0.5.2 or V5.1.0.0

• Once the upgrade is completed, you need to perform additional steps to configure the new IBM AD
components. For more information, see “Additional steps to take for configuring the new components”
on page 32.

Upgrading to 5.1.0.3 from earlier levels:

• IBM AD V5.1.0.2

Run the IBM AD V5.1.0.3 installer without uninstalling AD components and make sure that the same
installation path is used.

• IBM AD V5.0.5.0, V5.0.5.1, V5.0.5.2 or V5.1.0.0

Important: Before running the IBM AD V5.1.0.3 ADDI installer, you must uninstall the IBM AD
components. For more information, see Chapter 10, “Uninstalling IBM AD Components,” on page 123.

Run the IBM AD V5.1.0.3 ADDI installer and make sure to install the IBM AD components in the same
folder as in the previous version.

Note that the version and location of OrientDB have changed. After installing IBM® AD V5.1.0.3, take
the following steps:

1. Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\orientdb\orientdb-community-2.1.25-ibm1\bin\ and run server.bat on Windows or
server.sh on Linux. A command prompt window opens, asking for the root user account
password. Fill in a password of your choosing and press ENTER. The password is case-sensitive. A
message indicating that the service is now active is displayed.

2. Go to IBM AD Configuration Server and fill in the password for OrientDB at the following location:
Home Page > Configuration server name > Environments > "MyEnvironment" > Configurations >
"MyDefaultConfiguration" > Graph Database.

Note: At this point, OrientDB is configured to run with the root user name and the password that is
configured above.

Important:

– It is a must to upgrade the repository for each project by using either AD Build Client or AD Build
Configuration and it is highly recommended to perform a full Build.

– In case that full Build is triggered, then step 3 can be skipped as the links will automatically be
created (it is recommended as a Best Practice).

3. Go to <IBM AD Batch Server Installation folder> and run
recoverGDBSymbolicLinks.bat on Windows and recoverGDBSymbolicLinks.sh on Linux to
re-create the symbolic links.

Note: Both of the files must be executed with the following two parameter values:
Location of the graph databases

"<IBM AD Batch Server Installation path>\data\tmp\gdb"
Location where the symbolic links must be created

"<IBM AD Batch Server Installation path>\orientdb\orientdb-community-2.1.25-
ibm1\databases"
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Example: recoverGDBSymbolicLinks.bat "<IBM AD Batch Server Installation
path>\data\tmp\gdb" "<IBM AD Batch Server Installation path>\orientdb
\orientdb-community-2.1.25-ibm1\databases"

Additional steps to take for configuring the new components

Once the upgrade to IBM AD V5.1.0.3 is finalized, it is mandatory to configure and start the following
components as follows:

IBM AD File Service

Prior to IBM AD V5.1.0.3, the sources and the project folders need to be shared.

Starting with IBM AD V5.1.0.3, IBM AD File Service was introduced and in the context of the
authorization/authentication, the access rights of users or users' groups are mapped to a certain folder
with the source files that are on the same machine with IBM AD File Service or not. Once authenticated
and authorized, the user can start the analysis on the source files as long as the user has read access
rights.

If you still want to use the existing projects, you need to add the path to the shared sources folders, that
were used during the project creation, when configuring IBM AD File Service. In this way, you are still
able to access the sources from another machine. This path needs to be added in the conf.yaml file, in
the mapping section, where the remote parameter is present.

Note:

• If the authorization/authentication feature is used, for the new projects you will not need to have a
shared folder.

• If the authorization/authentication feature is not used, for the new projects you will need to have a
shared folder in order to access those files from another machine.

IBM AD Search Service

Prior to IBM AD V5.1.0.3, IBM AD Batch Server was generating, through the index component, the
indexed data for the resources of a project into a path set in the project.properties file. In IBM AD
Analyze Client a search in resources was directly performed by using Search in Files analysis.

Starting with IBM AD V5.1.0.3, IBM AD Search Service is responsible with the access to the indexed
data. Whether the authorization/authentication feature is used or not, the folder path in which the indexes
are generated needs to be accessible both for IBM AD Batch Server and IBM AD Search Service. The
path where the index data is generated needs to be added in the conf.yaml file, where the indexPath
parameter is present. This path can be found under <IBM ADDI Installation Folder>\IBM
Application Discovery Batch Server\conf\project.properties, where the
index.indexFolder parameter is present.

The path to the source folders that are added to the project or any additional folder that needs to be
indexed (apart from the project folders), needs to be added in the conf.yaml file of IBM AD File Service,
where the mapping section is present. The path to the additional folder can be found under <IBM ADDI
Installation Folder>\IBM Application Discovery Batch Server\conf
\project.properties, where the index.extraSources parameter is present.

Note:

• Make sure that IBM AD Search Service and IBM AD File Service are started as Search in Files analysis
depends on them.

• If the authorization/authentication feature is used, the user that is logged in IBM AD Analyze Client
needs to have read access rights to see the content of the files where the search pattern appears.

IBM AD Manual Resolutions Service

Prior IBM AD V5.1.0.3, the dynamic call resolutions were stored and managed by using files located in
the .resolutions folder under each project's path.

Starting with IBM AD V5.1.0.3, IBM AD Manual Resolutions Service manages these files, so the path
where these files are generated is separated from project's path and needs to be accessible only for IBM
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AD Manual Resolutions Service. This path where the journal files are generated needs to be added in the
conf.yaml file, where the projectPath parameter is present. Once a project is imported, a folder with the
same name is generated in that path and hosts all the files that are needed to manage dynamic call
resolutions.

Note: Make sure that IBM AD Manual Resolutions Service is started as the import process depends on
it.

In order to preserve the journal files that were used in the previous versions, the moveResolutions.ps1
script allows you to automatically move the journal files from a previous location to a new destination,
where for each project, a folder that contains the journal files is created.

To run the moveResolutions.ps1 script, perform the following steps:

1. Go to the <IBM ADDI Installation Folder>\IBM Application Discovery Manual
Resolutions Service folder and locate the moveResolutions.ps1 script.

2. Run the moveResolutions.ps1 script by using Windows PowerShell.
3. Set the source parameter, which represents the path where the IBM AD Build Client projects were

created. The default path is found in IBM AD Configuration Server at the following location: Home
Page > "YourConfigurationServer:Port" > > Install Configurations > IBM Application Discovery
Build Client > Default projects path.

4. Set the destination parameter, which represents the path for the files that are moved on, as described
in step 5, in the Configuring IBM AD Manual Resolutions Service section.

5. As a result, all the journal files are moved in the newly set location.

Upgrading to IBM AD V5.1.0.2 from versions V5.0.5.0, V5.0.5.1, V5.0.5.2 or
V5.1.0.0

Note: Once the latest version of IBM Application Discovery and Delivery Intelligence is installed and fully
configured, you need to:

1. Mandatory, upgrade the repository for each project by using either IBM AD Build Client or IBM AD
Build Configuration and it is highly recommended to perform a full Build.

2. Highly recommended to perform a full Build of each IBM AD project.

Instructions for upgrading the repository can be found at Upgrade a repository.

Instructions for performing a full Build of the project can be found at Building projects.

Run the IBM® AD V5.1.0.2 installer without uninstalling AD components and make sure that the same
installation path is used.

Please note that the version and location of OrientDB have changed. After installing IBM® AD V5.1.0.2,
take the following steps:

1. Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\orientdb\orientdb-community-2.1.25-ibm1\bin\ and run server.bat on Windows or
server.sh on Linux. A command prompt window opens, asking for the root user account password.
Fill in a password of your choosing and press ENTER. The password is case-sensitive. A message
indicating that the service is now active is displayed.

2. Go to IBM AD Configuration Server and fill in the password for OrientDB at the following location:
Home Page > Configuration server name > Environments > "MyEnvironment" > Configurations >
"MyDefaultConfiguration" > Graph Database.

Note: At this point, OrientDB is configured to run with the root user name and the password that is
configured above.

Important:

• It is a must to upgrade the repository for each project by using either AD Build Client or AD Build
Configuration and it is highly recommended to perform a full Build.
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• In case that full Build is triggered, then step 3 can be skipped as the links will automatically be
created (it is recommended as a Best Practice).

3. Go to <IBM AD Batch Server Installation folder> and run
recoverGDBSymbolicLinks.bat on Windows and recoverGDBSymbolicLinks.sh on Linux to
re-create the symbolic links.

Note: Both of the files must be executed with the following two parameter values:
Location of the graph databases

"<IBM AD Batch Server Installation path>\data\tmp\gdb"
Location where the symbolic links must be created

"<IBM AD Batch Server Installation path>\orientdb\orientdb-community-2.1.25-ibm1\databases"

Example: recoverGDBSymbolicLinks.bat "<IBM AD Batch Server Installation path>
\data\tmp\gdb" "<IBM AD Batch Server Installation path>\orientdb\orientdb-
community-2.1.25-ibm1\databases"

Upgrading to IBM AD V5.0.5.0
To upgrade to IBM AD V5.0.5.0, you can run the ADDI installer without uninstalling AD components.

Note: After upgrading the IBM AD code to the latest level, take the following steps:

1. Upgrade the repository database to the latest level.
2. Perform a full Build of each IBM AD project to correctly populate the repository database and allow the

corresponding changes to be propagated to the graph database.

Instructions for upgrading the repository can be found at Upgrade a repository.

Instructions for performing a full Build of the project can be found at Building projects.

Upgrading to IBM AD V5.0.4.2
Before upgrading to IBM AD V5.0.4.2, you must back up the configurations and uninstall the IBM AD
components.

Important: Please note that the location of the products you are about to install might be different than
the one from previous installations. To maintain the existing configurations, be sure to:

• Back up the configurations before uninstalling the application by following the backup steps described
below under each application.

• Once the application is installed, restore the backed-up configurations by manually copying them into
the new location.

Before you upgrade to a newer version, follow the steps to keep your old configurations:

IBM AD Configuration Server (from v5.0.2.x onwards)

To back up the data from IBM AD Configuration Server (also the projects published by IBM AD Build
Client in IBM AD Configuration Server), please make sure you keep:

• The store folder.
• The conf folder.

Both folders are stored under the IBM AD Configuration Server installation folder. To restore these
settings copy them from the backup location into the new installation folder.

IBM AD Analyze Server

When uninstalling the IBM AD Analyze Server, there is an automated process that creates a backup for
the server.properties and client.properties files, renaming them to
server.properties.bak and client.properties.bak. If you want to keep previous settings,
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please make sure you do not delete these files. They are kept under the installation folder. To restore
these settings, copy server.properties.bak and client.properties.bak from the backup
location to the new installation folder and rename them back to server.properties and
client.properties.

IBM AD Batch Server

To back up the data from IBM AD Batch Server make sure you don’t delete:

• The conf folder. Note that from one version to another, the server.properties and the
project.properties files structure might change. It is better not to overwrite the new files with the
old ones, but instead to copy the parameters and their values that were modified by the administrator
from the old files into the same parameter/value settings in the corresponding new files.

• The data folder.
• The orientDB folder.

All the folders are kept under the installation folder. To restore these settings copy them from the backup
location into the new installation folder.

Details on how to back up the Symbolic Links: The following part describes how to manually move the
Symbolic Links to a temporary location depending on the OS used (Windows or Linux System).

1. On Windows. Before uninstalling IBM AD Batch Server:

• Go to Start menu under IBM AD Batch Server and stop IBM AD Web Service, IBM AD GraphDB
Service and IBM AD Batch Service.

• Backup the content of databases folder present under \IBM Application Discovery Batch
Server installation folder>\orientdb\orientdb-
community-2.1.5_ezpatch1\databases using the following command in a command prompt
window:

robocopy "path to source folder" "path to the target folder" /S /SL

Note: Path to source folder is the path to the databases folder under IBM AD Batch Server
installation folder. Path to the target folder is the path to a folder created on the disk where the
content of the databases folder will be copied. (example: robocopy "C:\Program Files\IBM
Application Discovery Batch Server\orientdb\orientdb-
community-2.1.5_ezpatch1\databases" "C:\databases" /S /SL)

• Once you install IBM AD Batch Server use robocopy command to copy from the folder where the
symbolic links were saved to the databases folder under \IBM Application Discovery Batch
Server installation folder>\orientdb\orientdb-community-2.1.25-ibm1.
(Example: robocopy "C:\databases" "C:\Program Files\IBM Application Discovery Batch Server
\orientdb\orientdb-community-2.1.25-ibm1\databases" /S /SL)

Note: Once the installation of IBM AD Batch Server is completed set the password for GraphDB
server. For more information, see step 2 in Configuring IBM AD Batch Server.

2. On Linux (from v5.0.4.1 onwards). Before uninstalling IBM AD Batch Server:

• Stop IBM AD Web Server, IBM AD GraphDB Server and IBM AD Batch Server.
• Backup the content of databases folder present under \IBM Application Discovery Batch
Server installation folder>\orientdb\orientdb-
community-2.1.5_ezpatch1\databases using the following command in a terminal:

cp -Prv "path to source folder" "path to the target folder"

Note: Path to source folder is the path to the databases folder under IBM AD Batch Server
installation folder. Path to the target folder is the path to a folder created on the disk where the
content of the databases folder will be copied (Example: cp -Prv /home/user/IBM\ Application\
Discovery\ Batch\ Server/orientdb/orientdb-community-2.1.5_ezpatch1/databases/* /home/user/
databases)
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• Once you install IBM AD Batch Server use the same command to copy from the folder where the
symbolic links were saved to the databases folder under \IBM Application Discovery Batch
Server installation folder>\orientdb\orientdb-community-2.1.25-ibm1.
(Example: cp -Prv /home/user/databases/* /home/user/IBM\ Application\ Discovery\ Batch\ Server/
orientdb/orientdb-community-2.1.25-ibm1/databases)

Note: Once the installation of IBM AD Batch Server is completed set the password for GraphDB
server. For more information, see step 2 in Configuring IBM AD Batch Server.

IBM AD Build Client

Important: When upgrading from IBM AD Build v5.0.1.x to v5.0.4.1, take the following steps:

1. Uninstall the existing v5.0.1.x components.
2. Install any v5.0.3.x AD Build Configuration and Client.
3. Install IBM AD Configuration Server v1.0.6, which is included with IBM AD v5.0.3.x.
4. From AD Build Configuration Administration tool, click Publish Projects.
5. Once the projects have been published, uninstall the v5.0.3.x Build Components and v1.0.6 IBM AD

Configuration Server.
6. Proceed with 5.0.4.1 installation.

Important: When upgrading from IBM AD Build v5.0.2.x to v5.0.4.1:

Once the installation of IBM AD Build Client is done (on the same machine where previous version of IBM
AD Build Configuration was installed), a file called ConfigurationParameters.txt is automatically
generated in the installation folder under the folder bin, subfolder release. This file contains all
information related to the configurations made in IBM AD Configuration Server for IBM AD Build Client:

• Path for the Mainframe Connection (Path)
• Encoding (Japanese / No Encoding)
• Member Synchronization information (Yes / No and Path)
• Enable Communication Logging (Yes / No)
• Keep communication buffers (Yes/No)

Note: The user must add these configurations in the IBM AD Build Client settings page from IBM AD
Configuration Server. This step is a must to maintain the old configurations.
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Chapter 5. Installing IBM AD

You can use the IBM Application Discovery and Delivery Intelligence for IBM Z (ADDI) installer or
Command Line Installation to install IBM AD.

Installing with the IBM ADDI Installer
To install IBM AD on Windows or Linux, use the IBM ADDI installer. You can also use the IBM ADDI
installer to install IBM Application Delivery Intelligence for IBM Z (ADI).

Procedure

1. To run the IBM ADDI installer, double-click the
IBM_Application_Discovery_and_Delivery_Intelligence_Installer-5.1.0.x.exe file.

2. On the Welcome page, click Next.
3. On the Licensing Agreements page, click I accept the terms of this license agreement, and then

click Next.
4. On the Installation Path page, specify the installation path, and then click Next. The default

installation path is C:\Program Files\IBM Application Discovery and Delivery
Intelligence.

If the installation path that you specify does not exist, the target directory is created. Confirm the path,
and click OK in the Message dialog box.

5. On the Select Installation Components page, select the components that you want to install, and
then click Next. The components that are not applicable for the current system cannot be selected.

Figure 2. Select Installation Components wizard page
6. On the User Data pages, specify the settings and click Next.
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a. If the IBM Application Delivery Intelligence (ADI) check box was selected in step 5, you can specify
the IBM ADI installation path. The default installation path is C:\ibm.

b. Specify the configuration service IP address and service port for IBM AD Build Client.
7. On the Setup Shortcuts page, select the shortcuts that you want to create, and then click Next.
8. Additionally, after the installation is completed choose the Generate an automatic installation script

option to create an installation script, where the installation parameters are saved in a *.xml file, that
can be used later for silent installations. A Save dialog box is displayed, allowing to choose the
location and name of the installation script. By default, the name of the installation script is auto-
install.xml.

Alternative Installation for IBM ADDI Using CLI

In case you do not have access to a graphic interface, follow this procedure to install IBM ADDI:

1. Navigate to the IBM ADDI installation path and open a command line.
2. For regular installation, run the following command:

java –jar "<installer name>" 

3. For a silent installation, run the following command:

java –jar "<installer name>" -f "<path to install xml file>"

Note:

• The <installer name> represents the full name including the .exe extension.
• To install in silent mode, make sure that an interactive installation was initially performed and that

the automatic installation script was generated. For more information, see step 8 in “Installing with
the IBM ADDI Installer” on page 37.
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Chapter 6. Configuring IBM AD

After IBM AD is installed, follow the steps to configure the components.

Without Authentication

STEP 1. Configuring IBM AD Configuration Server

About this task
The IBM AD Configuration Server component can run with the default settings. If the default settings are
not compatible with your environment, you can configure the component and overwrite the default
settings.

Procedure

1. Configure the settings in the <IBM ADDI Installation Folder>/IBM Application
Discovery Configuration Service/conf/server.properties file.
a) Configure the port that AD Configuration Server listens on by setting the value of the server.port

parameter.
The default value is 2181.

b) Configure the number of the snapshots and the corresponding logs that are retained by AD
Configuration Server. To configure the setting, set the value of the
zookeeper.autopurge.snapRetainCount parameter.
The default value is 4, and the minimum value is 3.

c) Configure the time interval in hours for the purge task by setting the value of the
zookeeper.autopurge.purgeInterval parameter.
The purge task deletes old snapshots and the corresponding log files according to the time interval.
The default value of the parameter is 24. To enable the purge task, you must set a value that is
greater than 0.

2. Configure the web server settings in the <IBM ADDI Installation Folder>/IBM Application
Discovery Configuration Service/conf/webservice.log4j.properties file.
a) Configure the root logger level and the appenders by setting the log4j.rootLogger parameter

with one of the following values:

• OFF
• FATAL
• ERROR
• WARN
• INFO
• DEBUG
• TRACE
• ALL

The default log level is INFO. The default appenders are file, which indicates a rolling file
appender, and stdout, which indicates a console appender.

Example

log4j.rootLogger=DEBUG

© Copyright IBM Corp. 2010, 2019 39



b) Configure the file roller appender log level by setting the log4j.appender.file.threshold
parameter with one of the following values:

• OFF
• FATAL
• ERROR
• WARN
• INFO
• DEBUG
• TRACE
• ALL

Note: If you do not set the value of the log4j.appender.file.threshold parameter, the file
roller appender log level is the same as the root logger level. To set the
log4j.appender.file.threshold parameter, the value must be lower than or equal to the
root logger level.

Example

log4j.appender.file.threshold=ERROR

c) Configure the file roller appender location by setting the value of the
log4j.appender.file.File parameter.

Note: The value of the log4j.appender.file.File parameter must be a valid absolute or
relative path.

Example

log4j.appender.file.File=/home/user/logs/webservice.log

d) Configure the file roller appender minimum number of backup files to keep by setting the value of
the log4j.appender.file.MaxBackupIndex parameter.

Example

 log4j.appender.file.MaxBackupIndex=5

e) Configure the file roller appender maximum file size by setting the value of the
log4j.appender.file.MaxFileSize parameter.

Example

log4j.appender.file.MaxFileSize=100M

3. Configure the web server settings in the <IBM ADDI Installation Folder>/IBM Application
Discovery Configuration Service/conf/admin-ws.properties file.
The web server is attached to AD Configuration Server.
a) Configure the network interface that the web server listens on by setting the value of the host

parameter.
The default value is localhost.

Note: To expose the web server, you must set the host parameter with one of the following values:
IP_address

One of the IP addresses that are attached to a network interface on the computer where AD
Configuration Server is running.

0.0.0.0
Exposes the web server to all network interfaces.

b) Configure the port that the web server listens on by setting the value of the port parameter.
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The default value is 8080.

Note: If the web server is exposed to the network, the communication on the specified port must
be enabled by the firewall.

c) Configure the path to the configuration file of the logger by setting the value of the log-conf-
file parameter.
The default value is <IBM ADDI Installation Folder>/IBM Application Discovery
Configuration Service/conf/webservice.log4j.properties.

4. By default, the HTTP protocol is used to run the web service. To use the SSL/HTTPS protocol, follow
the steps:
a) Generate a self-signed key pair and store it in a Java keystore by using the Java Keytool command-

line interface. Run the following command:

Note: Java SDK or Java JRE must be installed, and the JAVA_HOME and PATH environment
variables must be configured for the Java SDK or Java JRE.

keytool -genkeypair -keyalg RSA -alias {alias} 
-ext SAN=DNS:localhost,IP:127.0.0.1 -dname {dname} 
-validity {validity} -keysize 2048 -keypass {keypass} 
-storepass {storepass} -keystore {keystore}

{alias}
The name that is used by the Java keystore to identify the generated key. The name must be
unique within the Java keystore.

{dname}
The distinguished name from the X.500 standard. This name is associated with the alias for the
key pair in the keystore. Also, the name is used as the value in the "issuer" and "subject" fields
in the self-signed certificate.

{validity}
The number of days that the certificate that is attached to the key pair is valid.

{keypass}
The password that is needed to access the key pair within the keystore.

{storepass}
The password for the Java keystore.

{keystore}
The path to the keystore file, which is used to store the generated key pair. If the file does not
exist, a keystore file is created.

Example

keytool -genkeypair -keyalg RSA -alias my-key-pair
-ext SAN=DNS:localhost,IP:127.0.0.1 -dname CN="IBM AD" 
-validity 9999 -keysize 2048 -keypass my-key-password 
-storepass my-store-password -keystore C:\my_keystore

b) Configure the web server that is attached to IBM AD Configuration Server to use the SSL/HTTPS
protocol. In the <IBM ADDI Installation Folder>/IBM Application Discovery
Configuration Service/conf/keystore-config.properties file, configure the following
parameters:
path

Set the value to the path of the Java keystore that is generated in the preceding substep.
storepass

Set the value to the password for the Java keystore.
keypass

Set the value to the password that is needed to access the key pair within the keystore.
c) In the <IBM ADDI Installation Folder>/IBM Application Discovery
Configuration Service/conf/admin-ws.properties file, set the value of the keystore-
conf-file parameter to the path of the keystore configuration file.
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5. Start IBM Application Discovery Configuration Admin Service and IBM Application Discovery
Configuration Service

• On Windows the services start automatically after the installation of IBM Application Discovery
Configuration Service. In case that they are not up and running follow these steps:

a. Click Start, select Run, type services.msc and start IBM Application Discovery Configuration
Admin Service and IBM Application Discovery Configuration Service.

b. If the service does not start, check the server.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Configuration Service/ folder.

• On Linux

a. Go to <IBM ADDI Installation Folder>/IBM Application Discovery
Configuration Service/ and locate the startServer.sh and startWebServerUI.sh
files.

b. In case that the .sh files are not executable, open a terminal and run the following commands for
flagging them as executable:

chmod +x startServer.sh

and

chmod +x startWebServerUI.sh

c. If the service does not start, check the server.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Configuration Service/ folder.

Important: For monitoring the IBM AD Configuration Server tasks, see Chapter 7, “Log Files
Location,” on page 115.

STEP 2. IBM AD Configuration Server: Configurations for IBM AD Build Client

About this task

IBM AD Configuration Server ensures that the installation parameters are consistent throughout the
different components of IBM AD by storing them in a central location, in a scalable, and fail-safe manner.

IBM AD Configuration Server additionally allows the system administrator to coordinate the access to the
resources by creating workspaces and user groups.

Procedure

1. Start IBM AD Configuration Server, by selecting Start > All Programs > IBM Application Discovery
Configuration Service > Launch IBM Application Discovery Configuration Service Admin.

2. Create an environment, on the IBM AD Configuration Server main page, by selecting the localhost
server. From the available options, select Environments then click Add Environment. Enter a name
and a description for the new environment then click Save. Select the newly defined environment. A
Default workspace is automatically created for the new environment and is attached to it. Also, a
Default blank configuration is automatically created and attached to the new environment.

Note: The environment ID will be later used in configuring other components.
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3. On the IBM Application Discovery Configuration Servers Admin page, click localhost:2181 > Install
Configurations > IBM Application Discovery Build Client, and configure the following parameters.
a) Default Project path: A default path where all AD Build Client projects are stored. Add the

path so that it can be accessed by any AD Build, Analyze Clients and AD Batch Server. This
default path can be changed while creating a Project in AD Build Client.

b) zOS configuration folder: A default path where the z/OS Connections are stored. Add the
path so that it can be accessed by any AD Build Client / AD Build Configuration Administration
tool.

c) Path for the retrieved members: A default path where all the members downloaded from a
Mainframe system, are stored. Add the path so that it can be accessed by any AD Build, Analyze
Clients and AD Batch Server.

4. To add a relational database server, in IBM AD Configuration Server main page, from the available
servers, select the localhost server where you defined your environment. From the available options,
select Environments > your Environment then click Relational database servers. Click Add
relational database server and enter the following parameters:

• Name: Enter a name for the relational database server.
• Host: IP or name of the computer where the relational database server is installed.
• Port: The relational database server port. The default port for SQL Server is 1433.
• Instance/Location: The relational database server instance name (if exists).
• Username/Password: User name and password for the IBM AD SQL Identity as defined in

“Microsoft SQL Server Configurations” on page 9, or for the Db2 for z/OS instance.
5. At this point, you can create new projects in AD Build Client.

Note: For more information on how to create new projects, please refer to IBM AD Build User Guide.

Note: In order to activate your IBM AD Build Client copy, follow the procedure described in Chapter 9,
“Activating Your IBM AD,” on page 121.

Important: For monitoring the IBM AD Build Client tasks, see Chapter 7, “Log Files Location,” on
page 115.
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STEP 3. (Optional) Configuring IBM AD Validation Service

About this task

IBM AD Validation Service component is specific only for ChangeMan ZMF users, therefore it is not part
of the must have components installation.

IBM AD Validation Service is automatically installed during the IBM AD Build installation.

IBM AD Validation Service acts like a listener and is linked directly with IBM AD Connect for Mainframe
component (Mainframe Agents).

After IBM AD Validation Service is installed, go to <IBM AD Build Client installation folder>
\Bin\Release\IBMApplicationDiscoveryValidationServer\SampleConf.

Select all configuration files and copy them to <IBM AD Build Client installation folder>
\Bin\Release\IBMApplicationDiscoveryValidationServer.

Next, perform the following configurations.

Procedure

1. Configure ProjectsMapping.txt to have a valid input. This is the configuration file for defining the
mapping between the projects that are used to download mainframe members, applications, and
subsystems.

Note: Comparing with the ProjectsMappingParallelBuild.txt file, the projects that are
specified in the ProjectsMapping.txt file do not need to contain the virtual folder that is specified
in the FoldersMapping.txt file, as they are not used for builds. However, a z/OS connection must
be attached and configured to the projects.

Each line of the configuration file must have the following comma-separated values format:

<ProjectName>, <ApplicationName>, <Subsystem>

Note:

• <ProjectName> represents the project that is defined in IBM AD Build Client.
• <ApplicationName> and <Subsystem> are defined in ChangeMan ZMF.

Example of the configuration file:

Project1, App1, Subsys1

2. Configure IncludesOrder.txt to have a valid input. This is the configuration file for defining the
ChangeMan Baseline Libraries Types and the order of COBOL Includes locations. This configuration file
is used later on while you set up the path for the COBOL Include folders
The configuration file must have the following comma-separated values format:

<Type1>, <Type2>,…, <Typen>

Example of the configuration file:

CPY, INC, IND, CPA

Note: It is EXTREMELY important to add the types in the order in which the include files must be
looked after.

3. Configure FoldersMapping.txt to have a valid input. This is the configuration file for defining a
mapping between a type of a mainframe member, that is defined in ChangeMan ZMF, and a virtual
folder name of an IBM AD project. This configuration file is used during the synchronize phase of the
validation process.
Each line of the configuration file must have the following comma-separated values format:

<MemberType>, <VirtualFolderName>
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• <MemberType> is defined in ChangeMan ZMF.
• <VirtualFolderName> is defined in IBM AD Build Client.

Examples of the configuration file:

COB, zOS Cobol

ASM, Assembler

4. Configure ServicePort.txt to have a valid input. This is the configuration file for defining the
Service’s port.
The configuration file must have the following format:

<Port Number>

Any available port can be used, for example:

48000

5. Enable or disable sending feedback to the mainframe by configuring the LoopbackResults.txt file
with one the following values:
Y

Enables sending feedback to the mainframe according to the weight of rules.
N

Disables sending feedback to the mainframe.
6. Set parallel validation parameters for the maximum-allowed values by configuring the
ParallelValidationParameters.txt.

The configuration file must have the following comma-separated values format:

<Number_of_validations_in_parallel>,<Number_of_components_per_validation>

Note:

• Do not set the number of validations in parallel greater than the number of CPU cores. Otherwise,
the validation process might be unstable.

• Do not set the number of components per validation greater than 20. Otherwise, the performance
might be negatively affected.

Examples of the configuration file:

4,10

Allows a maximum of four validation instances in parallel, and a maximum of 10 stages or members
that are allocated for each instance. You can set these values for a computer with 4 CPU cores.

8,15

Allows a maximum of eight validation instances in parallel, and a maximum of 15 members that are
allocated for each instance. You can set these values for a computer with 8 CPU cores.

7. Configure the mapping between the projects that are used to compile the members to be validated in
parallel, applications, and subsystems. Set the mapping values in the
ProjectsMappingParallelBuild.txt file.

Each line of the configuration file must have the following comma-separated values format:

<ProjectName>, <ApplicationName>, <Subsystem>

Note:

• <ProjectName> represents the project that is defined in IBM AD Build Client.
• <ApplicationName> and <Subsystem> are defined in ChangeMan ZMF.
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• The number of the projects that are mapped to one pair of an application and a subsystem must be
greater than or equal to the maximum number of validations in parallel, which is specified in the
ParallelValidationParameters.txt file. Otherwise, the service cannot start.

• Comparing with the ProjectsMapping.txt file, the projects that are specified in the
ProjectsMappingParallelBuild.txt file do not need to have a z/OS connection that is
attached and configured, as they are used only for builds. However, the projects must contain the
virtual folder that is specified in the FoldersMapping.txt file.

The following example shows the mapping configurations for eight validations in parallel:

Project1, App1, Subsys1
Project2, App1, Subsys1
Project3, App1, Subsys1
Project4, App1, Subsys1
Project5, App1, Subsys1
Project6, App1, Subsys1
Project7, App1, Subsys1
Project8, App1, Subsys1
Project9, App2, Subsys1
Project10, App2, Subsys1
Project11, App2, Subsys1
Project12, App2, Subsys1
Project13, App2, Subsys1
Project14, App2, Subsys1
Project15, App2, Subsys1
Project16, App2, Subsys1

8. Configure the completion code for messages by configuring the CompletionCodeVsMessage.txt
file.

Each line of the configuration file must have the following pipe-delimited format:

<CompletionCode>|<DescriptiveMessage>

Note: The descriptive message must have a maximum length of 23 characters.

Example of the configuration file:

0|Validation Success
4|Validation Warning
8|Validation Failed

Each of the numbers in the example reflects the weight of the rule that is specified in the
ruleBased.properties file.

9. Configure the approval request parameters in the ApprovalRequestParameters.txt file.

Each line of the configuration file must have the following comma-separated values format:

<ProjectName>,<ProcLibrary>

Note:

• <ProjectName> represents the project that is defined in IBM AD Build Client.
• <ProcLibrary> is a PDS/E library that is defined in ChangeMan ZMF.
• <ProcLibrary> must have a maximum length of 23 characters.

Example of the configuration file:

Project1,PJ.PROCLIB.S814

What to do next

Start IBM AD Validation Service: Click Start and then select All Programs > IBM Application Discovery
Build Client > Start IBM Application Discovery Validation Service.

The service can also be started from Windows Services (services.msc) by locating
IBMApplicationDiscoveryValidationServer and pressing Start.
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Important: For monitoring the Validation Service tasks, see Chapter 7, “Log Files Location,” on page
115.

STEP 4. Configuring IBM AD File Service
Follow the configuration steps that are needed to have up and running IBM AD File Service:

1. Configure the parameters that are present in the conf.yaml file
2. Start IBM AD File Service
3. Make IBM AD File Service available in IBM AD Configuration Server

1. Configure the parameters that are present in the conf.yaml file

On the machine where IBM AD File Service is installed, go to <IBM ADDI Installation
Folder>/IBM Application Discovery File Service/sample-conf/ and copy the conf.yaml
file to <IBM ADDI Installation Folder>/IBM Application Discovery File Service/
conf/. Open the conf.yaml file by using a text editor and enter the desired values for the parameters
that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value

1. Enter the port on which IBM AD File Service listens to. The default value is 7700.

#port to listen to
port: 7700

2. Set the https parameter as follows:

a. If the https parameter is set to false, a non-secured communication is used.

#if true, tls information (key, cert) must be specified
https: false

b. If the https parameter is set to true, a secured communication is used.

Note: This step implies the use of certificates. If you want to set the communication to be
secured, make sure that a certificate authority issues a signed certificate (.crt) and a private key
for the certificate (.key).

#if true, tls information (key, cert) must be specified
https: true

3. If the https parameter is set to true and the TLS certificate for IBM AD File Service are generated,
enter the paths of the certificate(.crt) and the key(.key) files. If the https parameter is set
to false leave blank the following lines. Example:

#mandatory if https: true
tls:
    key: C:\certs\file.service.key
    cert: C:\certs\file.service.crt

4. Leave blank the line where the authSrv parameter is present since Authentication Server (DEX) is
not needed.

#authentication server URL
authSrv:

5. In the mapping section, configure the remote parameter as follows:

• For the newly created projects, you need to add the path to the source folders that were used
during the project creation.
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• If you still want to use the previously created projects, you need to add the path to the shared
source folders that were used during the project creation.

Note: In case you want to use multiple folders, an entry for each mapping needs to be added.

#mapping specifies path query prefixes to local paths as a list
#of entries with the following keys:
#   remote: a remote path that can be used to query this service
#           for example, a UNC path
#   local:  local path that mirrors the remote path. If missing, it is 
#           identical to remote
#   groups: a list of group names that are allowed in all subfolders
#           of the local path. Since paths are matched by remote
#           the most specific remote will be used to obtain the groups
#           If groups are not specified, all authorized users have access.
mapping: 
   -  remote: \\9.20.128.222\Resources 
      local: C:\Resources 
      groups:  

  -   remote: \\9.20.128.222\Resources2 
      local: C:\Resources2 
      groups:

6. The caseSensitive parameter can be set to true or false. Through this parameter, you set the
mapping type (case-sensitive) of the folders under which the resources are located.

caseSensitive: false

7. The default value of the disableAuth parameter is true. Leave the default value since Authentication
Server (DEX) is not needed.

#disable authentication/authorization. allow all files to be sent
disableAuth: true

8. The default value of the matchUsers parameter is false, which means that the matching is made by
group names. If you want to authorize users and not groups, set the matchUsers to true and define
users in IBM AD Configuration Server. For more information, see Adding a User.

matchUsers: false

9. Configure the groups section as follows:

groups: 

  - type: ccs 
    #addrs - (mandatory) a list of servers that serve as CCS endpoints 
    addrs: [127.0.0.1] 
    #env (mandatory) the environment in CCS server 
    env: a8155844-be04-4193-a389-32993beccb0f 

Where:

• Type is ccs.
• Addrs is the IP address of the machine where IBM AD Configuration Server is installed.
• Env is the environment ID defined in IBM AD Configuration Server.

Note:

• By defining Groups and Users in IBM AD Configuration Server you can decide which users can
access the related mapping folders.

• If no Groups or Users are defined in IBM AD Configuration Server and no groups are listed in the
mapping section all users have access to the related mapping folders.

10. Optionally, add the refresh time to check periodically the groups that are present in IBM AD
Configuration Server.

#groupsPolling (optional) - refresh period expressed as a time duration
GroupsPolling: 2h
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2. Start IBM AD File Service

• On Windows

1. Click Start, select Run, type services.msc and start IBM Application Discovery File Service.
2. If the service does not start, check the .log file under <IBM ADDI Installation Folder>/IBM
Application Discovery File Service/ folder.

• On Linux

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery File Service/
folder and locate the micro-srcd-x.x.x.bin file.

2. In case that the .bin file is not executable, open a terminal and run the following command for
flagging them as executable:

chmod +x micro-srcd-x.x.x.bin

3. If the service does not start, check the .log file under <IBM ADDI Installation Folder>/IBM
Application Discovery File Service/ folder.

3. Make IBM AD File Service available in IBM AD Configuration Server

After IBM AD File Service is up and running, go to IBM AD Configuration Server and make IBM AD File
Service available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.

2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD File Service configuration. From the options that are displayed under the
selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Services.

4. The Services page is displayed. Select File Service.
5. The parameters that can be defined for the selected service are displayed in the right of the page.
6. The "File Service" page is displayed as in the following image.
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Click Edit and enter the following information:

• Service base link: Expects the URL of the File Service. It represents the full computer name or IP of
the machine that hosts the File Service and the port to which it listens.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7700

• Endpoints

– File Content endpoint: Expects the URL of File Service and the endpoint (file) used to obtain
the file content.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7700/file

– File Content and extra info endpoint: Expects the URL of File Service and the endpoint (fas)
used to obtain the file contents and to return a status.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7700/fas

– Line by offset endpoint: Expects the URL of File Service and the endpoint (lao) used to obtain
the corresponding text for a given list of offsets.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7700/lao

– Line by number endpoint: Expects the URL of File Service and the endpoint (lan) used to obtain
the corresponding text for a given list of line numbers.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7700/lan

7. Click Save to save the parameters.

STEP 5. Configuring IBM AD Manual Resolutions Service
Follow the configuration steps that are needed to have up and running IBM AD Manual Resolutions
Service:
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1. Configure the parameters that are present in the conf.yaml file
2. Start IBM AD Manual Resolutions Service
3. Make IBM AD Manual Resolutions Service available in IBM AD Configuration Server

1. Configure the parameters that are present in the conf.yaml file

On the machine where IBM AD Manual Resolution Service is installed, go to <IBM ADDI
Installation Folder>/IBM Application Discovery Manual Resolutions Service/
sample-conf/ and copy the conf.yaml file to <IBM ADDI Installation Folder>/IBM
Application Discovery Manual Resolutions Service/conf/. Open the conf.yaml file by
using a text editor and enter the desired values for the parameters that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value

1. Enter the port on which IBM AD Manual Resolutions Service listens to. The default value is 7900.

#port to listen to
port: 7900

2. Set the https parameter as follows:

a. If the https parameter is set to false, a non-secured communication is used.

#if communication should be secured with TLS
https: false

b. If the https parameter is set to true, a secured communication is used.

Note: This step implies the use of certificates. If you want to set the communication to be secured,
make sure that a certificate authority issues a signed certificate (.crt) and a private key for the
certificate (.key).

#if communication should be secured with TLS
https: true

Note: If the https parameter is set to true, an additional step needs to be performed. Locate
startServer.bat file under <IBM ADDI Installation Folder>/IBM Application
Discovery Manual Resolutions Service/ and replace the following line:

set tlsoptions=

with:

SET keystorepath=<"path_to_keystore">
SET keystorepass=<"password_of_keystore">
set tlsoptions=-Djavax.net.ssl.keyStore="%keystorepath%" -
Djavax.net.ssl.keyStorePassword="%keystorepass%"

Where:

• Path to keystore is the path to the keystore that holds the certificate for IBM Manual Resolutions
Service.

• Keystore password is the keystore password.
3. Leave blank the line where the authSrv parameter is present since Authentication Server (DEX) is not

needed.

#authentication server URL
authSrv:
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4. The default value of the disableAuth parameter is true. Leave the default value since Authentication
Server (DEX) is not needed.

#disable authentication/authorization. allow all files to be sent
disableAuth: true

5. Add the path where the journal files are created. The path where these files are generated is
separated from the project's path and needs to be accessible only for IBM AD Manual Resolutions
Service. Once a project is imported, a folder with the same name is generated in the related path and
it hosts all the files that are needed to manage dynamic call resolutions.

#generic path setting for journal files
#project name will be automatically added to the path
projectPath: C:\Resolutions

Note: On Linux, mount the Windows folder where the journal files are present (generated at the
project's level) and add the path.

projectPath: /LinuxUser/Resolutions

6. Add the host of IBM AD Configuration Server.

## Coordination and Configuration Server host
ccs.server.host: 127.0.0.1

7. Add the port of IBM AD Configuration Server.

## Coordination and Configuration Server port
## default 2181
ccs.server.port: 2181

8. Add the environment ID under which the projects are created.

## Coordination and Configuration environment
ccs.environment: ce127609-197e-4136-af34-83b612689b09

Note: The current configuration is only available for one environment.
9. Optionally, the main path where the manual resolutions are created for each project, can be

overwritten by the following configuration.

#optional
#overrides projectPath for a specific project.
projects:
   - project: Project1
     path: C:\Resolutions\Projects\Project1

2. Start IBM AD Manual Resolutions Service

• On Windows

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Manual
Resolutions Service/ and run startServer.bat.

2. Click Start, select Run, type services.msc and start IBM Application Discovery Manual
Resolutions Service.

3. If the service does not start, check the manualres.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Manual Resolutions Service/log folder.

• On Linux

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Manual
Resolutions Service/ and locate the startServer.sh file.
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2. In case that the .sh file is not executable, open a terminal and run the following command for
flagging them as executable:

chmod +x startServer.sh

3. If the service does not start, check the manualres.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Manual Resolutions Service/log folder.

3. Make IBM AD Manual Resolutions Service available in IBM AD Configuration Server

After IBM AD Manual Resolutions Service is up and running, go to IBM AD Configuration Server and
make IBM AD Manual Resolutions Service available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.

2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD File Service configuration. From the options that are displayed under the
selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Services.

4. The Services page is displayed. Select Manual resolutions service.
5. The parameters that can be defined for the selected service are displayed in the right of the page.
6. The "Manual Resolutions Service" page is displayed as in the following image.
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Click Edit and enter the URL of the Manual Resolutions Service in the Service base link section. It
represents the full computer name or IP of the machine that hosts the Manual Resolutions Service
and the port to which it listens.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7900

7. Click Save to save the parameters.

STEP 6. Configuring IBM AD Mainframe Projects Service
Follow the configuration steps that are needed to have up and running IBM AD Mainframe Projects
Service:

1. Configure the parameters that are present in the conf.yaml file
2. Start IBM AD Mainframe Projects Service
3. Make IBM AD Mainframe Projects Service available in IBM AD Configuration Server

Note: You have the following options when configuring IBM AD Mainframe Projects Service:

• By defining Groups and Users in IBM AD Configuration Server you can decide which projects are
accessible to specific users.

• If no Groups or Users are defined in IBM AD Configuration Server the projects that are present in the
related environment are accessible to all users.

For more information, see Managing workspaces' access rights.

1. Configure the parameters that are present in the conf.yaml file

On the machine where IBM AD Mainframe Projects Service is installed, go to <IBM ADDI
Installation Folder>/IBM Application Discovery Mainframe Projects Service/
sample-conf/ and copy the conf.yaml file to <IBM ADDI Installation Folder>/IBM
Application Discovery Mainframe Projects Service/conf/. Open the conf.yaml file by
using a text editor and enter the desired values for the parameters that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value

1. Enter the port on which IBM AD Mainframe Projects Service listens to. The default value is 7650.

#port to listen to
port: 7650

2. Set the https parameter as follows:

a. If the https parameter is set to false, a non-secured communication is used.

#if communication should be secured with TLS
https: false

b. If the https parameter is set to true, a secured communication is used.

Note: This step implies the use of certificates. If you want to set the communication to be secured,
make sure that a certificate authority issues a signed certificate (.crt) and a private key for the
certificate (.key).

#if communication should be secured with TLS
https: true
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Note: If the https parameter is set to true, an additional step needs to be performed. Locate
startServer.bat file under <IBM ADDI Installation Folder>/IBM Application
Discovery Mainframe Projects Service/ and replace the following line:

set tlsoptions=

with:

SET keystorepath=<"path_to_keystore">
SET keystorepass=<"password_of_keystore">
set tlsoptions=-Djavax.net.ssl.keyStore="%keystorepath%" -
Djavax.net.ssl.keyStorePassword="%keystorepass%"

Where:

• Path to keystore is the path to the keystore that holds the certificate for IBM AD Mainframe
Projects Service.

• Keystore password is the keystore password.
3. Add the host of IBM AD Configuration Server.

## Coordination and Configuration Server host
ccs.server.host: 127.0.0.1

4. Add the port of IBM AD Configuration Server.

## Coordination and Configuration Server port
## default 2181
ccs.server.port: 2181

5. Add the environment ID under which the projects are created.

## Coordination and Configuration environment
ccs.environment: ce127609-197e-4136-af34-83b612689b09

Note: The current configuration is only available for one environment.
6. The default value of the disableAuth parameter is true. Leave the default value since Authentication

Server (DEX) is not needed.

#disable authentication/authorization. allow all files to be sent
disableAuth: true

7. Leave blank the line where the authSrv parameter is present since Authentication Server (DEX) is not
needed.

#authentication server URL
authSrv:

2. Start IBM AD Mainframe Projects Service

• On Windows

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Mainframe
Projects Service/ and run startServer.bat.

2. Click Start, select Run, type services.msc and start IBM Application Discovery Mainframe
Projects Service.

3. If the service does not start, check the mfprojs.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Mainframe Projects Service/log folder.

• On Linux

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Mainframe
Projects Service/ and locate the startServer.sh file.
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2. In case that the .sh file is not executable, open a terminal and run the following command for
flagging them as executable:

chmod +x startServer.sh

3. If the service does not start, check the mfprojs.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Mainframe Projects Service/log folder.

3. Make IBM AD Mainframe Projects Service available in IBM AD Configuration Server

After IBM AD Mainframe Projects Service is up and running, go to IBM AD Configuration Server and
make IBM AD Mainframe Projects Service available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.

2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD Mainframe Projects Service configuration. From the options that are
displayed under the selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Services.

4. The Services page is displayed. Select Mainframe projects service.
5. The parameters that can be defined for the selected service are displayed in the right of the page.
6. The "Mainframe Projects Service" page is displayed as in the following image.

Click Edit and enter the URL of the Mainframe Projects Service in the Service base link section. It
represents the full computer name or IP of the machine that hosts the Mainframe Projects Service
and the port to which it listens.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7650
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7. Click Save to save the parameters.

STEP 7. Configuring IBM AD Batch Server

About this task

Before running IBM AD Batch Server, some preliminary configurations must be performed. You need to
specify on which projects you want IBM AD Batch Server to run the reports, which reports to generate,
where to store the generated reports, and so on. Also, you need to specify the parameters for IBM AD
Web Service.

The configuration parameters are stored in server.properties and project.properties files,
which can be found in the configuration folder.

Below are the instructions on how to perform a minimal configuration in order to have source code
analysis in IBM AD Analyze Client. For detailed instructions on how to configure IBM AD Batch Server,
see IBM AD Batch Server User Guide.

Note: Under Linux, in case .sh files are not executable, navigate to their installation directory, open a
terminal and run the following command for flagging them as executable:

chmod +x filename.sh

Procedure

1. Copy from <IBM ADDI Installation Folder>\IBM Application Discovery Batch
Server\sample-conf all the configurations files and sub folders to <IBM ADDI Installation
Folder>\IBM Application Discovery Batch Server\Conf.

2. Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\orientdb\orientdb-community\bin\ and run server.bat on Windows or server.sh on
Linux. A command prompt window will open, asking for the root user account password. Fill in a
password of your choosing and press ENTER. The password is case-sensitive. A message indicating
that the server is now active is displayed. Stop OrientDB by pressing the CTRL + C keys and by
confirming with "y". This action is required since IBM Application Discovery GraphDB Service is
started in a later step.

3. Go to IBM AD Configuration Server, at the following location: Home Page > Configuration server
name > Environments > "MyEnvironment" > Configurations > "MyDefaultConfiguration" > Graph
Database and enter the following information:
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Where:

• Host - enter the host name or the IP where IBM AD Batch Server / OrientDB is installed.
• Port - this field is automatically completed by the application with the default value 2424. Modify if

applicable.

Note: If the ssl implementation is used, the default port for OrientDB SSL is 2434. You need to
change your port range to 2434-2440 in the config/orientdb-server-config.xml file. For
more information, see Configuring OrientDB for SSL/TLS.

• Username - enter the root username.
• Password - enter the same password configured in the previous step.

Note: At this point, OrientDB is configured to run with the root username and the password that is
configured above.

4. In server.properties file, set the following parameters.

• ccs.server.host=<IP / hostname of the machine where the AD Configuration Server resides.>
• ccs.environment=<the same environment ID defined in Configuration Server.>

5. The project.properties file contains a set of global settings, followed by the specific settings for
each type of component. The global settings specify the projects on which the IBM AD Batch Server
will operate and which components will run on the specified projects. In project.properties file,
set the following parameters.
a) Enter an asterisk *, or a comma-separated list of project names that are the only ones considered

for this service. VERY IMPORTANT: If no value is set for this parameter, no report is generated; *
means all projects.

projects.whitelist=*

b) Comma-separated list of component names that must be considered for this service. Ex.: index
must be added as a component.

components=index,gdbImport,annUpdate
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Optional components can be considered for this service.

Table 1. Optional Components

Component Description

ruleBased The Rule Based component generates reports for the resources that are
specified in the configuration files according to the rules and parameters
that are defined in the corresponding configuration files.

Note: If the Rule Based component is used, make sure that the
ruleBased.properties file is configured. For more information, go to
IBM AD Batch Server User Guide, ruleBased.properties File chapter.

reports The Reports component is used to generate the complexity reports. For
more information, go to IBM AD Analyze User Guide, Complexity Reports
chapter.

cobolPP The cobolPP, jclPP, and pl1PP components generate the expanded sources
for Cobol, JCL, and PL/I. For more information, go to IBM AD Analyze User
Guide, View Expanded Source chapter.jclPP

pl1PP

wsmetrics The wsmetrics component is needed only if IBM Application Delivery
Intelligence for IBM Z (ADI) is used on the system.

Note: Additionally, in order for the wsmetrics component to be executed,
make sure that the gdbImport component is included in the components list
of this service.

adidx The addix component is needed only if IBM Application Delivery Intelligence
for IBM Z (ADI) is used on the system. The ADI Index component will index
the resources of a project so that the Business Rules Discovery (BRD)
feature can display code snippets.

c) The Index component will index the resources of a project so that a Search in resources can be
performed in IBM AD Analyze Client, using Search in Files analysis.

index.indexFolder=\\\\path\\<Folder>\\Index

Note: For the accessible path defined in the project.properties file, backslashes must be
doubled (\\) and spaces in the path must have a single backslash as a prefix.

Examples for the index.indexFolder parameter:

• index.indexFolder=\\\\path\\<Folder>\\Index

• index.indexFolder=C:\\ibm\\Index

Important:

• The folder path in which the indexes are generated needs to be accessible both for IBM AD Batch
Server and IBM AD Search Service.

• The Index location will be used when configuring IBM AD Search Service.
6. On Linux only, Open the mount.properties file, located under <installation folder>\IBM
Application Discovery Batch Server/conf folder and specify how the windows shared
folders are mounted on the local files system, using the following pattern:

\\\\machine IP\\WindowsSharedFolder=/home/user/LinuxFolder

Example:
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\\\\192.168.56.57\\ProjectsSharedPathWindows=/home/user/ ProjectsSharedPathLinux

It is mandatory to mount, at least the default shared path for AD Build Projects as defined in STEP 3
and the shared path for the Indexes as defined in project.properties file (step 5c).

7. Optional step: for integration with ADI only, please follow this procedure to set up the AD Batch
Server Web Service:

a. Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\, and run authConfigTool.bat on Windows or authConfigTool.sh on Linux. A command
prompt dialog window is displayed. Follow the directions and enter the username and the
password that are used by the Web Service then press ENTER. AuthConfigTool.bat sets the
user and password for Web Service basic access authentication.

b. Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\conf folder, locate the webService.properties file and set the keystore-file parameter to
enable an encrypted communication. Example:

## ssl keystore file
keystore-file=keystore.jks

Note: The keystore file needs to be added in the same \conf folder where
webService.properties is present.

What to do next

• Start IBM AD GraphDB (OrientDB).

– Under Windows: click Start and then select All Programs > IBM Application Discovery Servers \
IBM Application Discovery Batch Server > Start IBM Application Discovery GraphDB Service. The
service can also be started from Windows Services (services.msc) by locating
IBMApplicationDiscoveryGraphDBService and clicking Start.

– Under Linux: Go to <IBM ADDI Installation Folder>\IBM Application Discovery
Batch Server\orientdb\orientdb-community-2.1.25-ibm1\bin\ and run server.sh.
Make sure this process remains alive.

• Start IBM AD Batch Server.

– Under Windows: click Start and then select All Programs > IBM Application Discovery Servers \
IBM Application Discovery Batch Server > Start IBM Application Discovery Batch Server. The
service can also be started from Windows Services (services.msc) by locating
IBMApplicationDiscoveryBatchService and clicking Start.

– Under Linux: Go to <IBM ADDI Installation Folder>\IBM Application Discovery
Batch Server\, and run StartServer.sh. Make sure that this process remains alive.

• (Only in case step 7 from above has been taken) Start IBM AD Web Service.

– Under Windows: click Start and then select All Programs > IBM Application Discovery Servers \
IBM Application Discovery Batch Server > Start IBM Application Discovery Web Service. The
service can also be started from Windows Services (services.msc) by locating
IBMApplicationDiscoveryWebService and clicking Start.

– Under Linux: Go to <IBM ADDI Installation Folder>\IBM Application Discovery
Batch Server\, and run startWBServer.sh. Make sure this process remains alive.

Note: Make sure to restart IBM AD Batch Server after modifying the configuration files.

Important: For monitoring the IBM AD Batch Server tasks, see Chapter 7, “Log Files Location,” on page
115.

STEP 8. Configuring IBM AD Search Service
Follow the configuration steps that are needed to have up and running IBM AD Search Service:

1. Configure the parameters that are present in the conf.yaml file
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2. Start IBM AD Search Service

Note: IBM AD Search Service is necessary for the Search in Files functionality to work. It is
mandatory to have IBM AD File Service installed, configured and up and running.

3. Make IBM AD Search Service available in IBM AD Configuration Server

1. Configure the parameters that are present in the conf.yaml file

On the machine where IBM AD Search Service is installed, go to <IBM ADDI Installation
Folder>/IBM Application Discovery Search Service/sample-conf/ and copy the
conf.yaml file to <IBM ADDI Installation Folder>/IBM Application Discovery Search
Service/conf/. Open the conf.yaml file by using a text editor and enter the desired values for the
parameters that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value

1. Enter the port on which IBM AD Search Service listens to. The default value is 7800.

#port to listen to
port: 7800

2. Set the https parameter as follows:

a. If the https parameter is set to false, a non-secured communication is used.

#if communication should be secured with TLS
https: false

b. If the https parameter is set to true, a secured communication is used.

Note: This step implies the use of certificates. If you want to set the communication to be secured,
make sure that a certificate authority issues a signed certificate (.crt) and a private key for the
certificate (.key).

#if communication should be secured with TLS
https: true

Note: If the https parameter is set to true, an additional step needs to be performed. Locate
startServer.bat file under <IBM ADDI Installation Folder>/IBM Application
Discovery Search Service/ and replace the following line:

set tlsoptions=

with:

SET keystorepath=<"path_to_keystore">
SET keystorepass=<"password_of_keystore">
set tlsoptions=-Djavax.net.ssl.keyStore="%keystorepath%" -
Djavax.net.ssl.keyStorePassword="%keystorepass%"

Where:

• Path to keystore is the path to the keystore that holds the certificate for IBM AD Search Service.
• Keystore password is the keystore password.

3. Leave blank the line where the authSrv parameter is present since Authentication Server (DEX) is not
needed.

#authentication server URL
authSrv:
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4. The default value of the disableAuth parameter is true. Leave the default value since Authentication
Server (DEX) is not needed.

#disable authentication/authorization. allow all files to be sent
disableAuth: true

5. Add the path where the indexes are created. This path needs to have as an endpoint the same folder
where the indexes are stored. The path where the indexes are stored was set up under <IBM ADDI
Installation Folder>/IBM Application Discovery Batch Server/conf/
project.properties file, where the index.indexFolder parameter is present. The folder path
where the indexes are generated needs to be accessible for both IBM AD Batch Server and IBM AD
Search Service.

Example:

#generic path setting for indexes
#project name will be automatically added to the path
indexPath: \\server01\Indexes

6. Optionally, the main path where the indexes are created for each project, can be overwritten by the
following configuration. This path needs to be identical to the one present under <IBM ADDI
Installation Folder>/IBM Application Discovery Batch Server/conf/
project.properties, where the project.projectName.index.indexFolder parameter is present.

#optional
#overrides indexPath for a specific project.
projects:
   - project: Project1
     path: C:\Index\Indexes\Project1

2. Start IBM AD Search Service

• On Windows

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Search
Service/ and run startServer.bat.

2. Click Start, select Run, type services.msc and start IBM Application Discovery Search Service.
3. If the service does not start, check the search.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Search Service/log folder.

• On Linux

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Search
Service/ and locate the startServer.sh file.

2. In case that the .sh file is not executable, open a terminal and run the following command for
flagging them as executable:

chmod +x startServer.sh

3. If the service does not start, check the search.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Search Service/log folder.

3. Make IBM AD Search Service available in IBM AD Configuration Server

After IBM AD Search Service is up and running, go to IBM AD Configuration Server and make IBM AD
Search Service available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.
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2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD File Service configuration. From the options that are displayed under the
selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Services.

4. The Services page is displayed. Select Search Service.
5. The parameters that can be defined for the selected service are displayed in the right of the page.
6. The "Search Service" page is displayed as in the following image.

Click Edit and enter the URL of the Search Service in the Search service URL section. It represents
the full computer name or IP of the machine that hosts the Search Service, the port to which it listens
and the endpoint (search) .

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7800/search

7. Click Save to save the parameters.

STEP 9. Configuring IBM AD Cross Applications Service
Important: The IBM AD Cross Applications Service is still under development.

IBM AD Cross Applications Service is an additional service that needs to be configured to show calls
between different mainframe projects that have their databases on the same DB instance in IBM AD
Analyze Client.
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Follow the configuration steps that are needed to have up and running IBM AD Cross Applications
Service:

1. Configure the parameters that are present in the conf.yaml file
2. Start IBM AD Cross Applications Service
3. Make IBM AD Cross Applications Service available in IBM AD Configuration Server

1. Configure the parameters that are present in the conf.yaml file

On the machine where IBM AD Cross Applications Service is installed, go to <IBM ADDI
Installation Folder>/IBM Application Discovery Cross Applications Service/
sample-conf/ and copy the conf.yaml file to <IBM ADDI Installation Folder>/IBM
Application Discovery Cross Applications Service/conf/. Open the conf.yaml file by
using a text editor and enter the desired values for the parameters that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value

1. Enter the port on which IBM AD Cross Applications Service listens to. The default value is 7850.

#port to listen to
port: 7850

2. Add the host of IBM AD Configuration Server.

## Coordination and Configuration Server host
ccs.server.host: 127.0.0.1

3. Add the port of IBM AD Configuration Server.

## Coordination and Configuration Server port
## default 2181
ccs.server.port: 2181

4. Add the environment ID under which the projects are created.

## Coordination and Configuration environment
ccs.environment: ce127609-197e-4136-af34-83b612689b09

Note: The current configuration is only available for one environment.
5. Add the Relational database server name. The name needs to be identical to the one that has been

set up in Step 3, when configuring IBM AD Build Client in IBM AD Configuration Server.

## Relational database server name (name defined in the specified environment)
## used to create a new cross database
db.server.name: exampleDB 

6. Add the Cross repository name.

## cross repository name
cross.db.name: YourPreferedName

7. Set the https parameter as follows:

a. If the https parameter is set to false, a non-secured communication is used.

#if communication should be secured with TLS
https: false

b. If the https parameter is set to true, a secured communication is used.
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Note: This step implies the use of certificates. If you want to set the communication to be secured,
make sure that a certificate authority issues a signed certificate (.crt) and a private key for the
certificate (.key).

#if communication should be secured with TLS
https: true

Note: If the https parameter is set to true, an additional step needs to be performed. Locate
startServer.bat file under <IBM ADDI Installation Folder>/IBM Application
Discovery Cross Applications Service/ and replace the following line:

set tlsoptions=

with:

SET keystorepath=<"path_to_keystore">
SET keystorepass=<"password_of_keystore">
set tlsoptions=-Djavax.net.ssl.keyStore="%keystorepath%" -
Djavax.net.ssl.keyStorePassword="%keystorepass%"

Where:

• Path to keystore is the path to the keystore that holds the certificate for IBM AD Cross Applications
Service.

• Keystore password is the keystore password.
8. Leave blank the line where the authSrv parameter is present since Authentication Server (DEX) is not

needed.

#authentication server URL
authSrv:

9. The default value of the disableAuth parameter is true. Leave the default value since Authentication
Server (DEX) is not needed.

#disable authentication/authorization. allow all files to be sent
disableAuth: true

2. Start IBM AD Cross Applications Service

• On Windows

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Cross
Applications Service/ and run startServer.bat.

2. Click Start, select Run, type services.msc and start IBM Application Discovery Cross
Applications Service.

3. If the service does not start, check the cross.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Cross Applications Service/log folder.

• On Linux

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Cross
Applications Service/ and locate the startServer.sh file.

2. In case that the .sh file is not executable, open a terminal and run the following command for
flagging them as executable:

chmod +x startServer.sh

3. If the service does not start, check the cross.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Cross Applications Service/log folder.
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3. Make IBM AD Cross Applications Service available in IBM AD Configuration Server

After IBM AD Cross Applications Service is up and running, go to IBM AD Configuration Server and
make IBM AD Cross Applications Service available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.

2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD File Service configuration. From the options that are displayed under the
selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Services.

4. The Services page is displayed. Select Cross applications service.
5. The parameters that can be defined for the selected service are displayed in the right of the page.
6. The "Cross Applications Service page is displayed as in the following image.

Click Edit and enter the URL of the Cross Applications Service in the Service base link section. It
represents the full computer name or IP of the machine that hosts the Cross Applications Service and
the port to which it listens.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7850

7. Click Save to save the parameters.

Important: At this installation and configuration point, everything is put in place for having analysis
available in IBM AD Analyze Client. To take full advantage of the available analysis functionality, you
need to install IBM AD Analyze Client. For more information see, “STEP 11. Installing IBM AD Analyze
Client” on page 68.
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STEP 10. (Optional) Configuring IBM AD Analyze Server

Before you begin

This step is optional and not necessary unless Java source code will be included in one or more projects
in this environment.

On Linux only, Open the servermount.properties file, which is located under <installation
folder>\IBM Application Discovery Batch Server/conf folder and specify how the windows
shared folders are mounted on the local files system, by using the following pattern:

\\\\machine IP\\WindowsSharedFolder=/home/user/LinuxFolder

Example:

\\\\192.168.56.57\\ProjectsSharedPathWindows=/home/user/ ProjectsSharedPathLinux

It is mandatory to mount the Remote Path from Analyze Server Manager > Server Settings.

About this task

Following are the configuration steps that are needed after IBM AD Analyze Server was installed.

• Under Windows: to access the configuration parameters, select Start > Programs > IBM Application
Discovery Analyze Server > IBM Application Discovery Analyze Server Manager.

• Under Linux: to access the configuration parameters, go to <Installation Path>\IBM
Application Discovery Servers\IBM Application Discovery Analyze Server and run
manager.sh.

In the Server settings tab, the Server properties and Server arguments sections display default data
that was entered when IBM AD Analyze Server was installed.

To configure IBM AD Analyze Server, follow the instructions below.

Procedure

1. In IBM AD Configuration Server, go to Configurations > Default > Analyze Servers and fill in the
following details:

• Host: IP / Hostname where IBM AD Analyze Server is installed.
• RMI Registry Port: 1099 (Default).

2. Configuring the server database – the Database settings tab:
Select the Database Settings tab. In the Location area, fill in the following parameters:

• Server type field is completed by default with SQL server.
• Server IP: Enter the IP of the computer where SQL Server is installed.
• Server port: Server port is the access port, by default, 1433 port is used.

Important: Make sure that the IP address and the port number you set here are the same as the ones
entered in the Relational database servers page of IBM AD Configuration Server. For more
information, see “ STEP 2. IBM AD Configuration Server: Configurations for IBM AD Build Client ” on
page 42.

Database instance, this field must be used in case the default database name was not chosen at SQL
Server installation time. In the Authorization area, fill in the following parameters:

• Database name: Enter a name for the database.
• User and password: Give a user and password that can be used to create the database.

After you completed the details of the database, click Create database to create the database with
the selected parameters. If the database was configured correctly, after Test database is clicked, a
message with the installed DB version will be displayed. Click Save to apply the settings.
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You can also select an existing database. If the selected database belongs to an older version of IBM
AD and the database structure is now obsolete, a message is displayed indicating the current version
of the selected database. The user is given the option to upgrade the existing database. Press Upgrade
if applicable. After the upgrade process was performed, press again Test database to make sure that
the upgraded database is functional. The version of the upgraded database is presented and Upgrade
button is no longer available. For incomplete or corrupted databases one of the following messages
may be displayed: Database x is not a valid database or Cannot extract relevant data from the
database. Database may be nonexistent, obsolete or invalid.

After modifying the settings in any of the tabs, do not forget to press Save to apply them. An asterisk
at the beginning of the title of a tab indicates that parameters in that tab were modified but not saved.

3. Specifying allowed IBM AD Analyze Clients:

Note: This configuration applies only to Java projects.

• IBM AD Analyze clients can be of two types: manager and user.
• IBM AD Analyze client of the manager type, can create shared projects, build shared projects, and

delete shared projects.
• IBM AD Analyze client of the “user” type, can only import the shared projects and perform analysis.

Manager and user types are server-related attributes, which means that a server determines the type
for a client connecting to that server by looking up the client IP in the configuration files. This means
that a client can be a manager on one server and a user on another server.

a) To add a Manager to the Managers list: Click Add in the upper right corner of the Access Settings
tab: New Access Data dialog window is displayed. Enter the IP of the computer of the user who
will access the server as a Manager (the type of owner is selected by default) then press OK to add
the new manager to the list of Managers. To delete one of the Managers from the list, select it then
press Delete. If you want to allow access to all the projects on the server to all potential users, do
not add any users to the List of Users. If you want to limit the access to the projects to a number of
specific users, select restrict user IP then add all of them to the List of Users. Only users in the List
of Users and List of Managers will have access to the projects shared on the server.

b) To add a user to the List of Users, click Add from the List of Users area of the Access Settings tab:
the New Access Data dialog window is displayed. Enter the IP of the computer of the user who will
access the projects as a User (the type of owner is selected by default) then press OK to add the
new user to the list of Users.

What to do next

Under Windows: start IBM AD Analyze Server: Click Start and then select All Programs > IBM
Application Discovery Analyze Server > Start IBM Application Discovery Analyze Server.

Alternatively, to start the server: From the Start menu, choose Programs > IBM Application Discovery
Analyze Server > Start IBM Application Discovery Analyze Server Monitor then go to monitor icon from
the taskbar, right-click on the icon, and select Start service. When the server is running, the green arrow
from Server Monitor icon indicates that the server is started.

Under Linux: Go to <Installation Path>\IBM Application Discovery Servers\IBM
Application Discovery Analyze Server and run StartServer.sh. Please make sure that this
process remains alive.

Important: For monitoring the IBM AD Analyze Server tasks, see Chapter 7, “Log Files Location,” on
page 115.

STEP 11. Installing IBM AD Analyze Client

About this task

Attention:
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• If you want to connect the AD Analyze Client software on a machine or operating system
instance to multiple AD Server instances that are all running the same AD Server code level, one
copy of the AD Analyze Client software can be installed into an Eclipse/IDz instance, but
each AD server connection (IP/Hostname, port, and Unique ID, at a minimum) must be
configured in a unique workspace that does not already contain an instance of the AD Analyze
Client software's configuration settings.

• If you want to install multiple code levels of the AD Analyze Client software on the same
machine or operating system instance (to connect to different AD Servers running different AD
code levels), each level of the AD Analyze Client software can be installed into a separate
Eclipse/IDz instance, and also must use a unique workspace that does not already contain
the AD Analyze Client software's configuration settings. A workspace in use when the AD
Analyze Client software is installed and configured contains the AD Analyze Client software's
configuration settings in a folder named: <workspace location>\.metadata\.ez
\.settings.

Procedure

1. To install IBM AD Analyze Client: In your Eclipse instance, select Window > Preferences.
2. From the Install /Update section to the left of the Preferences dialog window select Available

Software Sites: A list of software sites available for update or install is displayed.
3. To select the location from where IBM AD Analyze Client is being installed click Add: The Add Site

dialog window is displayed.

• In the Name field enter a name for your IBM AD Analyze Client installation.
• If you extracted the installation archive that you received from IBM and you stored it on your

computer, use Local and point to the Repository folder generated after the extract operation.
• If you did not extract the installation archive received from IBM, use Archive button to select the

installation archive stored on your computer.
• If you did not store the installation archive locally but in a location on your intranet, enter the full

path to that location in the Location field.

Click OK: IBM AD Analyze Client will be added to the list of Available Software Sites.

Click OK to close the Preferences dialog window and proceed to the next step in the installation
process.

4. In your Eclipse client select Help > Install New Software: The Install dialog window is displayed. In
Work with field select the IBM AD Analyze Client site you have defined in the previous step. After you
selected the IBM AD Analyze Client site, the corresponding IBM AD Analyze components are
displayed in the central part of the dialog window. By default, all the components are selected.
a) If you are installing AD Analyze Client into IBM IDz, you can choose all the features listed under

IBM AD Analyze.
b) If you are installing AD Analyze Client into an Eclipse package that is not IBM IDz, for example an

Eclipse distribution downloaded from eclipse.org, you can choose the features listed under IBM AD
Analyze, except you should deselect all features that start with Application Discovery Integration
with to avoid errors during the installation process.

c) Once you have selected the correct features to install in your environment, click Next.
5. The Install details dialog window is displayed.

Select a component from the list to display a detailed description of it in the Details section of the
dialog window. Click Next.

6. The Review license dialog window is displayed. Carefully read the License agreement then select I
accept the terms and press Finish to start the installation process.

7. After the installation is completed, Eclipse will prompt you for a restart: Accept the restart operation to
see the newly installed features.
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STEP 12. Configuring IBM AD Analyze Client

About this task

To configure IBM AD Analyze Client, follow the instructions below.

Eclipse startup is controlled by the options in $ECLIPSE_HOME/eclipse.ini. If $ECLIPSE_HOME is not
defined, the default eclipse.ini in your Eclipse installation directory is used.

Procedure

1. OS-Dependent Configuration: In case Analyze Client is installed on Windows Server (any version) or
Windows 8/10, you need to edit the eclipse.ini configuration file and add the following line, in the
-vmargs section. Avoid blank lines in the -vmargs section.

-Dorg.osgi.framework.os.name=win32

Figure 3. OS-Dependent Configuration
2. Java-Dependent Configuration: If an AD-supported IBM Java version is used as the system Java and

you want to enable the TLS V1.2 connection, make sure to add the following lines in the eclipse.ini
configuration file, in the -vmargs section. Avoid blank lines in the -vmargs section.

-Dcom.ibm.jsse2.overrideDefaultTLS=true
-Djsse.enableCBCProtection=false

3. Memory Management Configuration: Eclipse must be configured to allow for optimized memory
consumption. To configure Eclipse, edit the eclipse.ini file under the Eclipse installation folder and
set the minimum memory parameter (marked –Xms), the maximum memory parameter (marked –
Xmx). Following is an example of an eclipse.ini file containing parameters for optimized memory
consumption.

Figure 4. Memory Management Configuration
4. If you are using an AD-supported IBM Java version as the system Java and want to enable TLS V1.2

connection, add the following parameter in the eclipse.ini file in the -vmargs section. Avoid blank
lines in the -vmargs section.
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-Djsse.enableCBCProtection=false

5. To use a specific language in the Eclipse interface, add the following parameter before the -startup
parameter in the eclipse.ini file:

-nl
language

The -nl parameter has the following language values:

Language value Language

de German

es Spanish

fr French

it Italian

ja Japanese

ko Korean

pt_BR Brazilian Portuguese

zh Simplified Chinese

zh_HK Traditional Chinese, Hong Kong

zh_TW Traditional Chinese, Taiwan

6. Go to IBM AD Analyze Client main window and select Window > Preferences > Application
Discovery > Environment settings.
The following Environment identification settings are available:

• Host, enter the hostname or the IP address of the computer where IBM AD Configuration Server is
installed.

• Port, enter the communications port number for IBM AD Configuration Server. If you are using the
default port, enter 2181.

• Unique id, enter the unique ID assigned by IBM AD Configuration Server to the environment you
want to work with.

Attention: This ID must be identical to the environment ID declared in “ STEP 2. IBM AD
Configuration Server: Configurations for IBM AD Build Client ” on page 42, procedure step 2.

• Name, enter the name of the environment with which you want to work, as defined in IBM AD
Configuration Server.

Attention: It is highly recommended that this name is identical to the one declared in “ STEP
2. IBM AD Configuration Server: Configurations for IBM AD Build Client ” on page 42,
procedure step 2.

7. Click OK and restart IBM AD Analyze Client (File Menu > Restart).
8. After restarting, a pop-up message displays the configurations that were made in IBM AD

Configuration Server, which are taken into account by IBM AD Analyze Client.

Important: For monitoring the IBM AD Analyze Client tasks, see Chapter 7, “Log Files Location,” on
page 115.

9. In order to see the Mainframe Analysis projects, go to . IBM AD Analyze User Guide, Explore Projects
Tab chapter.

Notice: At this point, all IBM AD components are up and running and ready for Analysis.
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With Authentication
The authentication process is conducted through DEX or through any other Authentication Server that
supports the OAuth2 protocol. Authentication Server (DEX), which is delivered through the IBM ADDI
installer, is an identity service that uses OpenID Connect and it is used in the following configurations.

When you start IBM AD Analyze Client, you need to login by using login button that is present on the right
bottom of the screen to observe the list of available projects. A browser page is opened into which the
user and password are filled in. The credentials reach the Authentication Server (DEX), using the LDAP
protocol, and it checks whether the credentials of the user are bounded to an account in Secure Storage.
The Secure Storage can be an Active Directory or any other entity that stores users and groups and can
communicate through LDAP. For more information, see the Authorization and Authentication section, in
IBM AD Analyze User Guide.

Once authenticated, an authorization process is started to determine the list of available mainframe
projects and whether the user can access all the source files that are used in the listed mainframe
projects. Based on the configurations that are made, File Service maps the groups of users to a certain
folder with the source files that can be on the same machine with File Service or not. Once you are
authenticated and authorized, you can start the analysis on the available mainframe projects and on the
source files.

STEP 1. Configuring IBM AD Configuration Server

About this task
The IBM AD Configuration Server component can run with the default settings. If the default settings are
not compatible with your environment, you can configure the component and overwrite the default
settings.

Procedure

1. Configure the settings in the <IBM ADDI Installation Folder>/IBM Application
Discovery Configuration Service/conf/server.properties file.
a) Configure the port that AD Configuration Server listens on by setting the value of the server.port

parameter.
The default value is 2181.

b) Configure the number of the snapshots and the corresponding logs that are retained by AD
Configuration Server. To configure the setting, set the value of the
zookeeper.autopurge.snapRetainCount parameter.
The default value is 4, and the minimum value is 3.

c) Configure the time interval in hours for the purge task by setting the value of the
zookeeper.autopurge.purgeInterval parameter.
The purge task deletes old snapshots and the corresponding log files according to the time interval.
The default value of the parameter is 24. To enable the purge task, you must set a value that is
greater than 0.

2. Configure the web server settings in the <IBM ADDI Installation Folder>/IBM Application
Discovery Configuration Service/conf/webservice.log4j.properties file.
a) Configure the root logger level and the appenders by setting the log4j.rootLogger parameter

with one of the following values:

• OFF
• FATAL
• ERROR
• WARN
• INFO
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• DEBUG
• TRACE
• ALL

The default log level is INFO. The default appenders are file, which indicates a rolling file
appender, and stdout, which indicates a console appender.

Example

log4j.rootLogger=DEBUG

b) Configure the file roller appender log level by setting the log4j.appender.file.threshold
parameter with one of the following values:

• OFF
• FATAL
• ERROR
• WARN
• INFO
• DEBUG
• TRACE
• ALL

Note: If you do not set the value of the log4j.appender.file.threshold parameter, the file
roller appender log level is the same as the root logger level. To set the
log4j.appender.file.threshold parameter, the value must be lower than or equal to the
root logger level.

Example

log4j.appender.file.threshold=ERROR

c) Configure the file roller appender location by setting the value of the
log4j.appender.file.File parameter.

Note: The value of the log4j.appender.file.File parameter must be a valid absolute or
relative path.

Example

log4j.appender.file.File=/home/user/logs/webservice.log

d) Configure the file roller appender minimum number of backup files to keep by setting the value of
the log4j.appender.file.MaxBackupIndex parameter.

Example

 log4j.appender.file.MaxBackupIndex=5

e) Configure the file roller appender maximum file size by setting the value of the
log4j.appender.file.MaxFileSize parameter.

Example

log4j.appender.file.MaxFileSize=100M

3. Configure the web server settings in the <IBM ADDI Installation Folder>/IBM Application
Discovery Configuration Service/conf/admin-ws.properties file.
The web server is attached to AD Configuration Server.
a) Configure the network interface that the web server listens on by setting the value of the host

parameter.
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The default value is localhost.

Note: To expose the web server, you must set the host parameter with one of the following values:
IP_address

One of the IP addresses that are attached to a network interface on the computer where AD
Configuration Server is running.

0.0.0.0
Exposes the web server to all network interfaces.

b) Configure the port that the web server listens on by setting the value of the port parameter.
The default value is 8080.

Note: If the web server is exposed to the network, the communication on the specified port must
be enabled by the firewall.

c) Configure the path to the configuration file of the logger by setting the value of the log-conf-
file parameter.
The default value is <IBM ADDI Installation Folder>/IBM Application Discovery
Configuration Service/conf/webservice.log4j.properties.

4. By default, the HTTP protocol is used to run the web service. To use the SSL/HTTPS protocol, follow
the steps:
a) Generate a self-signed key pair and store it in a Java keystore by using the Java Keytool command-

line interface. Run the following command:

Note: Java SDK or Java JRE must be installed, and the JAVA_HOME and PATH environment
variables must be configured for the Java SDK or Java JRE.

keytool -genkeypair -keyalg RSA -alias {alias} 
-ext SAN=DNS:localhost,IP:127.0.0.1 -dname {dname} 
-validity {validity} -keysize 2048 -keypass {keypass} 
-storepass {storepass} -keystore {keystore}

{alias}
The name that is used by the Java keystore to identify the generated key. The name must be
unique within the Java keystore.

{dname}
The distinguished name from the X.500 standard. This name is associated with the alias for the
key pair in the keystore. Also, the name is used as the value in the "issuer" and "subject" fields
in the self-signed certificate.

{validity}
The number of days that the certificate that is attached to the key pair is valid.

{keypass}
The password that is needed to access the key pair within the keystore.

{storepass}
The password for the Java keystore.

{keystore}
The path to the keystore file, which is used to store the generated key pair. If the file does not
exist, a keystore file is created.

Example

keytool -genkeypair -keyalg RSA -alias my-key-pair
-ext SAN=DNS:localhost,IP:127.0.0.1 -dname CN="IBM AD" 
-validity 9999 -keysize 2048 -keypass my-key-password 
-storepass my-store-password -keystore C:\my_keystore

b) Configure the web server that is attached to IBM AD Configuration Server to use the SSL/HTTPS
protocol. In the <IBM ADDI Installation Folder>/IBM Application Discovery
Configuration Service/conf/keystore-config.properties file, configure the following
parameters:
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path
Set the value to the path of the Java keystore that is generated in the preceding substep.

storepass
Set the value to the password for the Java keystore.

keypass
Set the value to the password that is needed to access the key pair within the keystore.

c) In the <IBM ADDI Installation Folder>/IBM Application Discovery
Configuration Service/conf/admin-ws.properties file, set the value of the keystore-
conf-file parameter to the path of the keystore configuration file.

5. Start IBM Application Discovery Configuration Admin Service and IBM Application Discovery
Configuration Service

• On Windows the services start automatically after the installation of IBM Application Discovery
Configuration Service. In case that they are not up and running follow these steps:

a. Click Start, select Run, type services.msc and start IBM Application Discovery Configuration
Admin Service and IBM Application Discovery Configuration Service.

b. If the service does not start, check the server.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Configuration Service/ folder.

• On Linux

a. Go to <IBM ADDI Installation Folder>/IBM Application Discovery
Configuration Service/ and locate the startServer.sh and startWebServerUI.sh
files.

b. In case that the .sh files are not executable, open a terminal and run the following commands for
flagging them as executable:

chmod +x startServer.sh

and

chmod +x startWebServerUI.sh

c. If the service does not start, check the server.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Configuration Service/ folder.

Important: For monitoring the IBM AD Configuration Server tasks, see Chapter 7, “Log Files
Location,” on page 115.

STEP 2. IBM AD Configuration Server: Configurations for IBM AD Build Client

About this task

IBM AD Configuration Server ensures that the installation parameters are consistent throughout the
different components of IBM AD by storing them in a central location, in a scalable, and fail-safe manner.

IBM AD Configuration Server additionally allows the system administrator to coordinate the access to the
resources by creating workspaces and user groups.

Procedure

1. Start IBM AD Configuration Server, by selecting Start > All Programs > IBM Application Discovery
Configuration Service > Launch IBM Application Discovery Configuration Service Admin.

2. Create an environment, on the IBM AD Configuration Server main page, by selecting the localhost
server. From the available options, select Environments then click Add Environment. Enter a name
and a description for the new environment then click Save. Select the newly defined environment. A
Default workspace is automatically created for the new environment and is attached to it. Also, a
Default blank configuration is automatically created and attached to the new environment.
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Note: The environment ID will be later used in configuring other components.

3. On the IBM Application Discovery Configuration Servers Admin page, click localhost:2181 > Install
Configurations > IBM Application Discovery Build Client, and configure the following parameters.
a) Default Project path: A default path where all AD Build Client projects are stored. Add the

path so that it can be accessed by any AD Build, Analyze Clients and AD Batch Server. This
default path can be changed while creating a Project in AD Build Client.

b) zOS configuration folder: A default path where the z/OS Connections are stored. Add the
path so that it can be accessed by any AD Build Client / AD Build Configuration Administration
tool.

c) Path for the retrieved members: A default path where all the members downloaded from a
Mainframe system, are stored. Add the path so that it can be accessed by any AD Build, Analyze
Clients and AD Batch Server.

4. To add a relational database server, in IBM AD Configuration Server main page, from the available
servers, select the localhost server where you defined your environment. From the available options,
select Environments > your Environment then click Relational database servers. Click Add
relational database server and enter the following parameters:

• Name: Enter a name for the relational database server.
• Host: IP or name of the computer where the relational database server is installed.
• Port: The relational database server port. The default port for SQL Server is 1433.
• Instance/Location: The relational database server instance name (if exists).
• Username/Password: User name and password for the IBM AD SQL Identity as defined in

“Microsoft SQL Server Configurations” on page 9, or for the Db2 for z/OS instance.
5. At this point, you can create new projects in AD Build Client.

Note: For more information on how to create new projects, please refer to IBM AD Build User Guide.

Note: In order to activate your IBM AD Build Client copy, follow the procedure described in Chapter 9,
“Activating Your IBM AD,” on page 121.
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Important: For monitoring the IBM AD Build Client tasks, see Chapter 7, “Log Files Location,” on
page 115.

STEP 3. (Optional) Configuring IBM AD Validation Service

About this task

IBM AD Validation Service component is specific only for ChangeMan ZMF users, therefore it is not part
of the must have components installation.

IBM AD Validation Service is automatically installed during the IBM AD Build installation.

IBM AD Validation Service acts like a listener and is linked directly with IBM AD Connect for Mainframe
component (Mainframe Agents).

After IBM AD Validation Service is installed, go to <IBM AD Build Client installation folder>
\Bin\Release\IBMApplicationDiscoveryValidationServer\SampleConf.

Select all configuration files and copy them to <IBM AD Build Client installation folder>
\Bin\Release\IBMApplicationDiscoveryValidationServer.

Next, perform the following configurations.

Procedure

1. Configure ProjectsMapping.txt to have a valid input. This is the configuration file for defining the
mapping between the projects that are used to download mainframe members, applications, and
subsystems.

Note: Comparing with the ProjectsMappingParallelBuild.txt file, the projects that are
specified in the ProjectsMapping.txt file do not need to contain the virtual folder that is specified
in the FoldersMapping.txt file, as they are not used for builds. However, a z/OS connection must
be attached and configured to the projects.

Each line of the configuration file must have the following comma-separated values format:

<ProjectName>, <ApplicationName>, <Subsystem>

Note:

• <ProjectName> represents the project that is defined in IBM AD Build Client.
• <ApplicationName> and <Subsystem> are defined in ChangeMan ZMF.

Example of the configuration file:

Project1, App1, Subsys1

2. Configure IncludesOrder.txt to have a valid input. This is the configuration file for defining the
ChangeMan Baseline Libraries Types and the order of COBOL Includes locations. This configuration file
is used later on while you set up the path for the COBOL Include folders
The configuration file must have the following comma-separated values format:

<Type1>, <Type2>,…, <Typen>

Example of the configuration file:

CPY, INC, IND, CPA

Note: It is EXTREMELY important to add the types in the order in which the include files must be
looked after.

3. Configure FoldersMapping.txt to have a valid input. This is the configuration file for defining a
mapping between a type of a mainframe member, that is defined in ChangeMan ZMF, and a virtual
folder name of an IBM AD project. This configuration file is used during the synchronize phase of the
validation process.
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Each line of the configuration file must have the following comma-separated values format:

<MemberType>, <VirtualFolderName>

• <MemberType> is defined in ChangeMan ZMF.
• <VirtualFolderName> is defined in IBM AD Build Client.

Examples of the configuration file:

COB, zOS Cobol

ASM, Assembler

4. Configure ServicePort.txt to have a valid input. This is the configuration file for defining the
Service’s port.
The configuration file must have the following format:

<Port Number>

Any available port can be used, for example:

48000

5. Enable or disable sending feedback to the mainframe by configuring the LoopbackResults.txt file
with one the following values:
Y

Enables sending feedback to the mainframe according to the weight of rules.
N

Disables sending feedback to the mainframe.
6. Set parallel validation parameters for the maximum-allowed values by configuring the
ParallelValidationParameters.txt.

The configuration file must have the following comma-separated values format:

<Number_of_validations_in_parallel>,<Number_of_components_per_validation>

Note:

• Do not set the number of validations in parallel greater than the number of CPU cores. Otherwise,
the validation process might be unstable.

• Do not set the number of components per validation greater than 20. Otherwise, the performance
might be negatively affected.

Examples of the configuration file:

4,10

Allows a maximum of four validation instances in parallel, and a maximum of 10 stages or members
that are allocated for each instance. You can set these values for a computer with 4 CPU cores.

8,15

Allows a maximum of eight validation instances in parallel, and a maximum of 15 members that are
allocated for each instance. You can set these values for a computer with 8 CPU cores.

7. Configure the mapping between the projects that are used to compile the members to be validated in
parallel, applications, and subsystems. Set the mapping values in the
ProjectsMappingParallelBuild.txt file.

Each line of the configuration file must have the following comma-separated values format:

<ProjectName>, <ApplicationName>, <Subsystem>

Note:
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• <ProjectName> represents the project that is defined in IBM AD Build Client.
• <ApplicationName> and <Subsystem> are defined in ChangeMan ZMF.
• The number of the projects that are mapped to one pair of an application and a subsystem must be

greater than or equal to the maximum number of validations in parallel, which is specified in the
ParallelValidationParameters.txt file. Otherwise, the service cannot start.

• Comparing with the ProjectsMapping.txt file, the projects that are specified in the
ProjectsMappingParallelBuild.txt file do not need to have a z/OS connection that is
attached and configured, as they are used only for builds. However, the projects must contain the
virtual folder that is specified in the FoldersMapping.txt file.

The following example shows the mapping configurations for eight validations in parallel:

Project1, App1, Subsys1
Project2, App1, Subsys1
Project3, App1, Subsys1
Project4, App1, Subsys1
Project5, App1, Subsys1
Project6, App1, Subsys1
Project7, App1, Subsys1
Project8, App1, Subsys1
Project9, App2, Subsys1
Project10, App2, Subsys1
Project11, App2, Subsys1
Project12, App2, Subsys1
Project13, App2, Subsys1
Project14, App2, Subsys1
Project15, App2, Subsys1
Project16, App2, Subsys1

8. Configure the completion code for messages by configuring the CompletionCodeVsMessage.txt
file.

Each line of the configuration file must have the following pipe-delimited format:

<CompletionCode>|<DescriptiveMessage>

Note: The descriptive message must have a maximum length of 23 characters.

Example of the configuration file:

0|Validation Success
4|Validation Warning
8|Validation Failed

Each of the numbers in the example reflects the weight of the rule that is specified in the
ruleBased.properties file.

9. Configure the approval request parameters in the ApprovalRequestParameters.txt file.

Each line of the configuration file must have the following comma-separated values format:

<ProjectName>,<ProcLibrary>

Note:

• <ProjectName> represents the project that is defined in IBM AD Build Client.
• <ProcLibrary> is a PDS/E library that is defined in ChangeMan ZMF.
• <ProcLibrary> must have a maximum length of 23 characters.

Example of the configuration file:

Project1,PJ.PROCLIB.S814

What to do next

Start IBM AD Validation Service: Click Start and then select All Programs > IBM Application Discovery
Build Client > Start IBM Application Discovery Validation Service.
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The service can also be started from Windows Services (services.msc) by locating
IBMApplicationDiscoveryValidationServer and pressing Start.

Important: For monitoring the Validation Service tasks, see Chapter 7, “Log Files Location,” on page
115.

STEP 4. Configuring Authentication Server (DEX)
The current implementation of the Authentication and Authorization feature, is based on OAuth2
authorization framework, and needs to have available an Authentication Server (DEX). The next
configurations are made in the context of using the Authentication Server (DEX), which is provided in the
IBM ADDI installer.

Note: These configurations are only made if the authentication of the users, who have access to the
resources, is used.

The provided Authentication Server is based on DEX and provides an authentication solution, which
connects through LDAP to Secure Storage. For more information about DEX, see https://github.com/
dexidp/dex/blob/master/Documentation/connectors/ldap.md.

Note: DEX can be replaced by any other Authentication Server that supports the OAuth2 protocol.

Follow the configuration steps that are needed to have up and running Authentication Server (DEX):

1. Configure the parameters that are present in the dex.yaml file
2. Start Authentication Server (DEX)
3. Make Authentication Server (DEX) available in IBM AD Configuration Server
4. Configure OAuth2 Client in IBM AD Configuration Server

1. Configure the parameters that are present in the dex.yaml file

On the machine where Authentication Server is installed, go to <IBM ADDI Installation Folder>/
Authentication Server (DEX)/sample-conf/ and copy the dex.yaml file to <IBM ADDI
Installation Folder>/Authentication Server (DEX)/conf/. Open the dex.yaml file by
using a text editor and enter the desired values for the properties that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value

1. Set the issuer parameter as follows.

a. If the communication to and from DEX is done through https, the issuer parameter has the
following format:

Note: This step implies the use of certificates. If you want to set the communication to be secured,
make sure that a certificate authority issues a signed certificate (.crt) and a private key for the
certificate (.key).

https://<machine name where DEX is installed>.<machine domain>:<port>/dex

Example:

issuer: https://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

b. If the communication to and from DEX is done through http, the issuer parameter has the following
format:

http://<machine name where DEX is installed>.<machine domain>:<port>/dex

Example:
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issuer: http://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

2. The next section can be configured as follows:

a. If the communication to and from DEX is done through https, generate the TLS certificates for
Authentication Server (DEX) and add the paths for the certificate(.crt) and the key(.key)
files in the TLSCert and TLSKey fields. The default port is 7600.

storage:
  type: sqlite3
  config:
    file: dex.db
frontend:
  theme: ad
web:
  https: 0.0.0.0:7600
  TLSCert: C:\certs\dex.cert
  TLSKey: C:\certs\dex.key

b. If the communication to and from DEX is done through http, comment the TLSCert and TLSKey
fields.

storage:
  type: sqlite3
  config:
    file: dex.db
frontend:
  theme: ad
web:
  http: 0.0.0.0:7600
  #TLSCert: 
  #TLSKey: 

3. The skipApprovalScreen parameter can be set to true or false. The true value offers the possibility to
skip the "Grant access screen" after the user logs in.

oauth2:
  skipApprovalScreen: true

4. The connectors section can be configured as follows:

a. Set the host parameter, including the default port 389 or 636.

The host parameter has the following format:

host: << IP:PORT >>

Example:

config:
    host: WIN-NSSMI7A1KJQ.ferdinand2.com:636

b. The InsecureNoSSL parameter can be set as follows:

• If the host parameter was set using the default port 389, set the InsecureNoSSL to true.

insecureNoSSL: true

• If the host parameter was set using the default port 636, set the InsecureNoSSL to false.

insecureNoSSL: false

c. Set the bindDN parameter by adding the account that has the rights for the LDAP bind action.

Note: To add the account that has rights for LDAP bind action run adsiedit.msc on the Active
Directory machine and load the current domain. Right click on CN=Users and CN=Administrator,
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select Properties and search for distinguishedName attribute. For more information, see ADSI Edit
(adsiedit.msc).

# This would normally be a read-only user.
    bindDN: CN=Administrator,CN=Users,DC=ferdinand2,DC=com

d. Set the bindPW parameter by adding the account's password that has the rights for the LDAP bind
action.

bindPW: password

e. Do not modify the value of the usernamePrompt parameter.

usernamePrompt: email address

5. Under the userSearch section, only modify the value of the baseDN parameter:

Note: The baseDN parameter contains the base location of all User Accounts.

userSearch:
      baseDN: dc=ferdinand2,dc=com
      filter: "(objectClass=person)"
      username: userPrincipalName
      # "DN" (case sensitive) is a special attribute name. It indicates that
      # this value should be taken from the entity's DN not an attribute on
      # the entity.
      idAttr: DN
      emailAttr: userPrincipalName
      nameAttr: cn

6. Under the groupSearch section, only modify the value of the baseDN parameter:

Note: The baseDN parameter contains the base location of all User Accounts.

groupSearch:
      baseDN: cn=Users,dc=alpaca,dc=com
      filter: "(objectClass=group)"

      # A user is a member of a group when their DN matches
      # the value of a "member" attribute on the group entity.
      userAttr: DN
      groupAttr: member

      # The group name should be the "cn" value.
      nameAttr: cn

7. The StaticClients section, can be configured as follows:

staticClients:
- id: analyze-client
  redirectURIs:
  - 'http://127.0.0.1:9999/callback'
  name: 'AD Client'
  secret: 38fcbc1a-3a65-11e9-b210-d663bd873d93

Where:

• id is the generic name that is given for the IBM AD Analyze Client.
• redirectURLs takes as value the localhost IP and a generic port that is used for callback to

Authentication Server (DEX).
• name takes as value 'AD Client'.
• secret is a secret that is shared among application.

Configuration Examples:

• When the communication to and from DEX is done through https the dex.yaml file is configured as
follows:

issuer: https://WIN-ASK7V692EKB.ferdinand2.com:7600/dex
storage:
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  type: sqlite3
  config:
    file: dex.db

frontend:
  theme: ad
  
web:
  https: 0.0.0.0:7600
  TLSCert: C:\certs\dex.crt
  TLSKey: C:\certs\dex.key
  
oauth2:
  skipApprovalScreen: true
 
connectors:
- type: ldap
  name: ADLDAP
  id: ldap
  config:
    host: WIN-NSSMI7A1KJQ.ferdinand2.com:636

    
    # No TLS for this setup.
    insecureNoSSL: false

    # This would normally be a read-only user.
    bindDN: CN=Administrator,CN=Users,DC=ferdinand2,DC=com
    bindPW: Admin15_

    usernamePrompt: email address

    userSearch:
      baseDN: dc=ferdinand2,dc=com
      filter: "(objectClass=person)"
      username: userPrincipalName
      scope: sub
      # "DN" (case sensitive) is a special attribute name. It indicates that
      # this value should be taken from the entity's DN not an attribute on
      # the entity.
      idAttr: DN
      emailAttr: userPrincipalName
      nameAttr: cn

    groupSearch:
      baseDN: dc=ferdinand2,dc=com
      filter: "(objectClass=group)"
      scope: sub
      # A user is a member of a group when their DN matches
      # the value of a "member" attribute on the group entity.
      userAttr: DN
      groupAttr: member

      # The group name should be the "cn" value.
      nameAttr: cn

staticClients:
- id: analyze-client
  redirectURIs:
  - 'http://127.0.0.1:9999/callback'
  name: 'AD Client'
  secret: 38fcbc1a-3a65-11e9-b210-d663bd873d93

• When the communication to and from DEX is done through http the dex.yaml file is configured as
follows:

issuer: http://WIN-ASK7V692EKB.ferdinand2.com:7600/dex
storage:
  type: sqlite3
  config:
    file: dex.db

frontend:
  theme: ad
  
web:
  https: 0.0.0.0:7600
  TLSCert: C:\certs\dex.crt
  TLSKey: C:\certs\dex.key
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oauth2:
  skipApprovalScreen: true
 
connectors:
- type: ldap
  name: ADLDAP
  id: ldap
  config:
    host: WIN-NSSMI7A1KJQ.ferdinand2.com:636

    
    # No TLS for this setup.
    insecureNoSSL: false

    # This would normally be a read-only user.
    bindDN: CN=Administrator,CN=Users,DC=ferdinand2,DC=com
    bindPW: Admin15_

    usernamePrompt: email address

    userSearch:
      baseDN: dc=ferdinand2,dc=com
      filter: "(objectClass=person)"
      username: userPrincipalName
      scope: sub
      # "DN" (case sensitive) is a special attribute name. It indicates that
      # this value should be taken from the entity's DN not an attribute on
      # the entity.
      idAttr: DN
      emailAttr: userPrincipalName
      nameAttr: cn

    groupSearch:
      baseDN: dc=ferdinand2,dc=com
      filter: "(objectClass=group)"
      scope: sub
      # A user is a member of a group when their DN matches
      # the value of a "member" attribute on the group entity.
      userAttr: DN
      groupAttr: member

      # The group name should be the "cn" value.
      nameAttr: cn

staticClients:
- id: analyze-client
  redirectURIs:
  - 'http://127.0.0.1:9999/callback'
  name: 'AD Client'
  secret: 38fcbc1a-3a65-11e9-b210-d663bd873d93

2. Start Authentication Server (DEX)

1. Click Start, select Run, type services.msc and start Authentication Server (DEX).
2. If the service does not start, check the dex.log file under <IBM ADDI Installation Folder>/
Authentication Server/ folder.

3. Make Authentication Server (DEX) available in IBM AD Configuration Server

After Authentication Server (DEX) is up and running, go to IBM AD Configuration Server and make
Authentication Server (DEX) available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.
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2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD File Service configuration. From the options that are displayed under the
selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Configurations.

4. The Configurations page is displayed. Select the DEFAULT configuration.
5. The parameters that can be defined for the selected configuration are displayed in the list to the left of

the page. Select Authentication Setup.
6. The "AD authentication setup" page is displayed as in the following image.
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Enable authentication option is selected when Authentication Server (DEX) is used.

Click Edit and enter the following information:

• Authentication server host: Expects the authentication server host that is used by Authentication
Server (DEX).

• Authentication discovery path: Expects the authentication discovery path that is used by
Authentication Server (DEX).

7. Click Save to save the parameters.

4. Configure OAuth2 Client in IBM AD Configuration Server

Configure OAuth2 Client in IBM AD Configuration Server as follows:

Note: If Authentication Server (DEX) is not used, make sure that your authentication server supports
Oauth2. The following configuration is done assuming that Authentication Server (DEX) is used.

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.
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2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD File Service configuration. From the options that are displayed under the
selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Configurations.

4. The Configurations page is displayed. Select the DEFAULT configuration.
5. The parameters that can be defined for the selected configuration are displayed in the list to the left of

the page. Select OAuth2 Client.
6. The "AD OAuth2 client configuration" page is displayed as in the following image.

Note: In the configuration example, the parameters are set according to the configurations made in
Authentication Server (DEX) (step where StaticClients is set).
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Click Edit and enter the following information:

• Application ID: Expects the generic name that is given for IBM AD Analyze Client.
• Secret: Expects a secret that is shared between Authentication Server (DEX) and IBM AD Analyze

Client.
• Callback URL: Expects a URL composed by localhost IP and a generic port that is used for callback

to Authentication Server (DEX).
• Timeout (in milliseconds): Expects the time for the client to respond.

7. Click Save to save the parameters.

STEP 5. Configuring IBM AD File Service
Follow the configuration steps that are needed to have up and running IBM AD File Service:

1. Configure the parameters that are present in the conf.yaml file
2. Start IBM AD File Service
3. Make IBM AD File Service available in IBM AD Configuration Server
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1. Configure the parameters that are present in the conf.yaml file

On the machine where IBM AD File Service is installed, go to <IBM ADDI Installation
Folder>/IBM Application Discovery File Service/sample-conf/ and copy the conf.yaml
file to <IBM ADDI Installation Folder>/IBM Application Discovery File Service/
conf/. Open the conf.yaml file by using a text editor and enter the desired values for the parameters
that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value

1. Enter the port on which IBM AD File Service listens to. The default value is 7700.

#port to listen to
port: 7700

2. Set the https parameter as follows:

a. If the https parameter is set to false, a non-secured communication is used.

#if true, tls information (key, cert) must be specified
https: false

b. If the https parameter is set to true, a secured communication is used.

Note: This step implies the use of certificates. If you want to set the communication to be
secured, make sure that a certificate authority issues a signed certificate (.crt) and a private key
for the certificate (.key).

#if true, tls information (key, cert) must be specified
https: true

3. If the https parameter is set to true and the TLS certificate for IBM AD File Service are generated,
enter the paths of the certificate(.crt) and the key(.key) files. If the https parameter is set
to false leave blank the following lines. Example:

#mandatory if https: true
tls:
    key: C:\certs\file.service.key
    cert: C:\certs\file.service.crt

4. Set the authSrv parameter as follows:

a. If the value of the https parameter is set to true, add the URL of Authentication Server (DEX)
where authSrv parameter is present. Authentication Sever (DEX) that belongs to the IBM AD
package is used. For more information, see “STEP 4. Configuring Authentication Server (DEX)” on
page 80. Example:

#authentication server URL
authSrv: https://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

b. If the value of the https parameter is set to false and the Authorization and Authentication
feature is enabled, add the URL of Authentication Server (DEX). Example:

#authentication server URL
authSrv: http://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

5. In the mapping section, configure the remote parameter as follows:

• For the newly created projects, you need to add the path to the source folders that were used
during the project creation.

• If you still want to use the previously created projects, you need to add the path to the shared
source folders that were used during the project creation.
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For the groups parameter, you need to define the authorization rules (which group of users can
access a specific folder).

Note: In case you want to use multiple folders, an entry for each mapping needs to be added.

#mapping specifies path query prefixes to local paths as a list
#of entries with the following keys:
#   remote: a remote path that can be used to query this service
#           for example, a UNC path
#   local:  local path that mirrors the remote path. If missing, it is 
#           identical to remote
#   groups: a list of group names that are allowed in all subfolders
#           of the local path. Since paths are matched by remote
#           the most specific remote will be used to obtain the groups
#           If groups are not specified, all authorized users have access.
mapping: 
   -  remote: \\9.20.128.222\Resources 
      local: C:\Resources 
      groups:  

  -   remote: \\9.20.128.222\Resources2 
      local: C:\Resources2 
      groups:

6. The caseSensitive parameter can be set to true or false. Through this parameter, you set the
mapping type (case-sensitive) of the folders under which the resources are located.

caseSensitive: false

7. Set the disableAuth parameter to false. The false value keeps enabled the authentication.

#disable authentication/authorization. allow all files to be sent
disableAuth: false

8. The default value of the matchUsers parameter is false, which means that the matching is made by
group names. If you want to authorize users and not groups, set the matchUsers to true and define
users in IBM AD Configuration Server. For more information, see Adding a User

matchUsers: false

Note: It is not recommended to import the list of users in IBM AD Configuration Server because it
may be time consuming to keep the list synchronized with the one from Secure Storage.

9. Configure the groups section as follows:

groups: 

  - type: ccs 
    #addrs - (mandatory) a list of servers that serve as CCS endpoints 
    addrs: [127.0.0.1] 
    #env (mandatory) the environment in CCS server 
    env: a8155844-be04-4193-a389-32993beccb0f 

Where:

• Type is ccs.
• Addrs is the IP address of the machine where IBM AD Configuration Server is installed.
• Env is the environment ID defined in IBM AD Configuration Server.

Note: When configuring IBM AD File Service you need to add in IBM AD Configuration Server the
group names that are defined in Secure Storage and use these group names to configure the
mapping section.

10. Optionally, add the refresh time to check periodically the groups that are present in IBM AD
Configuration Server.

#groupsPolling (optional) - refresh period expressed as a time duration
GroupsPolling: 2h
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2. Start IBM AD File Service

• On Windows

1. Click Start, select Run, type services.msc and start IBM Application Discovery File Service.
2. If the service does not start, check the .log file under <IBM ADDI Installation Folder>/IBM
Application Discovery File Service/ folder.

• On Linux

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery File Service/
folder and locate the micro-srcd-x.x.x.bin file.

2. In case that the .bin file is not executable, open a terminal and run the following command for
flagging them as executable:

chmod +x micro-srcd-x.x.x.bin

3. If the service does not start, check the .log file under <IBM ADDI Installation Folder>/IBM
Application Discovery File Service/ folder.

3. Make IBM AD File Service available in IBM AD Configuration Server

After IBM AD File Service is up and running, go to IBM AD Configuration Server and make IBM AD File
Service available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.

2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD File Service configuration. From the options that are displayed under the
selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Services.

4. The Services page is displayed. Select File Service.
5. The parameters that can be defined for the selected service are displayed in the right of the page.
6. The "File Service" page is displayed as in the following image.
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Click Edit and enter the following information:

• Service base link: Expects the URL of the File Service. It represents the full computer name or IP of
the machine that hosts the File Service and the port to which it listens.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7700

• Endpoints

– File Content endpoint: Expects the URL of File Service and the endpoint (file) used to obtain
the file content.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7700/file

– File Content and extra info endpoint: Expects the URL of File Service and the endpoint (fas)
used to obtain the file contents and to return a status.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7700/fas

– Line by offset endpoint: Expects the URL of File Service and the endpoint (lao) used to obtain
the corresponding text for a given list of offsets.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7700/lao

– Line by number endpoint: Expects the URL of File Service and the endpoint (lan) used to obtain
the corresponding text for a given list of line numbers.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7700/lan

7. Click Save to save the parameters.

STEP 6. Configuring IBM AD Manual Resolutions Service
Follow the configuration steps that are needed to have up and running IBM AD Manual Resolutions
Service:
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1. Configure the parameters that are present in the conf.yaml file
2. Start IBM AD Manual Resolutions Service
3. Make IBM AD Manual Resolutions Service available in IBM AD Configuration Server

1. Configure the parameters that are present in the conf.yaml file

On the machine where IBM AD Manual Resolution Service is installed, go to <IBM ADDI
Installation Folder>/IBM Application Discovery Manual Resolutions Service/
sample-conf/ and copy the conf.yaml file to <IBM ADDI Installation Folder>/IBM
Application Discovery Manual Resolutions Service/conf/. Open the conf.yaml file by
using a text editor and enter the desired values for the parameters that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value

1. Enter the port on which IBM AD Manual Resolutions Service listens to. The default value is 7900.

#port to listen to
port: 7900

2. Set the https parameter as follows:

a. If the https parameter is set to false, a non-secured communication is used.

#if communication should be secured with TLS
https: false

b. If the https parameter is set to true, a secured communication is used.

Note: This step implies the use of certificates. If you want to set the communication to be secured,
make sure that a certificate authority issues a signed certificate (.crt) and a private key for the
certificate (.key).

#if communication should be secured with TLS
https: true

Note: If the https parameter is set to true, an additional step needs to be performed. Locate
startServer.bat file under <IBM ADDI Installation Folder>/IBM Application
Discovery Manual Resolutions Service/ and replace the following line:

set tlsoptions=

with:

SET keystorepath=<"path_to_keystore">
SET keystorepass=<"password_of_keystore">
set tlsoptions=-Djavax.net.ssl.keyStore="%keystorepath%" -
Djavax.net.ssl.keyStorePassword="%keystorepass%"

Where:

• Path to keystore is the path to the keystore that holds the certificate for IBM AD Manual
Resolutions Service.

• Keystore password is the keystore password.
3. Set the authSrv parameter as follows:

a. If the value of the https parameter is set to true, add the URL of Authentication Server (DEX)
where authSrv parameter is present. Authentication Sever (DEX) that belongs to the IBM AD
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package is used. For more information, see “STEP 4. Configuring Authentication Server (DEX)” on
page 80. Example:

#authentication server URL
authSrv: https://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

b. If the value of the https parameter is set to false and the Authorization and Authentication
feature is enabled, add the URL of Authentication Server (DEX). Example:

#authentication server URL
authSrv: http://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

4. Set the disableAuth parameter to false. The false value keeps enabled the authentication.

#disable authentication/authorization. allow all files to be sent
disableAuth: false

5. Add the path where the journal files are created. The path where these files are generated is
separated from the project's path and needs to be accessible only for IBM AD Manual Resolutions
Service. Once a project is imported, a folder with the same name is generated in the related path and
it hosts all the files that are needed to manage dynamic call resolutions.

#generic path setting for journal files
#project name will be automatically added to the path
projectPath: C:\Resolutions

Note: On Linux, mount the Windows folder where the journal files are present (generated at the
project's level) and add the path.

projectPath: /LinuxUser/Resolutions

6. Add the host of IBM AD Configuration Server.

## Coordination and Configuration Server host
ccs.server.host: 127.0.0.1

7. Add the port of IBM AD Configuration Server.

## Coordination and Configuration Server port
## default 2181
ccs.server.port: 2181

8. Add the environment ID under which the projects are created.

## Coordination and Configuration environment
ccs.environment: ce127609-197e-4136-af34-83b612689b09

Note: The current configuration is only available for one environment.
9. Optionally, the main path where the manual resolutions are created for each project, can be

overwritten by the following configuration.

#optional
#overrides projectPath for a specific project.
projects:
   - project: Project1
     path: C:\Resolutions\Projects\Project1

2. Start IBM AD Manual Resolutions Service

• On Windows

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Manual
Resolutions Service/ and run startServer.bat.

2. Click Start, select Run, type services.msc and start IBM Application Discovery Manual
Resolutions Service.
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3. If the service does not start, check the manualres.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Manual Resolutions Service/log folder.

• On Linux

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Manual
Resolutions Service/ and locate the startServer.sh file.

2. In case that the .sh file is not executable, open a terminal and run the following command for
flagging them as executable:

chmod +x startServer.sh

3. If the service does not start, check the manualres.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Manual Resolutions Service/log folder.

3. Make IBM AD Manual Resolutions Service available in IBM AD Configuration Server

After IBM AD Manual Resolutions Service is up and running, go to IBM AD Configuration Server and
make IBM AD Manual Resolutions Service available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.

2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD File Service configuration. From the options that are displayed under the
selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Services.

4. The Services page is displayed. Select Manual resolutions service.
5. The parameters that can be defined for the selected service are displayed in the right of the page.
6. The "Manual Resolutions Service" page is displayed as in the following image.
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Click Edit and enter the URL of the Manual Resolutions Service in the Service base link section. It
represents the full computer name or IP of the machine that hosts the Manual Resolutions Service
and the port to which it listens.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7900

7. Click Save to save the parameters.

STEP 7. Configuring IBM AD Mainframe Projects Service
Follow the configuration steps that are needed to have up and running IBM AD Mainframe Projects
Service:

1. Configure the parameters that are present in the conf.yaml file
2. Start IBM AD Mainframe Projects Service
3. Make IBM AD Mainframe Projects Service available in IBM AD Configuration Server

Note: When configuring IBM AD Mainframe Projects Service you need to add in IBM AD Configuration
Server the group names that are defined in Secure Storage to decide which projects are accessible to
specific users.

1. Configure the parameters that are present in the conf.yaml file

On the machine where IBM AD Mainframe Projects Service is installed, go to <IBM ADDI
Installation Folder>/IBM Application Discovery Mainframe Projects Service/
sample-conf/ and copy the conf.yaml file to <IBM ADDI Installation Folder>/IBM
Application Discovery Mainframe Projects Service/conf/. Open the conf.yaml file by
using a text editor and enter the desired values for the parameters that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value
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1. Enter the port on which IBM AD Mainframe Projects Service listens to. The default value is 7650.

#port to listen to
port: 7650

2. Set the https parameter as follows:

a. If the https parameter is set to false, a non-secured communication is used.

#if communication should be secured with TLS
https: false

b. If the https parameter is set to true, a secured communication is used.

Note: This step implies the use of certificates. If you want to set the communication to be secured,
make sure that a certificate authority issues a signed certificate (.crt) and a private key for the
certificate (.key).

#if communication should be secured with TLS
https: true

Note: If the https parameter is set to true, an additional step needs to be performed. Locate
startServer.bat file under <IBM ADDI Installation Folder>/IBM Application
Discovery Mainframe Projects Service/ and replace the following line:

set tlsoptions=

with:

SET keystorepath=<"path_to_keystore">
SET keystorepass=<"password_of_keystore">
set tlsoptions=-Djavax.net.ssl.keyStore="%keystorepath%" -
Djavax.net.ssl.keyStorePassword="%keystorepass%"

Where:

• Path to keystore is the path to the keystore that holds the certificate for IBM AD Mainframe
Projects Service.

• Keystore password is the keystore password.
3. Add the host of IBM AD Configuration Server.

## Coordination and Configuration Server host
ccs.server.host: 127.0.0.1

4. Add the port of IBM AD Configuration Server.

## Coordination and Configuration Server port
## default 2181
ccs.server.port: 2181

5. Add the environment ID under which the projects are created.

## Coordination and Configuration environment
ccs.environment: ce127609-197e-4136-af34-83b612689b09

Note: The current configuration is only available for one environment.
6. Set the disableAuth parameter to false. The false value keeps enabled the authentication.

#disable authentication/authorization. allow all files to be sent
disableAuth: false

7. Set the authSrv parameter as follows:

a. If the value of the https parameter is set to true, add the URL of Authentication Server (DEX)
where authSrv parameter is present. Authentication Sever (DEX) that belongs to the IBM AD
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package is used. For more information, see “STEP 4. Configuring Authentication Server (DEX)” on
page 80. Example:

#authentication server URL
authSrv: https://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

b. If the value of the https parameter is set to false and the Authorization and Authentication
feature is enabled, add the URL of Authentication Server (DEX). Example:

#authentication server URL
authSrv: http://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

2. Start IBM AD Mainframe Projects Service

• On Windows

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Mainframe
Projects Service/ and run startServer.bat.

2. Click Start, select Run, type services.msc and start IBM Application Discovery Mainframe
Projects Service.

3. If the service does not start, check the mfprojs.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Mainframe Projects Service/log folder.

• On Linux

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Mainframe
Projects Service/ and locate the startServer.sh file.

2. In case that the .sh file is not executable, open a terminal and run the following command for
flagging them as executable:

chmod +x startServer.sh

3. If the service does not start, check the mfprojs.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Mainframe Projects Service/log folder.

3. Make IBM AD Mainframe Projects Service available in IBM AD Configuration Server

After IBM AD Mainframe Projects Service is up and running, go to IBM AD Configuration Server and
make IBM AD Mainframe Projects Service available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.

2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD Mainframe Projects Service configuration. From the options that are
displayed under the selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Services.

4. The Services page is displayed. Select Mainframe projects service.
5. The parameters that can be defined for the selected service are displayed in the right of the page.
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6. The "Mainframe Projects Service" page is displayed as in the following image.

Click Edit and enter the URL of the Mainframe Projects Service in the Service base link section. It
represents the full computer name or IP of the machine that hosts the Mainframe Projects Service
and the port to which it listens.

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7650

7. Click Save to save the parameters.

STEP 8. Configuring IBM AD Batch Server

About this task

Before running IBM AD Batch Server, some preliminary configurations must be performed. You need to
specify on which projects you want IBM AD Batch Server to run the reports, which reports to generate,
where to store the generated reports, and so on. Also, you need to specify the parameters for IBM AD
Web Service.

The configuration parameters are stored in server.properties and project.properties files,
which can be found in the configuration folder.

Below are the instructions on how to perform a minimal configuration in order to have source code
analysis in IBM AD Analyze Client. For detailed instructions on how to configure IBM AD Batch Server,
see IBM AD Batch Server User Guide.

Note: Under Linux, in case .sh files are not executable, navigate to their installation directory, open a
terminal and run the following command for flagging them as executable:

chmod +x filename.sh

Procedure

1. Copy from <IBM ADDI Installation Folder>\IBM Application Discovery Batch
Server\sample-conf all the configurations files and sub folders to <IBM ADDI Installation
Folder>\IBM Application Discovery Batch Server\Conf.

2. Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\orientdb\orientdb-community\bin\ and run server.bat on Windows or server.sh on
Linux. A command prompt window will open, asking for the root user account password. Fill in a
password of your choosing and press ENTER. The password is case-sensitive. A message indicating
that the server is now active is displayed.
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3. Go to IBM AD Configuration Server, at the following location: Home Page > Configuration server
name > Environments > "MyEnvironment" > Configurations > "MyDefaultConfiguration" > Graph
Database and enter the following information:

Where:

• Host - enter the host name or the IP where IBM AD Batch Server / OrientDB is installed.
• Port - this field is automatically completed by the application with the default value 2424. Modify if

applicable.

Note: If the ssl implementation is used, the default port for OrientDB SSL is 2434. You need to
change your port range to 2434-2440 in the config/orientdb-server-config.xml file. For
more information, see Configuring OrientDB for SSL/TLS.

• Username - enter the root username.
• Password - enter the same password configured in the previous step.

Note: At this point, OrientDB is configured to run with the root user name and the password that is
configured above.

4. In server.properties file, set the following parameters.

• ccs.server.host=<IP / hostname of the machine where the AD Configuration Server resides.>
• ccs.environment=<the same environment ID defined in Configuration Server.>

5. The project.properties file contains a set of global settings, followed by the specific settings for
each type of component. The global settings specify the projects on which the IBM AD Batch Server
will operate and which components will run on the specified projects. In project.properties file,
set the following parameters.
a) Enter an asterisk *, or a comma-separated list of project names that are the only ones considered

for this service. VERY IMPORTANT: If no value is set for this parameter, no report is generated; *
means all projects.

projects.whitelist=*

b) Comma-separated list of component names that must be considered for this service. Ex.: index
must be added as a component.

100  IBM Application Discovery for IBM Z V5.1.0: Installation and Configuration Guide

https://orientdb.com/docs/last/Using-SSL-with-OrientDB.html


components=index,gdbImport,annUpdate

Optional components can be considered for this service.

Table 2. Optional Components

Component Description

ruleBased The Rule Based component generates reports for the resources specified in
the configuration files according to the rules and parameters defined in the
corresponding configuration files.

Note: If the Rule Based component is used, make sure that the
ruleBased.properties file is configured. For more information, go to
IBM AD Batch Server User Guide, ruleBased.properties File chapter.

reports The Reports component is used to generate the complexity reports. For
more information, go to IBM AD Analyze User Guide, Complexity Reports
chapter.

cobolPP The cobolPP, jclPP, and pl1PP components generate the expanded sources
for Cobol, JCL, and PL/I. For more information, go to IBM AD Analyze User
Guide, View Expanded Source chapter.jclPP

pl1PP

wsmetrics The wsmetrics component is needed only if IBM Application Delivery
Intelligence for IBM Z (ADI) is used on the system.

Note: Additionally, in order for the wsmetrics component to be executed,
make sure that the gdbImport component is included in the components list
of this service.

adidx The addix component is needed only if IBM Application Delivery Intelligence
for IBM Z (ADI) is used on the system. The ADI Index component will index
the resources of a project so that the Business Rules Discovery (BRD)
feature can display code snippets.

c) The Index component will index the resources of a project so that a Search in resources can be
performed in IBM AD Analyze Client, using Search in Files analysis.

index.indexFolder=\\\\path\\<Folder>\\Index

Note: For the accessible path defined in the project.properties file, backslashes must be
doubled (\\) and spaces in the path must have a single backslash as a prefix.

Examples for the index.indexFolder parameter:

• index.indexFolder=\\\\path\\<Folder>\\Index

• index.indexFolder=C:\\ibm\\Index

Important:

• The folder path in which the indexes are generated needs to be accessible both for IBM AD Batch
Server and IBM AD Search Service.

• The Index location will be used when configuring IBM AD Search Service.
6. On Linux only, Open the mount.properties file, located under <installation folder>\IBM
Application Discovery Batch Server/conf folder and specify how the windows shared
folders are mounted on the local files system, using the following pattern:

\\\\machine IP\\WindowsSharedFolder=/home/user/LinuxFolder
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Example:

\\\\192.168.56.57\\ProjectsSharedPathWindows=/home/user/ ProjectsSharedPathLinux

It is mandatory to mount, at least the default shared path for AD Build Projects as defined in STEP 3
and the shared path for the Indexes as defined in project.properties file (step 5c).

7. Optional step: for integration with ADI only, please follow this procedure to set up the AD Batch
Server Web Service:

a. Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\, and run authConfigTool.bat on Windows or authConfigTool.sh on Linux. A command
prompt dialog window is displayed. Follow the directions and enter the username and the
password that are used by the Web Service then press ENTER. AuthConfigTool.bat sets the
user and password for Web Service basic access authentication.

b. Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server
\conf folder, locate the webService.properties file and set the keystore-file parameter to
enable an encrypted communication. Example:

## ssl keystore file
keystore-file=keystore.jks

Note: The keystore file needs to be added in the same \conf folder where
webService.properties is present.

What to do next

• Start IBM AD GraphDB (OrientDB).

– Under Windows: click Start and then select All Programs > IBM Application Discovery Servers \
IBM Application Discovery Batch Server > Start IBM Application Discovery GraphDB Service. The
service can also be started from Windows Services (services.msc) by locating
IBMApplicationDiscoveryGraphDBService and clicking Start.

– Under Linux: Go to <IBM ADDI Installation Folder>\IBM Application Discovery
Batch Server\orientdb\orientdb-community-2.1.25-ibm1\bin\ and run server.sh.
Make sure this process remains alive.

• Start IBM AD Batch Server.

– Under Windows: click Start and then select All Programs > IBM Application Discovery Servers \
IBM Application Discovery Batch Server > Start IBM Application Discovery Batch Server. The
service can also be started from Windows Services (services.msc) by locating
IBMApplicationDiscoveryBatchService and clicking Start.

– Under Linux: Go to <IBM ADDI Installation Folder>\IBM Application Discovery
Batch Server\, and run StartServer.sh. Make sure this process remains alive.

• (Only in case step 7 from above has been taken) Start IBM AD Web Service.

– Under Windows: click Start and then select All Programs > IBM Application Discovery Servers \
IBM Application Discovery Batch Server > Start IBM Application Discovery Web Service. The
service can also be started from Windows Services (services.msc) by locating
IBMApplicationDiscoveryWebService and clicking Start.

– Under Linux: Go to <IBM ADDI Installation Folder>\IBM Application Discovery
Batch Server\, and run startWBServer.sh. Make sure this process remains alive.

Note: Make sure to restart IBM AD Batch Server after modifying the configuration files.

Important: For monitoring the IBM AD Batch Server tasks, see Chapter 7, “Log Files Location,” on page
115.

STEP 9. Configuring IBM AD Search Service
Follow the configuration steps that are needed to have up and running IBM AD Search Service:
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1. Configure the parameters that are present in the conf.yaml file
2. Start IBM AD Search Service

Note: IBM AD Search Service is necessary for the Search in Files functionality to work. It is
mandatory to have IBM AD File Service installed, configured and up and running.

3. Make IBM AD Search Service available in IBM AD Configuration Server

1. Configure the parameters that are present in the conf.yaml file

On the machine where IBM AD Search Service is installed, go to <IBM ADDI Installation
Folder>/IBM Application Discovery Search Service/sample-conf/ and copy the
conf.yaml file to <IBM ADDI Installation Folder>/IBM Application Discovery Search
Service/conf/. Open the conf.yaml file by using a text editor and enter the desired values for the
parameters that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value

1. Enter the port on which IBM AD Search Service listens to. The default value is 7800.

#port to listen to
port: 7800

2. Set the https parameter as follows:

a. If the https parameter is set to false, a non-secured communication is used.

#if communication should be secured with TLS
https: false

b. If the https parameter is set to true, a secured communication is used.

Note: This step implies the use of certificates. If you want to set the communication to be secured,
make sure that a certificate authority issues a signed certificate (.crt) and a private key for the
certificate (.key).

#if communication should be secured with TLS
https: true

Note: If the https parameter is set to true, an additional step needs to be performed. Locate
startServer.bat file under <IBM ADDI Installation Folder>/IBM Application
Discovery Search Service/ and replace the following line:

set tlsoptions=

with:

SET keystorepath=<"path_to_keystore">
SET keystorepass=<"password_of_keystore">
set tlsoptions=-Djavax.net.ssl.keyStore="%keystorepath%" -
Djavax.net.ssl.keyStorePassword="%keystorepass%"

Where:

• Path to keystore is the path to the keystore that holds the certificate for IBM AD Search Service.
• Keystore password is the keystore password.

3. Set the authSrv parameter as follows:

a. If the value of the https parameter is set to true, add the URL of Authentication Server (DEX)
where authSrv parameter is present. Authentication Sever (DEX) that belongs to the IBM AD
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package is used. For more information, see “STEP 4. Configuring Authentication Server (DEX)” on
page 80. Example:

#authentication server URL
authSrv: https://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

b. If the value of the https parameter is set to false and the Authorization and Authentication
feature is enabled, add the URL of Authentication Server (DEX). Example:

#authentication server URL
authSrv: http://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

4. Set the disableAuth parameter to false. The false value keeps enabled the authentication.

#disable authentication/authorization. allow all files to be sent
disableAuth: false

5. Add the path where the indexes are created. This path needs to have as an endpoint the same folder
where the indexes are stored. The path where the indexes are stored was set up under <IBM ADDI
Installation Folder>/IBM Application Discovery Batch Server/conf/
project.properties file, where the index.indexFolder parameter is present. The folder path
where the indexes are generated needs to be accessible for both IBM AD Batch Server and IBM AD
Search Service.

Example:

#generic path setting for indexes
#project name will be automatically added to the path
indexPath: \\server01\Indexes

6. Optionally, the main path where the indexes are created for each project, can be overwritten by the
following configuration. This path needs to be identical to the one present under <IBM ADDI
Installation Folder>/IBM Application Discovery Batch Server/conf/
project.properties, where the project.projectName.index.indexFolder parameter is present.

#optional
#overrides indexPath for a specific project.
projects:
   - project: Project1
     path: C:\Index\Indexes\Project1

2. Start IBM AD Search Service

• On Windows

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Search
Service/ and run startServer.bat.

2. Click Start, select Run, type services.msc and start IBM Application Discovery Search Service.
3. If the service does not start, check the search.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Search Service/log folder.

• On Linux

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Search
Service/ and locate the startServer.sh file.

2. In case that the .sh file is not executable, open a terminal and run the following command for
flagging them as executable:

chmod +x startServer.sh

3. If the service does not start, check the search.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Search Service/log folder.
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3. Make IBM AD Search Service available in IBM AD Configuration Server

After IBM AD Search Service is up and running, go to IBM AD Configuration Server and make IBM AD
Search Service available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.

2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD File Service configuration. From the options that are displayed under the
selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Services.

4. The Services page is displayed. Select Search Service.
5. The parameters that can be defined for the selected service are displayed in the right of the page.
6. The "Search Service" page is displayed as in the following image.

Click Edit and enter the URL of the Search Service in the Search service URL section. It represents
the full computer name or IP of the machine that hosts the Search Service, the port to which it listens
and the endpoint (search) .

Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7800/search

7. Click Save to save the parameters.

Chapter 6. Configuring IBM AD   105



STEP 10. Configuring IBM AD Cross Applications Service
Important: The IBM AD Cross Applications Service is still under development.

IBM AD Cross Applications Service is an additional service that needs to be configured to show calls
between different mainframe projects that have their databases on the same DB instance in IBM AD
Analyze Client.

Follow the configuration steps that are needed to have up and running IBM AD Cross Applications
Service:

1. Configure the parameters that are present in the conf.yaml file
2. Start IBM AD Cross Applications Service
3. Make IBM AD Cross Applications Service available in IBM AD Configuration Server

1. Configure the parameters that are present in the conf.yaml file

On the machine where IBM AD Cross Applications Service is installed, go to <IBM ADDI
Installation Folder>/IBM Application Discovery Cross Applications Service/
sample-conf/ and copy the conf.yaml file to <IBM ADDI Installation Folder>/IBM
Application Discovery Cross Applications Service/conf/. Open the conf.yaml file by
using a text editor and enter the desired values for the parameters that are detailed below.

Note: The parameters are represented in YAML as strings terminated by a trailing colon. Values are
represented by either a string following the colon, separated by a space. Example:

my_parameter: my_value

1. Enter the port on which IBM AD Cross Applications Service listens to. The default value is 7850.

#port to listen to
port: 7850

2. Add the host of IBM AD Configuration Server.

## Coordination and Configuration Server host
ccs.server.host: 127.0.0.1

3. Add the port of IBM AD Configuration Server.

## Coordination and Configuration Server port
## default 2181
ccs.server.port: 2181

4. Add the environment ID under which the projects are created.

## Coordination and Configuration environment
ccs.environment: ce127609-197e-4136-af34-83b612689b09

Note: The current configuration is only available for one environment.
5. Add the Relational database server name. The name needs to be identical to the one that has been

set up in Step 3, when configuring IBM AD Build Client in IBM AD Configuration Server.

## Relational database server name (name defined in the specified environment)
## used to create a new cross database
db.server.name: exampleDB 

6. Add the Cross repository name.

## cross repository name
cross.db.name: YourPreferedName

7. Set the https parameter as follows:
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a. If the https parameter is set to false, a non-secured communication is used.

#if communication should be secured with TLS
https: false

b. If the https parameter is set to true, a secured communication is used.

Note: This step implies the use of certificates. If you want to set the communication to be secured,
make sure that a certificate authority issues a signed certificate (.crt) and a private key for the
certificate (.key).

#if communication should be secured with TLS
https: true

Note: If the https parameter is set to true, an additional step needs to be performed. Locate
startServer.bat file under <IBM ADDI Installation Folder>/IBM Application
Discovery Cross Applications Service/ and replace the following line:

set tlsoptions=

with:

SET keystorepath=<"path_to_keystore">
SET keystorepass=<"password_of_keystore">
set tlsoptions=-Djavax.net.ssl.keyStore="%keystorepath%" -
Djavax.net.ssl.keyStorePassword="%keystorepass%"

Where:

• Path to keystore is the path to the keystore that holds the certificate for IBM AD Cross Applications
Service.

• Keystore password is the keystore password.
8. Set the authSrv parameter as follows:

a. If the value of the https parameter is set to true, add the URL of Authentication Server (DEX)
where authSrv parameter is present. Authentication Sever (DEX) that belongs to the IBM AD
package is used. For more information, see “STEP 4. Configuring Authentication Server (DEX)” on
page 80. Example:

#authentication server URL
authSrv: https://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

b. If the value of the https parameter is set to false and the Authorization and Authentication
feature is enabled, add the URL of Authentication Server (DEX). Example:

#authentication server URL
authSrv: http://WIN-ASK7V692EKB.ferdinand2.com:7600/dex

9. Set the disableAuth parameter to false. The false value keeps enabled the authentication.

#disable authentication/authorization. allow all files to be sent
disableAuth: false

2. Start IBM AD Cross Applications Service

• On Windows

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Cross
Applications Service/ and run startServer.bat.

2. Click Start, select Run, type services.msc and start IBM Application Discovery Cross
Applications Service.

3. If the service does not start, check the cross.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Cross Applications Service/log folder.
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• On Linux

1. Go to <IBM ADDI Installation Folder>/IBM Application Discovery Cross
Applications Service/ and locate the startServer.sh file.

2. In case that the .sh file is not executable, open a terminal and run the following command for
flagging them as executable:

chmod +x startServer.sh

3. If the service does not start, check the cross.log file under <IBM ADDI Installation
Folder>/IBM Application Discovery Cross Applications Service/log folder.

3. Configure IBM AD Cross Applications Service in IBM AD Configuration Server

After IBM AD Cross Applications Service is up and running, go to IBM AD Configuration Server and
make IBM AD Cross Applications Service available for the other IBM AD components as follows:

1. To access IBM AD Configuration Server, go to Start > All Programs > IBM Application Discovery
Configuration Server > Launch IBM Application Discovery Configuration Server. The main page of
IBM AD Configuration Server is displayed as in the following image.

2. From the available configuration servers, select the server where you defined the environment for
which you define the IBM AD Cross Applications Service configuration. From the options that are
displayed under the selected server, click Environments.

3. The Environments page is displayed. From the options available for the selected environment, select
Services.

4. The Services page is displayed. Select Cross applications service.
5. The parameters that can be defined for the selected service are displayed in the right of the page.
6. The "Cross Applications Service page is displayed as in the following image.

Click Edit and enter the URL of the Cross Applications Service in the Service base link section. It
represents the full computer name or IP of the machine that hosts the Cross Applications Service and
the port to which it listens.
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Example:

https://WIN-ASK7V692EKB.ferdinand2.com:7850

7. Click Save to save the parameters.

Important: At this installation and configuration point, everything is put in place for having analysis
available in IBM AD Analyze Client. To take full advantage of the available analysis functionality, you
need to install IBM AD Analyze Client. For more information see, “STEP 11. Installing IBM AD Analyze
Client” on page 68.

STEP 11. (Optional) Configuring IBM AD Analyze Server

Before you begin

This step is optional and not necessary unless Java source code will be included in one or more projects
in this environment.

On Linux only, Open the servermount.properties file, which is located under <installation
folder>\IBM Application Discovery Batch Server/conf folder and specify how the windows
shared folders are mounted on the local files system, by using the following pattern:

\\\\machine IP\\WindowsSharedFolder=/home/user/LinuxFolder

Example:

\\\\192.168.56.57\\ProjectsSharedPathWindows=/home/user/ ProjectsSharedPathLinux

It is mandatory to mount the Remote Path from Analyze Server Manager > Server Settings.

About this task

Following are the configuration steps that are needed after IBM AD Analyze Server was installed.

• Under Windows: to access the configuration parameters, select Start > Programs > IBM Application
Discovery Analyze Server > IBM Application Discovery Analyze Server Manager.

• Under Linux: to access the configuration parameters, go to <Installation Path>\IBM
Application Discovery Servers\IBM Application Discovery Analyze Server and run
manager.sh.

In the Server settings tab, the Server properties and Server arguments sections display default data
that was entered when IBM AD Analyze Server was installed.

To configure IBM AD Analyze Server, follow the instructions below.

Procedure

1. In IBM AD Configuration Server, go to Configurations > Default > Analyze Servers and fill in the
following details:

• Host: IP / Hostname where IBM AD Analyze Server is installed.
• RMI Registry Port: 1099 (Default).

2. Configuring the server database – the Database settings tab:
Select the Database Settings tab. In the Location area, fill in the following parameters:

• Server type field is completed by default with SQL server.
• Server IP: Enter the IP of the computer where SQL Server is installed.
• Server port: Server port is the access port, by default, 1433 port is used.

Important: Make sure that the IP address and the port number you set here are the same as the ones
entered in the Relational database servers page of IBM AD Configuration Server. For more
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information, see “ STEP 2. IBM AD Configuration Server: Configurations for IBM AD Build Client ” on
page 42.

Database instance, this field must be used in case the default database name was not chosen at SQL
Server installation time. In the Authorization area, fill in the following parameters:

• Database name: Enter a name for the database.
• User and password: Give a user and password that can be used to create the database.

After you completed the details of the database, click Create database to create the database with
the selected parameters. If the database was configured correctly, after Test database is clicked, a
message with the installed DB version will be displayed. Click Save to apply the settings.

You can also select an existing database. If the selected database belongs to an older version of IBM
AD and the database structure is now obsolete, a message is displayed indicating the current version
of the selected database. The user is given the option to upgrade the existing database. Press Upgrade
if applicable. After the upgrade process was performed, press again Test database to make sure that
the upgraded database is functional. The version of the upgraded database is presented and Upgrade
button is no longer available. For incomplete or corrupted databases one of the following messages
may be displayed: Database x is not a valid database or Cannot extract relevant data from the
database. Database may be nonexistent, obsolete or invalid.

After modifying the settings in any of the tabs, do not forget to press Save to apply them. An asterisk
at the beginning of the title of a tab indicates that parameters in that tab were modified but not saved.

3. Specifying allowed IBM AD Analyze Clients:

Note: This configuration applies only to Java projects.

• IBM AD Analyze clients can be of two types: manager and user.
• IBM AD Analyze client of the manager type, can create shared projects, build shared projects, and

delete shared projects.
• IBM AD Analyze client of the “user” type, can only import the shared projects and perform analysis.

Manager and user types are server-related attributes, which means that a server determines the type
for a client connecting to that server by looking up the client IP in the configuration files. This means
that a client can be a manager on one server and a user on another server.

a) To add a Manager to the Managers list: Click Add in the upper right corner of the Access Settings
tab: New Access Data dialog window is displayed. Enter the IP of the computer of the user who
will access the server as a Manager (the type of owner is selected by default) then press OK to add
the new manager to the list of Managers. To delete one of the Managers from the list, select it then
press Delete. If you want to allow access to all the projects on the server to all potential users, do
not add any users to the List of Users. If you want to limit the access to the projects to a number of
specific users, select restrict user IP then add all of them to the List of Users. Only users in the List
of Users and List of Managers will have access to the projects shared on the server.

b) To add a user to the List of Users, click Add from the List of Users area of the Access Settings tab:
the New Access Data dialog window is displayed. Enter the IP of the computer of the user who will
access the projects as a User (the type of owner is selected by default) then press OK to add the
new user to the list of Users.

What to do next

Under Windows: start IBM AD Analyze Server: Click Start and then select All Programs > IBM
Application Discovery Analyze Server > Start IBM Application Discovery Analyze Server.

Alternatively, to start the server: From the Start menu, choose Programs > IBM Application Discovery
Analyze Server > Start IBM Application Discovery Analyze Server Monitor then go to monitor icon from
the taskbar, right-click on the icon, and select Start service. When the server is running, the green arrow
from Server Monitor icon indicates that the server is started.
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Under Linux: Go to <Installation Path>\IBM Application Discovery Servers\IBM
Application Discovery Analyze Server and run StartServer.sh. Please make sure that this
process remains alive.

Important: For monitoring the IBM AD Analyze Server tasks, see Chapter 7, “Log Files Location,” on
page 115.

STEP 12. Installing IBM AD Analyze Client

About this task

Attention:

• If you want to connect the AD Analyze Client software on a machine or operating system
instance to multiple AD Server instances that are all running the same AD Server code level, one
copy of the AD Analyze Client software can be installed into an Eclipse/IDz instance, but
each AD server connection (IP/Hostname, port, and Unique ID, at a minimum) must be
configured in a unique workspace that does not already contain an instance of the AD Analyze
Client software's configuration settings.

• If you want to install multiple code levels of the AD Analyze Client software on the same
machine or operating system instance (to connect to different AD Servers running different AD
code levels), each level of the AD Analyze Client software can be installed into a separate
Eclipse/IDz instance, and also must use a unique workspace that does not already contain
the AD Analyze Client software's configuration settings. A workspace in use when the AD
Analyze Client software is installed and configured contains the AD Analyze Client software's
configuration settings in a folder named: <workspace location>\.metadata\.ez
\.settings.

Procedure

1. To install IBM AD Analyze Client: In your Eclipse instance, select Window > Preferences.
2. From the Install /Update section to the left of the Preferences dialog window select Available

Software Sites: A list of software sites available for update or install is displayed.
3. To select the location from where IBM AD Analyze Client is being installed click Add: The Add Site

dialog window is displayed.

• In the Name field enter a name for your IBM AD Analyze Client installation.
• If you extracted the installation archive that you received from IBM and you stored it on your

computer, use Local and point to the Repository folder generated after the extract operation.
• If you did not extract the installation archive received from IBM, use Archive button to select the

installation archive stored on your computer.
• If you did not store the installation archive locally but in a location on your intranet, enter the full

path to that location in the Location field.

Click OK: IBM AD Analyze Client will be added to the list of Available Software Sites.

Click OK to close the Preferences dialog window and proceed to the next step in the installation
process.

4. In your Eclipse client select Help > Install New Software: The Install dialog window is displayed. In
Work with field select the IBM AD Analyze Client site you have defined in the previous step. After you
selected the IBM AD Analyze Client site, the corresponding IBM AD Analyze components are
displayed in the central part of the dialog window. By default, all the components are selected.
a) If you are installing AD Analyze Client into IBM IDz, you can choose all the features listed under

IBM AD Analyze.
b) If you are installing AD Analyze Client into an Eclipse package that is not IBM IDz, for example an

Eclipse distribution downloaded from eclipse.org, you can choose the features listed under IBM AD
Analyze, except you should deselect all features that start with Application Discovery Integration
with to avoid errors during the installation process.
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c) Once you have selected the correct features to install in your environment, click Next.
5. The Install details dialog window is displayed.

Select a component from the list to display a detailed description of it in the Details section of the
dialog window. Click Next.

6. The Review license dialog window is displayed. Carefully read the License agreement then select I
accept the terms and press Finish to start the installation process.

7. After the installation is completed, Eclipse will prompt you for a restart: Accept the restart operation to
see the newly installed features.

STEP 13. Configuring IBM AD Analyze Client

About this task

To configure IBM AD Analyze Client, follow the instructions below.

Eclipse startup is controlled by the options in $ECLIPSE_HOME/eclipse.ini. If $ECLIPSE_HOME is not
defined, the default eclipse.ini in your Eclipse installation directory is used.

Procedure

1. OS Dependent Configuration: In case Analyze Client is installed on Windows Server (any version) or
Windows 8/10, you need to edit the eclipse.ini configuration file and add the following line, in the
-vmargs section. Avoid blank lines in the -vmargs section.

-Dorg.osgi.framework.os.name=win32

Figure 5. OS Dependent Configuration
2. Java-Dependent Configuration: If an AD-supported IBM Java version is used as the system Java and

you want to enable the TLS V1.2 connection, make sure to add the following lines in the eclipse.ini
configuration file, in the -vmargs section. Avoid blank lines in the -vmargs section.

-Dcom.ibm.jsse2.overrideDefaultTLS=true
-Djsse.enableCBCProtection=false

3. Memory Management Configuration: Eclipse must be configured to allow for optimized memory
consumption. To configure Eclipse, edit the eclipse.ini file under the Eclipse installation folder and
set the minimum memory parameter (marked –Xms), the maximum memory parameter (marked –
Xmx). Following is an example of an eclipse.ini file containing parameters for optimized memory
consumption.
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Figure 6. Memory Management Configuration
4. If you are using an AD-supported IBM Java version as the system Java and want to enable TLS V1.2

connection, add the following parameter in the eclipse.ini file in the -vmargs section. Avoid blank
lines in the -vmargs section.

-Djsse.enableCBCProtection=false

5. To use a specific language in the Eclipse interface, add the following parameter before the -startup
parameter in the eclipse.ini file:

-nl
language

The -nl parameter has the following language values:

Language value Language

de German

es Spanish

fr French

it Italian

ja Japanese

ko Korean

pt_BR Brazilian Portuguese

zh Simplified Chinese

zh_HK Traditional Chinese, Hong Kong

zh_TW Traditional Chinese, Taiwan

6. Go to IBM AD Analyze Client main window and select Window > Preferences > Application
Discovery > Environment settings.
The following Environment identification settings are available:

• Host, enter the host name or the IP address of the computer where IBM AD Configuration Server is
installed.

• Port, enter the communications port number for IBM AD Configuration Server. If you are using the
default port, enter 2181.

• Unique id, enter the unique ID assigned by IBM AD Configuration Server to the environment you
want to work with.

Attention: This ID must be identical to the environment ID declared in “ STEP 2. IBM AD
Configuration Server: Configurations for IBM AD Build Client ” on page 42, procedure step 2.
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• Name, enter the name of the environment with which you want to work, as defined in IBM AD
Configuration Server.

Attention: It is highly recommended that this name is identical to the one declared in “ STEP
2. IBM AD Configuration Server: Configurations for IBM AD Build Client ” on page 42,
procedure step 2.

7. Click OK and restart IBM AD Analyze Client (File Menu > Restart).
8. After restarting, a pop-up message displays the configurations that were made in IBM AD

Configuration Server, which are taken into account by IBM AD Analyze Client.

Important: For monitoring the IBM AD Analyze Client tasks, see Chapter 7, “Log Files Location,” on
page 115.

9. In order to see the Mainframe Analysis projects you need to be authenticated and authorized in IBM
AD Analyze Client. For more information, see the Authorization and Authentication section, in IBM AD
Analyze User Guide.

Notice: At this point, all IBM AD components are up and running and ready for Analysis.
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Chapter 7. Log Files Location

The following table summarizes a list of log files that are generated by a specific component. For
monitoring any component's tasks, check the logs that are located in their specific location.

Table 3. Log files Location

Component Logs location Log files name format

IBM AD
Configuration
Server

<IBM ADDI Installation
Folder>\IBM Application
Discovery Configuration
Service\log\

• server.log
• ibmapplicationdiscoveryconfigurationadminservice-
stderr.<date>.log

• ibmapplicationdiscoveryconfigurationadminservice-
stdout.<date>.log

• ibmapplicationdiscoveryconfigurationservice-
stderr.<date>.log

• ibmapplicationdiscoveryconfigurationservice-
stdout.<date>.log

• ezservice-daemon.<date>.log
• ws-service-daemon.<date>.log

IBM AD Build
Client

<IBM AD Build Client
installation folder>\Bin
\Release\

IBM AD Build Client can be invoked in batch mode to create a new
project in background. The log for the New project in background
has the following name format
NewProjInBackLog_timestamp.log.

<Project's Folder> IBM AD Build Client can be invoked in batch mode to run a build (full
build). The log for the Build in background process has the following
name format Project'sName_timestamp.txt.

IBM AD Build Client can be invoked in batch mode to keep the
information stored in repository up-to-date. The logs for the Make
process have the following format:

• BatchMakeStatusFile_timestamp.txt
• Project'sName_timestamp.txt

IBM AD Build Client can automatically add all files from a given
physical folder to a virtual one (similar to Add all files from folder
option that can be found in GUI Mode). The log for this process has
the following format UpdateInBackgroundLog_timestamp.txt.

IBM AD Build Client can be invoked in batch mode to update API
Resolutions. The log for this process has the following format
UpdateApiResolutions_timestamp.txt.

<Project's Folder>
\Synchronize\

• ConfigFileValidation<timestamp>.log
• SynchronizeMembersExtendedInfo<timestamp>
• SynchronizeMembersProgress<timestamp>
• SynchronizeMembersSummary<timestamp>

<Project's Folder>\MVS\Logs
\<zOS Connection's Name>

• MFImport<timestamp>.log
• MFErrors<timestamp>.log

<IBM ADDI Installation
Folder>\IBM Application
Discovery Build Client\Bin
\Release\CCS_Interaction_Logs
\

The log for the interaction with IBM AD Configuration Server can be
found under CCSErrors_<timestamp>.log.

IBM AD Build
Configuration

<IBM AD Build Client
installation folder>\Bin
\Release\Log\

ADBuildConfiguration_timestamp.log
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Table 3. Log files Location (continued)

Component Logs location Log files name format

IBM Application
Discovery
GraphDB

<IBM ADDI Installation
Folder>\IBM Application
Discovery Batch Server
\orientdb\log\

ezservice-daemon.<date>.log

<IBM ADDI Installation
Folder>\IBM Application
Discovery Batch Server
\orientdb-community-
x.x.x_ezpatch1\log\

orient-server.log

IBM AD
Validation
Server

<IBM AD Build Client
installation path>\bin
\Release\IBMApplication
DiscoveryValidationServer
\Logs\

• ValidationServiceActivity<number>.log
• ValidationServiceStatus<date>.log

<Project's Folder>\Validation
\

ValidationThroughPDS_GenerateIncludePaths<date>.log

<Project's Folder>
\Synchronize\

Authentication
Server (DEX)

<IBM ADDI Installation
Folder>\Authentication Server
(DEX)\

dex.log

IBM AD File
Service

<IBM ADDI Installation
Folder>\IBM Application
Discovery File Service\

.log

IBM AD Manual
Resolution
Service

<IBM ADDI Installation
Folder>\IBM Application
Discovery Manual Resolutions
Service\log\

manualres.log

IBM AD
Mainframe
Projects

<IBM ADDI Installation
Folder>\IBM Application
Discovery Mainframe Projects
Service\log\

mfprojs.log

IBM AD Batch
Server

<IBM ADDI Installation
Folder>\IBM Application
Discovery Batch Server\log\

• server.log
• ibmapplicationdiscoverybatchservice -
stdout.<date>.log

• ibmapplicationdiscoverybatchservice -
stderr.<date>.log

• ibmapplicationdiscoverywebservice -
stdout.<date>.log

• ibmapplicationdiscoverywebservice -
stderr.<date>.log

• server-daemon.<date>.log
• webservice.log
• webservice-daemon.<date>.log
• status.log
• ProjectName-projectDBVersion.log
• gdbTool.log
• rb.log

IBM AD Search
Service

<IBM ADDI Installation
Folder>\IBM Application
Discovery Search Service\log\

search.log

IBM AD Cross
Applications
Service

<IBM ADDI Installation
Folder>\IBM Application
Discovery Cross Applications
Service\log\

cross.log
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Table 3. Log files Location (continued)

Component Logs location Log files name format

IBM AD Analyze
Server

<IBM ADDI Installation
Folder>\IBM Application
Discovery Analyze Server\log
\log_service\

• ezservice-daemon.<date>.log
• ibmapplicationdiscoveryanalyzeservice-
stderr.<date>.log

• ibmapplicationdiscoveryanalyzeservice-
stdout.<date>.log

<IBM ADDI Installation
Folder>\IBM Application
Discovery Analyze Server\log
\server\

• server.log
• server.<date>.log

<IBM ADDI Installation
Folder>\IBM Application
Discovery Analyze Server\log
\manager\

• manager.log
• manager.<date>.log

IBM AD Analyze
Client

<Local Workspace>\.metadata\.ez\log\ • ez.log
• ez.<date>.log

<Local Workspace>\.metadata\ .log
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Chapter 8. IBM AD Connect for Mainframe
Installation and Configuration

After all the steps in the Configuring IBM AD chapter are completed, you can install IBM AD Connect for
Mainframe.

• Install IBM AD Connect for Mainframe using SMP/E, following the instructions in the IBM AD Connect
for Mainframe Program Directory. Instructions for installing additional PTFs provided with the IBM AD
Connect for Mainframe can be found in the installation package at:

IBM AD v.X Suite\IBM AD Build\IBM AD Connect for Mainframe\Install
instructions.

• Configure IBM AD Connect for Mainframe by following the instructions in IBM AD Connect for
Mainframe Configuration Guide.
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Chapter 9. Activating Your IBM AD
A free IBM AD version is offered for evaluation purposes. This for evaluation version allows you to create
a maximum of 5 projects and compile a maximum of 100 programs and 100 JCLs. After you purchase the
full version, you will receive an activation tool. Following are the steps you need to take for unlocking the
full functionality of IBM AD.

Before you begin

Stop IBM AD Build Client and IBM AD Administration Tool before using the activation tool and make
sure you run it on all machines where IBM AD Build Client is installed.

Procedure

1. Double-click the ADActivation.exe received from IBM. (Highly recommended to use Run as
Administrator method)

2. Application Discovery License Activation dialog window is displayed. Click Activate then click Exit to
finalize the activation.
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Chapter 10. Uninstalling IBM AD Components

Important:

• Before starting the uninstall process, make sure that all IBM AD Build and IBM AD Analyze clients are
closed.

• Uninstall the products in the exact order in which they are presented below.
• As a general note, understand that Force the Deletion option deletes all the contents of a specific

folder, meaning that configurations are lost.
• After IBM AD Build Client is uninstalled make sure to reboot the workstation.
• In case you are upgrading and need to uninstall first, make sure to back up the configuration

information. For more details on upgrading, go to Chapter 4, “Upgrading Components from Earlier
Versions,” on page 17.

1. Uninstall IBM AD:

Under Windows

• Stop all services that are related to IBM AD Batch Server, IBM AD Configuration Server, and IBM AD
Analyze Server:

– IBM Application Discovery Analyze Service
– IBM Application Discovery Batch Service
– IBM Application Discovery Configuration Admin Service
– IBM Application Discovery Configuration Service
– IBM Application Discovery GraphDB Service

• Click Start and then select All Programs > IBM Application Discovery and Delivery Intelligence >
Unistall IBM Application Discovery and Delivery Intelligence.

• Alternative CLI uninstall: open a command line in Installation Path\IBM Application
Discovery and Delivery Intelligence\Uninstall and run the following command:

 java –jar uninstaller.jar -cki

Under Linux/zLinux

• Stop all the processes that are related to IBM AD Batch Server, IBM AD Configuration Server, and
IBM AD Analyze Server.

• Stop all Java™ processes related to IBM AD Batch Server, IBM AD Configuration Server, and IBM AD
Analyze Server.

• Go to the installation folder (By default, the installation folder is Installation Path\IBM
Application Discovery and Delivery Intelligence\Uninstall), execute
uninstaller.sh and follow the uninstalling steps.

• Alternative CLI uninstall: open a command line in Installation Path\IBM Application
Discovery and Delivery Intelligence\Uninstall and run the following command:

 ./uninstaller.sh -cki

2. Uninstall IBM AD Analyze Client: To uninstall IBM AD Analyze Client: Go to Eclipse client > Help >
About Eclipse SDK. In the About Eclipse SDK dialog window: Click Installation Details. In the
Eclipse SDK Installation Details dialog window: From the Installed Software tab, select all the
components that start with Application Discovery then click Uninstall. The Uninstall dialog window
presents the list of components that will be uninstalled: Click Finish to start the uninstall process.
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Chapter 11. Disaster Recovery

Backing Up Steps for Components

I. AD Configuration Server
Note:

• Before you start to back up on Windows, make sure that the
IBMApplicationDiscoveryConfigurationAdminService and IBMApplicationDiscoveryConfigurationService
services are stopped.

• Before you start to back up on Linux, make sure that the startServer.sh and
startWebServerUI.sh files, corresponding to AD Configuration Server, are not running.

Procedure

1. Back up folder <IBM AD Configuration Server Installation Path>\store. The database
and data of Configuration Server are stored in the store folder.

2. Back up folder <IBM AD Configuration Server Installation Path>\conf. The
configuration files are stored in the conf folder.

II. AD Build Client

Procedure

1. Back up AD Build projects.

a. Back up project folders.

1) Include the default path for AD Build projects in the backing up procedure. The default path is
defined in the Default projects path field. To see the value, click the AD Build Client tab in IBM
AD Configuration Server. See the following figure for illustration:

Figure 7. Default projects path field
2) If project folders exist in the paths that are not the default path for AD Build projects, make sure

to include those paths in the backing up procedure. To identify the paths, run the following
query on the SQL Server where AD Build projects exist:

SET NOCOUNT ON;
DECLARE @t TABLE (DB VARCHAR(100), PathStrFull VARCHAR(1000)) ;
DECLARE @SQL NVARCHAR(MAX);

SELECT @SQL = STUFF((
    SELECT CHAR(13) + 'SELECT ''' + name + ''', PropValue FROM [' + name + '].[dbo].[Pj_ProjectProp] WHERE 
ID_PropType = 27'  
    FROM sys.databases 
    WHERE OBJECT_ID('[' + name + '].[dbo].[Pj_ProjectProp]') IS NOT NULL
    FOR XML PATH(''), TYPE).value('.', 'NVARCHAR(MAX)'), 1, 1, '');
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INSERT INTO @t(DB, PathStrFull)              
EXEC sys.sp_executesql @SQL ;

SELECT ProjectsPaths
FROM (
       SELECT DISTINCT
       CASE WHEN CHARINDEX('EZ_', DB) = 1 THEN SUBSTRING(PathStrFull, 1, PATINDEX( '%[\]' + SUBSTRING(DB, 4, 
LEN(DB) - 3) + '[\]%', PathStrFull))
            ELSE NULL
        END AS ProjectsPaths
       FROM @t t
      ) src
WHERE LEN(src.ProjectsPaths) > 0 ;

b. Back up the relational databases of AD Build Client projects.

Every AD Build Client project has its own corresponding relational database. Include all the
relational databases with names that start with string "EZ_" in the backing up procedure, and make
sure that they can be restored at any time. See the following figure for illustration:

Figure 8. Relational database examples
2. Back up the source code files that are loaded in AD Build Client.

a. Include the path where source code files are automatically downloaded from a Mainframe system
using AD Connect for Mainframe and stored in the backing up procedure. This path is defined in the
Path for the retrieved members field. To see the value, click Install Configurations > IBM
Application Discovery Build Client in IBM AD Configuration Server. See the following figure for
illustration:

Figure 9. Path for the retrieved members field
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b. For the source code files that are manually added or loaded in AD Build projects, make sure to
include the paths where those files exist in the backing up procedure.

3. Back up AD Build configurations.

a. Back up z/OS configurations. The folder where z/OS configurations are stored is defined in the zOS
configuration folder field. To see the value, click Install Configurations > IBM Application
Discovery Build Client in IBM AD Configuration Server. See the following figure for illustration:

Figure 10. zOS configuration folder field
b. Back up the Synchronization configuration file. This file is used for the mainframe members

synchronization process, and is defined in the Path for members synchronization configuration
file field. To see the value, click Install Configurations > IBM Application Discovery Build Client
in IBM AD Configuration Server. See the following figure for illustration:
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Figure 11. Path for members synchronization configuration file field
c. For environments that download assets from Endevor via IBM AD Connect for Mainframe, back up

the following Endevor configuration files:

• Promotion routes configuration file
• Types list configuration file

The two files are configured for Endevor source code download. To see the file paths, click the
ENDEVOR Info tab in the "zOS configuration" window. See the following figure for illustration:

Figure 12. ENDEVOR Info tab
4. Back up the following AD Validation Service configuration files. They are stored in the <IBM AD
Build Client InstallationFolder>\IBMApplicationDiscoveryValidationServer
folder.

• ApprovalRequestParameters.txt
• CompletionCodeVsMessage.txt
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• FoldersMapping.txt
• IncludesOrder.txt
• LoopbackResult.txt
• ParallelValidationParameters.txt
• ProjectsMapping.txt
• ProjectsMappingParallelBuild.txt
• ServicePort.txt

5. Back up the <IBM AD Build Client InstallationFolder>
\IBMApplicationDiscoveryValidationServer\ReportsGenerator folder. By default, the
conf, data, and tmp folders are contained by the ReportsGenerator folder. If the paths for the
three folders are changed in the server.properties configuration file, back up accordingly.

6. If the Rule Based component is used, back up Rule Based reports and queries.

a. Back up Rule Based reports.

By default, the rule-based data is generated and stored in the data folder, which is already
included in the backing up procedure. For more information about the data folder, see Step 5.

If the default folders that are related to the Rule Based component are changed in the
project.properties file, back up the folders as configured. If folders for specific projects are
defined, back up the corresponding folders as well.

## output folder for rule based reports generated by source based rules. Default, data 
folder
ruleBased.reportsFolder=

## output folder for csv files generated by data based rules. Default, data folder
#ruleBased.csvFolder=

## output folder for controlTotals files generated by source based rules. Default, data 
folder
## used only if generateTotals is true
#ruleBased.totalsFolder=

## output folder for rule based reports generated by source based rules. Default, data 
folder
#project.<projectName>.ruleBased.reportsFolder=

## output folder for csv files generated by data based rules. Default, data folder
#project.<projectName>.ruleBased.csvFolder=

## output folder for controlTotals files generated by source based rules. Default, data 
folder
## used only if generateTotals is true
#project.<projectName>.ruleBased.totalsFolder=

b. Back up Rule Based queries.

If you use Rule Based global settings, check the paths where input and queries are stored in the
ruleBasedConfig.properties file.

If you use Rule Based project settings, check the paths where input and queries are stored in the
rule properties file of each project. Also, if the rule properties files are not stored in the conf folder,
back up the folders where they are stored.

III. AD Batch Server
Note:

• Before you start to back up on Windows, make sure that the IBMApplicationDiscoveryBatchService,
IBMApplicationDiscoveryGraphDBService, and IBMApplicationDiscoveryWebService services are
stopped.

• Before you start to back up on Linux, make sure that the server.sh (corresponding to GraphDB),
startServer.sh (corresponding to AD Batch Server), and startWBServer.sh (corresponding to AD
Web Service) files are not running.
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• Generally, the data and conf folders that are distributed by the AD Batch Server installation must be
included in the backing up procedure. See the following detailed description for the folders.

## path to the directory where configuration files are placed
## default: ${install.dir}/conf
conf.dir=<path>\conf

## path to the directory where data files are placed
## default: ${install.dir}/data
data.dir=<path>\data

## path to the directory where temporary data is placed
## default: ${data.dir}/tmp
tmp.dir=<path>\tmp

If the default paths for the data, conf, and tmp folders are changed in the server.properties
configuration file, back up accordingly.

Procedure

1. Back up configurations.

a. Back up the <Batch Server Installation Path>\Conf configuration folder.
b. Back up the following configuration folders from the tmp folder:

• <Batch Server Installation Path>\data\tmp\mfp
• <Batch Server Installation Path>\data\tmp\ver

2. Back up OrientDB databases (graph databases).

Back up the default folder <Batch Server Installation Path>\data\tmp\gdb. The size of
this folder might be large, depending on the number and size of AD Build Client projects.

3. Back up the index folders as defined in the project.properties configuration file. The indexes that
are generated by AD Batch Server and used for Search In Files analysis in AD Analyze Client are stored
in these folders. If indexes for specific projects are defined, back up the corresponding index folders
as well.

## index global settings
## output folder where indexes are stored. (project name will be added by default)
## this setting does not override database entry!
## Note that index folder should be a shared folder in order for all Analyze client to be able to use it
index.indexFolder=\\9.20.128.211\\IBM AD\\Batch Server\\Indexes

### index project settings
## output folder where index for this project is stored. must be unique per project
## this setting does not override database entry!
project.
project.<projectName>.index.indexFolder==\\9.20.128.211\\IBM AD\\Batch Server\\Indexes\\<projectName>

4. Back up the <Batch Server Installation Path>\data\tmp\wsmetrics folder. The Web
Services data is stored in this folder.

5. If the Rule Based component is used, back up Rule Based reports and queries.

a. Back up Rule Based reports.

By default, the rule-based data is generated and stored in the data folder, which is already
included in the backing up procedure. For more information about the data folder, see the
preceding Note.

If the default folders that are related to the Rule Based component are changed in the
project.properties file, back up the folders as configured. If folders for specific projects are
defined, back up the corresponding folders as well.

## output folder for rule based reports generated by source based rules. Default, data 
folder
ruleBased.reportsFolder=

## output folder for csv files generated by data based rules. Default, data folder
#ruleBased.csvFolder=

130  IBM Application Discovery for IBM Z V5.1.0: Installation and Configuration Guide



## output folder for controlTotals files generated by source based rules. Default, data 
folder
## used only if generateTotals is true
#ruleBased.totalsFolder=

## output folder for rule based reports generated by source based rules. Default, data 
folder
#project.<projectName>.ruleBased.reportsFolder=

## output folder for csv files generated by data based rules. Default, data folder
#project.<projectName>.ruleBased.csvFolder=

## output folder for controlTotals files generated by source based rules. Default, data 
folder
## used only if generateTotals is true
#project.<projectName>.ruleBased.totalsFolder=

b. Back up Rule Based queries.

If you use Rule Based global settings, check the paths where input and queries are stored in the
ruleBasedConfig.properties file.

If you use Rule Based project settings, check the paths where input and queries are stored in the
rule properties file of each project. Also, if the rule properties files are not stored in the conf folder,
back up the folders where they are stored.

6. Back up the annotation database.

In earlier versions of IBM AD, IBM AD Batch Server creates a database that is called EZ#Annotations
in Microsoft SQL Server. This database is created on the SQL Server as defined in the
server.properties configuration file.

Figure 13. EZ#Annotations database

Starting with IBM AD V5.1.0, IBM AD Batch Server reads the configurations that are made in IBM AD
Configuration Sever, under Annotations Database and create the annotations database in the
relational database server that is specified there, by using the database name and the schema set by
the user.

You can still add EZ#Annotations in database name field, together with dbo schema and associate the
relational database server in which the annotation database was created, the one defined in the
server.properties configuration file.

Using the configurations set in Annotations Database configurations area you can find out the name
of your annotations database, the schema and the associated relational database server in order to
know what database to back up.

IV. AD Analyze Server
Note:

• Before you start to back up on Windows, make sure that the IBMApplicationDiscoveryAnalyzeService
service is stopped.

• Before you start to back up on Linux, make sure that the StartServer.sh file, corresponding to IBM
AD Analyze Server, is not running.

Procedure
If the IBM AD Analyze Server component is used, follow the steps to back up:

1. Back up the IBM AD Analyze Server database.
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IBM AD Analyze Server creates a database in Microsoft SQL Server. To identify the IBM AD Analyze
Server database, start IBM AD Analyze Server, and click the Database settings tab. See the following
figure for the illustration of the details about the SQL Server location and the database:

Figure 14. IBM AD Analyze Server database details
2. Back up the following configuration files. These three files are required for IBM AD Analyze Server

Service, and they are stored in folder <IBM AD Analyze Server Installation Folder>.

• server.properties
• client.properties
• database.properties

V. AD Analyze Client

Procedure

Back up the Analyze Client workspace. All information about configuration settings is stored in the
Analyze Client workspace. To see the workspace location, click Windows > Preferences > Workspace.

VI. AD Web Services
Note:

• The IBM AD Catalog, IBM AD Audit, and IBM AD BRD web services are deployed on the same IBM WAS
Liberty Web Server. Back up the web services together because they are using the same configuration
file.

• The server.xml file is the only file that is changed and can be configured after the deployment of the
IBM AD Catalog, IBM AD Audit, and IBM AD BRD web services.

Procedure

1. Back up the IBM AD Catalog and IBM AD Audit databases.

Both IBM AD Catalog and IBM AD Audit require a database. To back up the databases that are used by
the IBM AD Catalog and IBM AD Audit, see the server.xml file and get the database connection
details.

• For the Audit web service, search for the following data source:

<dataSource id="DefaultDataSource" jndiName="jdbc/datasource" type="javax.sql.DataSource">

• For the Catalog web service, search for the following data source:
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<dataSource id="ADCatRDB" jndiName="jdbc/ad/catalog/relational" 
type="javax.sql.DataSource">

2. Back up the server.xml configuration file.

Add the server.xml file in the backup directory for web services. The server.xml file is under the
web service installation path: <was_liberty_path>\usr\servers\ad_server.

3. For the IBM AD Catalog web service, back up the DataColector configuration files DC.properties
and zoscdc.cmd. The files are stored under the zoscDataCollector directory in the same location
as the IBM WAS Liberty.

4. For the IBM AD BRD web service, back up the conf.brd-ws folder that includes the
application.properties file.

VII. AD Services

Procedures

Back up the configuration files for the following IBM AD Services as follows:

• Authentication Server (DEX)

Back up the dex.yaml file that is stored in the <IBM ADDI Installation Folder>/
Authentication Server (DEX)/conf/ folder.

• IBM AD File Service

Back up the conf.yaml file that is stored in the <IBM ADDI Installation Folder>/IBM
Application Discovery File Service/conf/ folder.

• IBM AD Search Service

Back up the conf.yaml file that is stored in the <IBM ADDI Installation Folder>/IBM
Application Discovery Search Service/conf/ folder.

• IBM AD Manual Resolutions Service

1. Back up the conf.yaml file that is stored in the <IBM ADDI Installation Folder>/IBM
Application Discovery Manual Resolutions Service/conf/ folder.

2. Back up the folder where the journals were created by following the same path that is set in the
conf.yaml, both the default path and the overridden path. The values of the projectPath
parameter and the projects section present in the conf.yaml need to be taken into consideration.

• IBM AD Mainframe Projects Service

Back up the conf.yaml file that is stored in the <IBM ADDI Installation Folder>/IBM
Application Discovery Mainframe Projects Service/conf/ folder.

• IBM AD Cross Applications Service

Back up the conf.yaml file that is stored in the <IBM ADDI Installation Folder>/IBM
Application Discovery Cross Applications Service/conf/ folder.

Restoring Steps for Components

Important:

• All the following components must be installed, and their corresponding services (Windows) and
processes (Linux) must be stopped before you start to restore.

• Make sure that you restore in the same order as mentioned in this document. Restoring in a different
order might make the components not work properly because the components have dependencies.

• Make sure to maintain the same IP/Hostname values for the AD components and AD SQL Server
machines when you restore, considering that AD components are using IP/Hostname values for some of
their configurations.
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I. AD Configuration Server
Note:

• Before you start to restore on Windows, make sure that the
IBMApplicationDiscoveryConfigurationAdminService and IBMApplicationDiscoveryConfigurationService
services are stopped.

• Before you start to restore on Linux, make sure that the startServer.sh and
startWebServerUI.sh files, corresponding to AD Configuration Server, are not running.

Procedure

1. Restore the database and data of Configuration Server. For more information about the database and
data, see step 1 in section backing up steps for AD Configuration Server.

2. Restore the configuration files. For more information about the files, see step 2 in section backing up
steps for AD Configuration Server.

Note: At this point, IBM AD Configuration Server is configured and up and running.

II. AD Build Client
Note: Before you start to restore AD Build Client, AD Configuration Server must be restored, and AD Build
Client is highly recommended to be installed.

Procedure

1. Restore AD Build projects.

a. Restore the project folders. For more information about the folders, see substep a of step 1 in
section backing up steps for AD Build Client.

Note: Make sure to keep the same security/share level for each folder as they were defined.
b. Restore the relational databases of AD Build Client projects. For more information about the

databases, see substep b of step 1 in section backing up steps for AD Build Client.

Note: Make sure to maintain the same ownership for each database as they were defined, and that
the owner has all the necessary rights as defined during installation and configuration.

2. Restore the source code files that are loaded in AD Build Client. For more information about the files,
see step 2 in section backing up steps for AD Build Client.

Note: Make sure to keep the same security/share level for each folder as they were defined.
3. Restore AD Build configurations. For more information about the configurations, see step 3 in section

backing up steps for AD Build Client.

Note:

• Make sure to keep the same security/share level for each folder as they were defined.
• At this point, IBM AD Build Client is configured and up and running, and all the projects are available

and can be used.
4. If AD Validation Service is used, restore AD Validation Service configuration files. For more information

about the files, see step 4 and 5 in section backing up steps for AD Build Client.
5. If the Rule Based component is used, restore Rule Based reports and queries. For more information

about the reports and queries, see step 6 in section backing up steps for AD Build Client.

Note: At this point, IBM AD Validation Service is configured, and the corresponding service can be
started.

III. AD Batch Server
Note:
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• Before you start to restore on Windows, make sure that the IBMApplicationDiscoveryBatchService,
IBMApplicationDiscoveryGraphDBService, and IBMApplicationDiscoveryWebService services are
stopped.

• Before you start to restore on Linux, make sure that the server.sh (corresponding to GraphDB),
startServer.sh (corresponding to AD Batch Server), and startWBServer.sh (corresponding to AD
Web Service) files are not running.

• Before you start to restore AD Batch Server, AD Configuration Server and AD Build Client must be
restored or up and running.

Procedure

1. Restore the configuration folders. For more information about the folders, see step 1 in section
backing up steps for AD Batch Server.

2. Restore OrientDB databases (graph databases).

a. Restore the default folder. For more information about the folder, see step 2 in section backing up
steps for AD Batch Server.

b. To re-create the symbolic links, go to <IBM AD Batch Server Installation folder> and
run recoverGDBSymbolicLinks.bat on Windows and recoverGDBSymbolicLinks.sh on
Linux.

Note: Both of the files must be executed with the following two parameter values:
Location of the graph databases

"<IBM AD Batch Server Installation path>\data\tmp\gdb"
Location where the symbolic links must be created

"<IBM AD Batch Server Installation path>\orientdb\orientdb-community\databases"

Example: recoverGDBSymbolicLinks.bat "<IBM AD Batch Server Installation
path>\data\tmp\gdb" "<IBM AD Batch Server Installation path>\orientdb
\orientdb-community\databases"

3. Restore the index folders. For more information about the folders, see step 3 in section backing up
steps for AD Batch Server.

Note: Make sure to keep the same security/share level for each folder as they were defined.
4. Restore the Web Services data. For more information about the data, see step 4 in section backing up

steps for AD Batch Server.
5. If the Rules Based component is used, restore Rules Based reports. For more information about the

reports, see step 5 in section backing up steps for AD Batch Server.
6. Restore the annotation database: EZ#Annotations. For more information about the database, see step

6 in section backing up steps for AD Batch Server.

Note:

• Make sure to maintain the same ownership for the annotation database as it was defined, and that
the owner has all the necessary rights as defined during installation and configuration.

• At this point, IBM AD Batch Server is configured, and all the corresponding services (Windows) and
processes (Linux) can be started.

IV. AD Analyze Server
Note:

• Before you start to restore on Windows, make sure that the IBMApplicationDiscoveryAnalyzeService
service is stopped.

• Before you start to restore on Linux, make sure that the StartServer.sh file, corresponding to
Analyze Server, is not running.
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Procedure

1. Restore the Analyze Server database. For more information about the database, see step 1 in section
backing up steps for AD Analyze Server.

Note: Make sure to maintain the same ownership for the Analyze Server database as it was defined,
and that the owner has all the necessary rights as defined during installation and configuration.

2. Restore the Analyze Server configuration files. For more information about the files, see step 2 in
section backing up steps for AD Analyze Server.

Note: At this point, IBM AD Analyze Server is configured, and all the corresponding services (Windows)
and processes (Linux) can be started.

V. AD Analyze Client

Procedure

1. Restore the Analyze Client workspace. For more information about the workspace, see the procedure
in section backing up steps for AD Analyze Client.

2. Set the Analyze Client Eclipse to use the backup workspace.

a. Open the Analyze Client instance.
b. Click File > Switch Workspace > Other...
c. Select the backup workspace.

Note: At this point, IBM AD Analyze Client is configured and ready to use for analysis.

VI. AD Web Services

Procedure

1. Restore the IBM AD Catalog and IBM AD Audit databases. For more information about the databases,
see step 1 in section backing up steps for AD Web Services.

Note: Make sure to maintain the same ownership for each database as it was defined, and that the
owner has all the necessary rights as defined during installation and configuration.

2. Restore the server.xml configuration file. For more information about the file, see step 2 in section
backing up steps for AD Web Services.

If the database connection details were changed, edit the server.xml file to point to the correct
location of the SQL/Db2 server, and change the credentials accordingly.

3. For IBM AD Catalog, restore the DataCollector configuration files DC.properties and zoscdc.cmd.
For more information about the files, see step 3 in section backing up steps for AD Web Services.

Create a directory <was_liberty_path>\zoscDataCollector, and put the DataCollector
configuration files in it.

4. For IBM AD BRD, restore the conf.brd-ws folder which includes the application.properties
file.

Note: At this point, IBM AD Catalog, IBM AD Audit and IBM AD BRD are configured, and all their
services (Windows) and processes (Linux) can be started.

VII. AD Services

Procedures

Restore the configuration files for the following IBM AD Services as follows:

• Authentication Server (DEX)
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Restore the dex.yaml file and place it under the <IBM ADDI Installation Folder>/
Authentication Server (DEX)/conf/ folder.

• IBM AD File Service

Restore the conf.yaml file and place it under the <IBM ADDI Installation Folder>/IBM
Application Discovery File Service/conf/ folder.

• IBM AD Search Service

Restore the conf.yaml file and place it under the <IBM ADDI Installation Folder>/IBM
Application Discovery Search Service/conf/ folder.

• IBM AD Manual Resolutions Service

1. Restore the conf.yaml file and place it under the <IBM ADDI Installation Folder>/IBM
Application Discovery Manual Resolutions/conf/ folder.

2. Restore the folders where the journals were created by following the same path that is set in the
conf.yaml file.

Note: If the path to the folders where the journals are placed is different from the previous one,
make sure that you add the new path in the conf.yaml configuration file.

• IBM AD Mainframe Projects Service

Restore the conf.yaml file and place it under the <IBM ADDI Installation Folder>/IBM
Application Discovery Mainframe Projects Service/conf/ folder.

• IBM AD Cross Applications Service

Restore the conf.yaml file and place it under the <IBM ADDI Installation Folder>/IBM
Application Discovery Cross Applications Service/conf/ folder.
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Chapter 12. Integration with IBM License Metric Tool

IBM AD generates IBM Software License Metric Tag (SLMT) files. The versions of IBM License Metric Tool
that support IBM Software License Metric Tag can generate License Consumption Reports.

Each instance of a running environment generates an IBM Software License Metric Tag file. The USER
metrics are monitored. The values are refreshed every 10 minutes.

IBM AD generates an SLMT tag file that records the active user count at 10-minute intervals. The
recorded information is:

• USER: containing the name of the system account that started IBM AD Analyze Client.
• INSTANCE: containing the workspace of IBM AD Analyze Client.
• APPLICATION_INSTANCE: a unique identifier of the current workspace of IBM AD Analyze Client.

IBM SLM tag files are found at work/.metadata/.ez/.slmtag for Linux and work\.metadata\.ez
\.slmtag for Windows. This is a relative path where work is the name of the workspace used for the IBM
AD Analyze Client installation.

Following is an example of the content of an SLM tag file:

<SchemaVersion>2.1.1</SchemaVersion>
    <SoftwareIdentity>
        <PersistentId>e1874f9ed93d4a3fb9cda4c1c442b1b1</PersistentId>
        <Name>IBM Application Discovery</Name>
        <InstanceId>/eviewer/workspace/.metadata/.ez/.slmtag</InstanceId>
    </SoftwareIdentity>
    <Metric logTime="2017-11-14T16:02:39+02:00">
        <Type>USER</Type>
        <SubType>adriana</SubType>
        <Value>13</Value>
        <Period>
            <StartTime>2017-11-14T16:02:39+02:00</StartTime>
            <EndTime>2017-11-14T16:02:39+02:00</EndTime>
        </Period>
    </Metric>
    <Metric logTime="2017-11-14T16:02:39+02:00">
        <Type>INSTANCE</Type>
        <SubType>/eviewer/workspace</SubType>
        <Value>13</Value>
        <Period>
            <StartTime>2017-11-14T16:02:39+02:00</StartTime>
            <EndTime>2017-11-14T16:02:39+02:00</EndTime>
        </Period>
    </Metric>
    <Metric logTime="2017-11-14T16:08:10+02:00">
        <Type>USER</Type>
        <SubType>adriana</SubType>
        <Value>13</Value>
        <Period>
            <StartTime>2017-11-14T16:08:10+02:00</StartTime>
                    <EndTime>2017-11-14T16:08:10+02:00</EndTime>
        </Period>
    </Metric>
    <Metric logTime="2017-11-14T16:08:10+02:00">
        <Type>INSTANCE</Type>
        <SubType>/eviewer/workspace</SubType>
        <Value>13</Value>
        <Period>
            <StartTime>2017-11-14T16:08:10+02:00</StartTime>
            <EndTime>2017-11-14T16:08:10+02:00</EndTime>
        </Period>
    </Metric>
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Documentation Notices for IBM Application Discovery for
IBM Z

This edition applies to version 5.1.0 of IBM Application Discovery for IBM Z with the corresponding fix
packs.
© Copyright International Business Machines Corporation 2010, 2019. US Government Users Restricted
Rights - Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the US. This material might be
available from IBM in other languages. However, you may be required to own a copy of the product or
product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.
IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property
Law
IBM Japan Ltd.
19-21, Nihonbashi-
Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
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Armonk, NY 10504-1785
US

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

Statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary. This information is for planning purposes only.

The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to actual people or business enterprises is
entirely coincidental.

COPYRIGHT LICENSE: This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy, modify, and distribute
these sample programs in any form without payment to IBM, for the purposes of developing, using,
marketing or distributing application programs conforming to the application programming interface for
the operating platform for which the sample programs are written. These examples have not been
thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability,
serviceability, or function of these programs. The sample programs are provided "AS IS", without
warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample
programs.

Each copy or any portion of these sample programs or any derivative work must include a copyright notice
as follows: © (your company name) (year). Portions of this code are derived from IBM Corp. Sample
Programs. © Copyright IBM Corp. _enter the year or years_.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the web Copyright
and trademark information.
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